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1111 | Welcome| Welcome| Welcome| Welcome    

 

 

Congratulations on purchasing the Hewlett-Packard Jornada 700 
Series Handheld PC (H/PC), a mobile device powered by the 
Microsoft® Windows® for Handheld PC (H/PC) 2000 operating 
system. The size and capabilities of the HP Jornada H/PC let you 
keep your most important business and personal information 
current and close at hand. Your HP Jornada supports the latest 
version of Microsoft Pocket Outlook, so you can check e-mail and 
manage your appointments and contacts while on the road. Your 
HP Jornada is also the perfect companion to your desktop or 
notebook PC. It allows you to take vital business data and 
documents with you when away from the office, then easily 
transfer updated information back to your PC upon return. A 
powerful, reliable, mobile business partner, HP Jornada offers 
you the highest quality in performance and battery life as well as 
rich programs and utilities designed by Hewlett-Packard. 

If you are familiar with Microsoft Windows products and 
notebook PCs, you will notice that your HP Jornada has many of 
the same characteristics, making it easy for you to be productive 
quickly.   

In this chapter, you will find: 

•  An overview of this User’s Guide and other sources of help and 
information 

•  A list and brief descriptions of the built-in applications, 
including MS Windows for H/PC 2000 software and special HP 
applications 

•  An introduction to HP Jornada features and a description of 
the advantages of using the HP Jornada 
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Using this guideUsing this guideUsing this guideUsing this guide    
This User’s Guide will give you a quick and effective introduction 
to your HP Jornada. Although great care has been taken to 
ensure the accuracy of procedures and artwork, some of the 
screens displayed on your HP Jornada may differ from the ones 
that appear in this User’s Guide.  

Detailed, step-by-step instructions for using the programs on 
your HP Jornada are also included in online Help, so you do not 
have to carry this guide when you travel. (For more information 
on using online Help, see the Using Help on your HP Jornada 
section in chapter 2.) 

Conventions  
This User’s Guide includes certain visual cues that will help you 
find the information you want easily.  

 
A shortcut, another way to do 
something, or expanded 
information about the topic. 

 
Caution or warning information 
about the topic. This is important 
information that should be 
observed to prevent loss of data or 
damage to the HP Jornada. 

 
Helpful information related to the 
topic. 

Finding information 
This guide describes what is included with your HP Jornada, 
provides an overview of the installed programs, and describes 
how to set up communications between your device and desktop 
PC and between your device and the Internet. The following table 
lists the different types of information available to help you use 
your HP Jornada. Note that although this book introduces the 
programs on your device, it does not describe them completely. 
For more information, see the comprehensive online Help for 
each program. 
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Information  Source 

Programs This User’s Guide  

–or– 

Online Help on your device. On the 
Start menu, tap Help. 

Unfamiliar technical 
terms 

The glossary located at the end of this 
User’s Guide. 

Synchronizing and 
exchanging files with 
a desktop PC 
(including 
information on 
connecting while 
traveling) 

This User’s Guide. 

–or–  

Online Help on your device. On the 
Start menu tap Help. 

–or– 

Microsoft ActiveSync online Help on 
your desktop PC. In the ActiveSync 
window, click Help, and then click 
Microsoft ActiveSync Help. 

Tool tips Any toolbar button. Tap and hold the 
button and the button name will 
appear. (To avoid activating the 
toolbar button, drag off the button 
before lifting the stylus.) For more 
information, see the Using your 
HP Jornada section in chapter 2. 

Troubleshooting 
information on 
connections 

This User’s Guide 

–or– 

The ActiveSync Troubleshooter on 
your desktop PC. In the ActiveSync 
window, click File, Click Connection 
Settings, and then click Help to 
activate the ActiveSync 
Troubleshooter. 

For more troubleshooting help visit 
the Microsoft Mobile Devices Web site 
at www.microsoft.com/mobile. 
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Software updates, 
device drivers, and 
lists of compatible 
accessories 

The HP Jornada Web site at 
www.hp.com/jornada. 

Up-to-date 
information on MS 
Windows for H/PC 
2000–based devices 

The Microsoft Windows Mobile 
Devices Web site at 
http://www.microsoft.com/mobile/. 

Information on this 
release of MS 
Windows for H/PC 
2000 

Readme.doc file (located in the 
Microsoft ActiveSync folder on your 
Windows desktop PC). 

 

 

The complete text of this User’s Guide is available on the HP 
Web site at www.hp.com/jornada. You can download the User’s 
Guide to your desktop PC and view it using the Adobe™ 
Acrobat Reader, available from the Adobe Web site at 
www.adobe.com.  

Learning about HP JornadaLearning about HP JornadaLearning about HP JornadaLearning about HP Jornada    
Hewlett-Packard has taken mobile computing to new levels of 
compatibility and convenience. With HP Jornada, you will notice 
many benefits not found in other, similar computers.  For 
example, you can:  

·  Move the data you already have on an older palmtop or 
handheld PC to your HP Jornada. You can transfer 
information from older Windows CE devices and even some 
non-Windows CE devices. (See the Transferring PIM data 
from older palmtop PCs section in  
Appendix B.) 

·  Use e-mail without a modem. Conveniently send e-mail  
automatically when you synchronize with your desktop PC. 
(See the Synchronizing data section in chapter 3.) 

·  Take more data with you. A desktop Microsoft Word file may 
take up to 85 percent less space on your HP Jornada. (See 
the Transferring files section in chapter 3.) 

·  Send voice messages to friends and colleagues—even those 
who do not have H/PC 2000 devices. You can save voice 



 Chapter 1 | Welcome | 5 

  

messages in the compatible Wave audio format.  (See the 
Recording voice memos section in chapter 4.)  

·  Keep Word, Access, and Excel files stored at work and at 
home synchronized. Update any file in any location, and once 
you synchronize, the file will be updated in every place it is 
stored.  (See the Synchronizing data section in chapter 3.) 

·  Read online news and information while offline, or download 
Web pages for viewing later.  (See the Browsing the Web 
section in Chapter 6.) 

·  Work any time, any place, with up to 9 hours of battery life. 
(See the Managing battery power section in chapter 7.) 

·  Synchronize mail messages, contacts, appointments, and 
tasks with your desktop or notebook PC in just a few steps.  
(See the Synchronizing data section in chapter 3.) 

·  Carry your HP Jornada with you. The HP Jornada weighs 
only 510 g (1.1 lb.), including batteries.  

·  Expand your functionality with PC Card accessories.  
(See the Accessories section in chapter 7.) 

HP Jornada is your mobile computing companion. Several 
valuable features allow you to stay organized and in touch while 
you are on the road. For instance: 

·  The HP Jornada viewer application displays PIM data 
(contacts, calendar, and tasks) at a glance, allowing you to 
navigate to or view the data you need immediately. You 
can even view notes attached to appointments. 

 

·  The HP Jornada dialup application leads you through  
the steps required to configure a dial-up connection and  
to access your e-mail and the Web. When you are ready to 
connect, just use the convenient dialup window on your 
HP Jornada desktop. 

 

·  The HP Jornada quick pad provides a convenient place to 
jot down notes, names, telephone numbers, and other data 
for short-term storage. Information can be saved in quick 
pad for fast retrieval or sent to the appropriate database 
for long-term storage. 

 

·  The HP Jornada backup application can back up and 
restore information to/from an optional CompactFlash 
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Card or PC Card, safeguarding against loss of data while 
you are on the road—even if power is lost. 

 

HP Jornada programs 
Your HP Jornada already includes the full suite of software that 
you need to function as a mobile professional. Detailed 
information can be found in later chapters. 

 

The programs listed below are pre-installed in ROM, so you 
will never need to reinstall them. 

Microsoft Pocket Office 
On the Start menu, point to Programs, point to Office, and 
then tap one of the following choices. 

 

·  Pocket Word—Take notes and compose documents, or 
transfer Microsoft Word files from your desktop PC to read 
and review while you are away from your office. 

 

·  Pocket Excel—View and edit price lists or financial 
forecasts on your HP Jornada, or fill out your expense form 
before you even land at the home office. 

 

·  Pocket Access—Take database information with you  
on the road, and fill in custom forms to update Access 
databases when you return to your office. 

 

·  Pocket PowerPoint—Create professional presentations 
on your desktop, and then take them with you to show on 
your HP Jornada. Or, use a PC Card VGA adapter 
(F1252A) to project them to an external monitor or VGA 
projector. 

Microsoft Pocket Outlook 
On the Start menu, point to Programs, point to Pocket 
Outlook, and then tap one of the following choices. 

 

·  Calendar—Never miss a meeting. Keep track of 
important dates and events or manage your schedule. 

 

·  Contacts—Take your address book with you so that you 
always have access to names, addresses, and telephone 
numbers. If you update your HP Jornada contacts list, just 
synchronize with your desktop PC and your contacts will 
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always be up to date. 

·  Inbox—Send and receive e-mail messages and 
synchronize your HP Jornada Inbox with Microsoft 
Outlook™ or Exchange™ on your desktop PC partner in a 
matter of minutes 

 

·  Tasks—Keep track of to-do lists. Set an alarm or a 
reminder and HP Jornada will make sure you do not  
forget a task! 

 

Microsoft Explorers 
On the Start menu, point to Programs, and then tap Internet 
Explorer or Windows Explorer. Or, double-tap the Internet 
Explorer or My Handheld PC icons on the desktop. 

·  Microsoft Internet Explorer 4.01 for Handheld PC—
Browse the Web from your HP Jornada or subscribe to 
channel content with this version of Microsoft Internet 
Explorer 4.01 developed specifically for the H/PC. 

 

·  Windows Explorer—Browse the files and folders on your 
HP Jornada.  

Communication 
On the Start menu, point to Programs, point to 
Communication, and then tap one of the following choices. 

·  ActiveSync™—Synchronize your HP Jornada with your 
desktop or notebook PC over a network or dial-up 
connection from a remote location.  

·  PC Link—Establish the connection between your 
HP Jornada and desktop PC partner with a single tap. 

 

·  Yahoo Messenger—Send and receive messages 
instantly. Stay in touch with friends, family and associates 
whenever you are on line.  

·  Remote Networking—Connect to a dial-up server, RAS 
account, or Internet service provider.  

·  Terminal—Connect to online services that require 
VT-100 or TTY terminal emulation. 
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Special HP Applications 
On the Start menu, point to Programs, point to HP 
Applications, and then tap one of the following choices. 

 

·  HP viewer—Display Calendar, Task, and Contact 
information (Pocket Outlook) in as much detail as you 
need so that you are always in control of your schedule. 
Month View, Week View, and Day View help you manage 
your calendar even more efficiently. (HP viewer is also 
accessible through a desktop icon and an HP hot key.) 

 

·  HP dialup—Configure connections to the Internet and e-
mail accounts or corporate network, and then dial in from 
a convenient pop-up window on your HP Jornada desktop. 
(HP dialup is also accessible through a desktop icon.) 

 

·  HP quick pad—Write simple notes and reminders on this 
electronic notepad, and then move the important 
information to Pocket Outlook or a Word document. 

 

·  HP security—Control access to your HP Jornada and the 
important information you have stored on it. Set 
passwords for accessing your device. 

 

·  HP info exchange—Exchange PIM data with PDA 
devices with IrDA capability (e.g., Palm PDA devices) 

 

·  HP backup—Protect your valuable data even when you 
are away from your office by backing up your Pocket 
Outlook data or your entire device to a CompactFlash or 
PC Card. 

 

·  HP ChaiVM—Allows you to view Java applets in Internet 
Explorer on your HP Jornada and provides developers 
with a complete runtime environment for integrating Java 
applications on the H/PC. 

On the Start menu, point to Programs, point to HP 
Utilities, and then tap one of the following choices. 

 

·  HP settings—Adjust screen controls and sound volume to 
suit any work environment. Or, choose from four preset 
profiles for different environments, and change all options 
with the touch of a button. 



 Chapter 1 | Welcome | 9 

  

·  HP hot keys—Open programs, files, or folders with a 
single keystroke. The HP Jornada hot keys and hard icons 
are fully customizable, so you can configure them for one-
touch access to your favorite programs or frequently used 
documents. 

 

Accessories 
On the Start menu, point to Accessories, and then tap 
one of the following choices. 

·  Microsoft InkWriter®—Jot quick notes or create 
sketches while in a meeting. 

 

·  Microsoft Voice Recorder—Record voice memos, 
reminders or other vital information for later playback.  

·  Calculator—Perform simple calculations in an on-screen 
calculator, and then copy the results to any open 
document. 

 

·  World Clock—Keep track of the time anywhere in the 
world and display useful travel information for both your 
home city and the city you are visiting.  

·  OmniSolve®—Perform complex mathematical and 
business calculations with this full-featured calculator 
from LandWare. 

 

Games 
·  Solitaire—Pass the time at the airport, on the train, or 

during a not-so-interesting meeting or lecture with this  
classic game.  

 

Additional H/PC-compatible software is available for download 
from the HP Jornada Web site at 
http://www.hp.com/jornada/solutions. 
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This section will help you start using your Hewlett-Packard 
Jornada 700 Series Handheld PC (H/PC). You will learn how to 
set up your HP Jornada, receive a brief introduction to MS 
Windows for H/PC 2000 operating system, and discover how to 
customize its features to work for you. When you have finished 
this chapter, you will have all the information you need to begin 
working with your HP Jornada.  

This chapter includes step-by-step instructions to help you: 

·  Identify the hardware features of your HP Jornada 

·  Connect the ac adapter 

·  Install the main battery 

·  Install the backup battery 

·  Complete the MS Windows for H/PC 2000 Welcome Wizard 

·  Put your HP Jornada to work for you 
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HP Jornada hardware features 
The views below will introduce you to the various connectors, 
ports, and other features of your HP Jornada. 

 

 

 Appointment notification LED—Notifies you of 
scheduled appointments, alarms, and reminders. (For 
more information on setting alarms and reminders, see the 
Using Microsoft Pocket Outlook section in  
chapter 4.) 

 HP hot keys—Allow one-touch access to your favorite 
programs, folders, documents, or frequently used settings. 
(See the Customizing the HP hot keys and hard icons 
section in chapter 7.) 

 Reset button—Restart your Jornada with the touch of a 
button. 

 
The Reset button quickly reinitializes the MS Windows for 
H/PC 2000 operating system. (Warning: When you reset your 
HP Jornada, you will lose all unsaved data in any open 
documents. See the Resetting section in chapter 8.) 
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 Status LED—A steady red light indicates that Voice 
Recorder is recording a voice memo; a flashing green light 
indicates that your Jornada display is off but the device is 
still turned on. 

 Microphone—Allows you to record voice memos. 

 Audio buttons—Enable you to listen to your favorite MP3 
or WMA music files with Windows Media Player 

 Stylus and stylus slot—Keeps your stylus within easy 
reach. (For more information, see the Using the stylus 
and touch screen section in this chapter.) 

 dc jack for ac power adapter—Connect your 
HP Jornada to ac power to charge the main battery. 

 Battery charging LED—Indicates the charging status of 
the main battery while connected to ac power. 

 Telephone connector (RJ-11)—Enables you to connect 
a telephone line to the built-in modem (on models 
equipped with a built-in modem), keeping you in touch 
with the world. (For more information, see the 
Connecting the telephone line section in chapter 6.) 

 Instant-on/off—No waiting for the Jornada to start up or 
shut down. Just press the on/off button to suspend 
operation, and later when you turn it back on again, you 
can start working exactly where you left off. 

 HP hard icons—Adjust display and volume settings, 
check system status, backup your data, open a dialup 
connection, or play music files with just a tap of your 
stylus. (See the Customizing the HP hot keys and 
hard icons section in chapter 7.) 
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 CompactFlash Type I card slot—Enables you to add 
storage memory or use accessories on CompactFlash cards. 
(For more information, see the Using PC Cards, 
CompactFlash Cards and Smart Cards section in 
chapter 7. For a list of recommended accessory cards, go to 
the HP Jornada Web site at www.hp.com/jornada.) 

 Backup battery compartment—Holds a 3-V CR2032 
coin-cell backup battery. (For information on replacing the 
backup battery, see chapter 7.) 

 CompactFlash door release tab—Slide the tab in the 
direction of the arrow to insert CompactFlash Cards or 
access the backup battery compartment. 

 PC Card Type II card slot—Enables you to use PC 
Cards (also called PCMCIA Cards) to expand memory, 
connect to an external monitor, or add other functionality 
to your HP Jornada. For information on how to use PC 
Card accessories, see the Using PC Cards, 
CompactFlash Cards and Smart Cards section in 
chapter 7. (For a list of recommended PC Cards, go to the 
HP Jornada Web site at www.hp.com/jornada.) 
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 Smart Card reader slot— Smart Cards are designed 
with embedded chip technology that enables the highest 
standard in device security for HP Jornada owners. For 
information about using Smart Cards, see the Using PC 
Cards, CompactFlash Cards and Smart Cards section 
in chapter 7, or go to the HP Jornada Web site at 
http:/www.hp.com/jornada. 

 PC Card release tab—Flip the tab out and depress it to 
eject a PC Card from the Type II PC Card slot. 

 Earphone jack—listen to your favorite music via the 
stereo earphone jack. 

 Security cable slot—Allows you to keep your 
HP Jornada safe with the connection of an optional thin-
wire security cable. 

 Infrared port (SIR IrDA–compliant transceiver)—
Enables you to send and receive files by infrared beam 
between your HP Jornada and another HP Jornada or 
palmtop PC, or between your HP Jornada and an infrared-
equipped printer or desktop PC.  (For more information, 
see the Connecting by infrared section in chapter 3 and 
the Infrared transfer section in chapter 8.) 

 Main battery—Provides power to your HP Jornada for up 
to 9 hours of use. Optional Extended battery is available 
for up to 24 hours of use. 

 Main battery release tab—Slide the tab to release the 
main battery for removal or replacement. 

 Serial Port (RS-232C)—Connect your HP Jornada to 
your desktop PC to transfer files or synchronize Pocket 
Outlook data, or connect your HP Jornada directly to a 
printer, external modem, or other device. (For more 
information, see the Connecting for the first time 
section in chapter 3.) 
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Setting up your HP Jornada 
Follow the steps in this section to start using your 
HP Jornada for the first time. As part of the setup process, 
you will connect the ac power adapter, install the main 
battery, install the backup battery, and complete the MS 
Windows for H/PC 2000 Welcome Wizard. To set up your 
HP Jornada, you will need to have your HP Jornada, the ac 
adapter, the HP Jornada Standard Battery, the backup 
battery (attached to the Quick Start Card), and the power 
cable. 

 
Follow these steps in the order they are presented. Do not 
install the backup battery before connecting ac power and 
installing the main battery. 

Connecting the ac adapter 
To avoid running out of battery power, you can operate your HP 
Jornada on ac power using the supplied ac adapter. The ac 
adapter accepts 100 to 240 V, enabling you to connect to ac power 
anywhere in the world. When you travel, you may need adapters 
to accommodate different electrical outlets, but the HP Jornada 
ac adapter will safely convert ac line voltage to the dc voltage 
required by your HP Jornada.  

Use only the supplied ac adapter (model HP F1279B, input 
specifications 100-240 V ac, 50-60 Hz, 1.5 A).  

While your HP Jornada is connected to ac power, the main 
battery is charged automatically. The color of the LED indicates 
the status of the battery: Amber indicates that battery is 
charging, and green indicates that the battery is fully charged. 
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The ac adapter components:  dc plug,  ac adapter, and 
 power cable. 

To connect to ac power 

1. Connect the cable from the ac adapter to the dc jack on 
the right side of your HP Jornada. 

2. Connect the power cable to the ac adapter.  

3. Plug the power cable into an ac power outlet. 

After you connect the ac adapter your HP Jornada will turn on 
automatically. However, you should install the main battery 
and install the backup battery before using your device. 

 

Installing the main battery 
The HP Jornada Lithium-Ion Battery provides power to your HP 
Jornada while it is not connected to ac power. Under normal 
operating conditions, the fully charged battery should provide 
power for up to 9 hours of continuous use; however, battery life 
will vary depending on how you use your HP Jornada. 
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Rechargeable Lithium-Ion batteries, unlike NiCD and NiMH 
batteries, are not subject to "memory effect," allowing you to 
fully recharge your batteries at any time regardless of battery 
power level. 

The main battery fits into the bottom of your HP Jornada, as 
shown in the following diagram. 

 

 

This bottom view of the HP Jornada shows how to install 
the main battery. 

To install the main battery 

·  Place the main battery in the battery slot on the bottom of 
your HP Jornada and push firmly until it snaps into place. 

The main battery should be partially charged when removed from 
the box. However, you should charge the main battery fully 
before operating your HP Jornada on battery power. Charging 
the main battery takes approximately 3.5 hours. When the 
battery is fully charged, charging stops automatically; the battery 
will not overcharge if left connected to ac power. 

 
When the main battery charge is low, a low battery warning is 
displayed. If you see a low battery warning message 
displayed, connect ac power and charge your main battery 
immediately to avoid draining your backup battery, and 
possible data loss. 
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Do not mutilate, puncture, or dispose of batteries in fire. The 
batteries can burst or explode, releasing hazardous chemicals. 
Replace batteries only with the types recommended in this 
User’s Guide. Discard used batteries according to the 
manufacturer’s instructions. 

 

Installing the backup battery 
The backup battery protects your data when the main battery 
runs out of power. The backup battery does not provide enough 
power to operate your HP Jornada, but it will preserve your data 
while you replace the main battery or while you connect to ac 
power to recharge. The 3-V CR2032 coin-cell backup battery is 
attached to the HP Jornada Quick Start Card. Follow the 
procedure outlined below to install the backup battery. 

To prevent loss of data, replace the backup battery as soon as a 
warning message appears on your screen indicating that 
backup battery power is low. (For detailed instructions on 
replacing the backup battery, see the Managing battery 
power section in chapter 7.)   

 

 

To install the backup battery 

1. Remove the backup battery from the HP Jornada Quick 
Start Card. 

2. Turn the Jornada upside-down and open the 
CompactFlash door. 

3. Use the tip of the stylus to carefully open the backup 
battery cover.  

4. Insert the battery printed side up in the battery 
compartment. 

5. Using the stylus tip, close the backup battery cover to 
secure the coin-cell battery, and then close the 
CompactFlash door. 
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Installing the backup battery 

 CompactFlash door  shown open 

 Coin-cell 3V CR2032 backup battery 

 Backup battery compartment 

 Backup battery cover in open position 
 

 
Be sure to close the backup battery cover before closing 
the CompactFlash door in order to avoid damaging these 
components. 

Using the stylus and touch screen 
Use the stylus in much the same way you would use a mouse to 
navigate and select objects on screen. You can also use your 
fingertip to tap the touch screen, but the stylus provides the 
greatest accuracy.  

For convenience, the stylus is stored in the stylus slot on the 
front of the HP Jornada. To remove the stylus, push on the stylus 
to release the catch as you slide it out of the slot. 

 
The top of the stylus pops up to make it easy to remove the 
stylus. Pressing the top has no effect on the stylus function. 
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To navigate by using the stylus, follow these tips:  

·  Where you would normally click a mouse, simply tap the 
stylus on the touch screen to select an icon or activate a 
button.  

·  Double-tap instead of double-clicking on a mouse. 

·  Hold down the  key as you tap instead of right-clicking on 

a mouse.  

To replace the stylus, insert the pointed end of the stylus into the 
slot and push until it clicks into place. 

Following the Welcome Wizard 
After you install the main battery, your HP Jornada will turn on 
automatically. At startup, the Hewlett-Packard welcome screen 
appears. Then, after a few moments, the MS Windows for H/PC 
2000 Welcome Wizard begins. The Welcome Wizard presents a 
brief orientation that helps you to calibrate the touch screen and 
configure device settings such as the World Clock and Owner 
Identification.  

Before you begin working, you may need to adjust the brightness 
and contrast of the display to compensate for different lighting 
conditions and viewing angles. You can use the keyboard to 
adjust both contrast and brightness. 

To adjust screen brightness and contrast 

1. To adjust the contrast, hold down the  key as you 

press  or .  

2. To adjust the brightness, hold down the  key as you 

press   or   .  

To maximize battery life, minimize the brightness setting and 
then adjust contrast to achieve greater readability  

The following sections describe the Welcome Wizard. To complete 
the Welcome Wizard, follow the instructions displayed in the 
taskbar area at the bottom of your screen. After you complete the 
Welcome Wizard, you can begin using your HP Jornada.  
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If your HP Jornada freezes during operation, you may need to 
perform a soft reset. To reset, use the stylus to press the reset 
button located on the left side of the HP Jornada keyboard. 
Your HP Jornada will restart automatically. Unsaved data in 
any open documents will be lost. For more information, see the 
Resetting section in chapter 8. 

Calibrating the touch screen 
Before you can use the stylus to navigate, you must calibrate the 
touch screen to align the image on the screen with the touch-
sensitive coating. The first screen of the Welcome Wizard 
prompts you to calibrate the touch screen by tapping a series of 
targets at different locations on the screen.  

From time to time, you might notice that the accuracy of your 
stylus tap diminishes. When this happens, you can return to this 
screen to calibrate your touch screen. 

To calibrate the touch screen 

·  On the Start menu, point to Settings, tap Control Panel, 
and then double-tap the Stylus icon. 

 –or– 

 Press       . 

You can also use the Stylus control panel to set options for 
double-tap rate and physical distance between taps.  
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Selecting your Home City 
MS Windows for H/PC 2000 displays current time and regional 
information for the city you designate as your “Home City.” Tap 
the city nearest your home from the drop-down list on the Home 
City tab. If your city is not listed, you can use the World Clock 
control panel to add it later. (See the World Clock topic in online 
Help.)  

 

Setting the World Clock 
MS Windows for H/PC 2000 uses the system clock to monitor 
your alarms and appointments as well as to ensure proper 
synchronization of the most current files and appointments with 
your desktop PC. So make sure you set the correct time and date. 
To set the time, type the current time in the box below the clock 
face, or drag the hands on one of the clocks to the correct time. To 
set the date, tap the current date on the calendar. (Tap   or  
to change month or tap the month or year.) 

You can set the clock settings again later using the World Clock 
control panel. (See the World Clock topic in online Help or tap 
the clock in the status area of the taskbar.) 
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Adding owner information 
You can set MS Windows for H/PC 2000 to display owner 
information, such as your name, address, and telephone number. 
You can also type a note to be displayed; for example, offering a 
reward for the safe return of your HP Jornada. To display your 
owner information each time you start your HP Jornada, tap 
Start, then tap Settings, and then tap Control Panel. Open the 
Owner control panel and select the Display Owner 
Identification check box under At Power On. 

You can change the information you type here at any time using 
the Owner control panel. (See the Settings topic in online Help.) 

Using your HP JornadaUsing your HP JornadaUsing your HP JornadaUsing your HP Jornada    
After you complete the Welcome Wizard, you can begin using 
your HP Jornada and its built-in programs.   

Welcome to MS Windows for H/PC 2000  
Congratulations on purchasing a mobile device powered by MS 
Windows for H/PC 2000. The size and capabilities of your HP 
Jornada let you keep your most important business and personal 
information up to date and close at hand. Microsoft ActiveSync 
increases the power of your HP Jornada by letting you 
synchronize the information on your desktop or notebook PC with 
your device. 

Using the Start menu and Taskbar 
Use the Start menu to open settings, online Help, recently used 
documents, and programs such as the HP Applications. Just tap 
Start, and then tap the program or item you want to open. In 
addition to the Start menu, the taskbar contains buttons for the 
programs you have running, a status area, and a desktop icon. 



 Chapter 2 | Getting started | 25 

  

 

Using the command bars 
Each program has a command bar located at the top of the 
program window. The command bar displays both menu names 
and toolbar buttons. Tap the slider and drag to switch between 
displaying toolbar buttons only or menu names and toolbar 
buttons. You can drag the slider to display only the buttons and 
menu names you want. You can also drag the slider down to 
move the toolbar buttons under the menus. 

Using Help on your HP Jornada 
You can get Help for specific programs, including MS Windows 
for H/PC 2000, as follows: 

• For detailed procedures and overview information about a 
program, on the Start menu, tap Help, and then tap the 
program name. 

• For MS Windows for H/PC 2000 Help, tap the  button in 
any program or dialog box where it appears. 

• To learn the function of a specific button or control, tap and 
hold on a toolbar button and its name will appear in a ToolTip. 
Drag the stylus off the toolbar button before lifting to avoid 
activating the button. 
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Online Help uses the same font setting as Internet Explorer. 
Changing the font size in Internet Explorer will also change 
the font size in Help. 

Turning your HP Jornada on and off 
One of the most convenient features of MS Windows for H/PC 
2000 and HP Jornada is “instant on.” With instant on, there is no 
waiting for HP Jornada to start up or shut down; you can start 
working immediately by pressing the On/Off key on the upper 
right corner of the keyboard. When you are finished, turn off your 
HP Jornada by pressing the On/Off key or by tapping Suspend 
on the Start menu. Turning off your HP Jornada simply 
suspends operation. When you turn it on again, you can resume 
working.  

You can also set options in the Power control panel to turn your 
HP Jornada on and off automatically. For example, you can set 
your HP Jornada to turn on when you tap the touch screen with 
the stylus. To conserve battery power, you can set HP Jornada to 
auto-suspend or to turn itself off after a preset period of 
continuous idle time. By default, your HP Jornada will auto-
suspend after 3 minutes while running on battery power. (For 
more information on these options and tips for conserving battery 
power, see the Managing battery power section in chapter 7.) 

 
If the HP Jornada wakes up from a suspended state and there 
is no user activity for one minute, the Jornada will return to a 
suspended state. To avoid this, simply use any of the Jornada's 
functions or programs within the one-minute interval. 

Using the HP Jornada keyboard 
To provide full functionality in a smaller size, the HP Jornada 
keyboard lets you accomplish common tasks with a few 
convenient key combinations: 

• To turn the caps lock on or off, press and hold the  key as 

you press the left  key. While caps lock is on, the  

symbol appears in the status area of the taskbar.  
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• To activate (or deactivate) the numeric keypad, press and hold 
the  key as you press the  key. While the numeric 

keypad is activated, the  symbol appears in the status area 

of the taskbar. 

Be sure the numeric keypad is deactivated and caps lock is off 
while you set your password and before you turn off your HP 
Jornada. Check for either the  or  symbols in the status 

area of the task bar at the lower right of the Jornada display 
screen. If either of these symbols appear, be sure to deactivate 
them before setting or re-entering your password. 

 

• To type accented or international characters, press and hold 
the  key as you press the keys corresponding to the 

character (international versions only). International versions 
of the HP Jornada have slightly different keyboard layouts.  

When using Terminal Server Client, the  key is not 

available for use in typing extended or international keyboard 
characters. See Appendix C  for information on alternative 
keystroke combinations in Terminal Server Client. 

 

 
• To generate extended characters or keyboard commands, hold 

down   or  as you press a key. Holding down the  

key will activate the character or command printed in yellow, 
while pressing  will activate the character or command 
printed in blue. 

You can also use the Keyboard control panel to adjust how 
quickly characters repeat when you hold down a key. To open 
the Keyboard control panel, press . 
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Using HP Jornada settings 
The HP Jornada settings application gives you access to many 
useful controls. Use the HP Jornada settings control panel to: 

• Adjust your screen brightness and contrast in different 
lighting conditions 

• Adjust speaker volume or quickly mute all sounds 

• Check the remaining battery power  

• Check the amount of system memory available 

HP Jornada settings also enable you to save your preferred 
sound, contrast, and brightness settings in a custom profile, so 
you can change all your options with a single tap.  

To open HP settings 

·  On the Start menu, point to Programs, point to HP 
Utilities, and then tap HP settings.  

 –or– 

 Tap the HP Jornada settings hard icon on the left side of 
the screen. 

For more information about the HP Jornada settings application, 
refer to the Using the HP settings application section in 
chapter 7 or the HP settings topic in online Help. 

Using the audio buttons 
The audio buttons on the front of your HP Jornada enable 
you to play Windows Media Audio and MP3 music files 
using Windows Media Player. 

There are three audio buttons and a sliding audio lock. 

 
When locking the audio buttons, be sure to slide the audio lock 
button to the fully locked position to avoid accidental 
activation of Windows Media Player in your pocket or luggage. 

When using Windows Media Player, the buttons control 
volume and play/stop functions. 
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HP Jornada Audio buttons 

 Microphone  Volume decrease button 

 Status LED  Volume increase button 

 Play/Pause button  Audio button lock 

When you press the Play button, Windows Media Player plays 
the currently selected play list. Play lists are selected from within 
the Windows Media Player application. 

For more information about play lists and using Windows 
Media Player in general, see the Windows Media Player online 
help files. 

 

Playback volume levels may vary considerably between 
different recording formats. To avoid uncomfortably high 
sound levels when listening to music via earphone, turn down 
the volume before you start playback. Then, adjust the volume 
to the desired listening level. 
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When an audio file is being played, appointment notification 
will not sound (even if sound and reminders have been set in 
the control panel), however, the appointment notification light 
will still flash. 

 

 
When playing MP3 music files through the HP Jornada built-
in speaker, reduce the bass setting. See Setting bass and treble 
levels in Chapter 7. 

 



 Chapter 3 | Connecting to your desktop PC | 31 

  

3333 | Connecting to your | Connecting to your | Connecting to your | Connecting to your 
desktop PCdesktop PCdesktop PCdesktop PC    

 
Your HP Jornada 700 Series Handheld PC works perfectly as a 
standalone computer. But to get the most out of your 
HP Jornada, you will want to connect to your desktop or notebook 
PC. This chapter describes how to establish a connection between 
your HP Jornada and a desktop PC, and how to use your HP 
Jornada with a desktop PC—or with any PC that has Microsoft 
ActiveSync installed. You will learn to: 

• Connect to your desktop PC 

• Set up Microsoft ActiveSync 

• Establish a partnership between your HP Jornada and your 
desktop PC 

• Use Microsoft ActiveSync to browse the contents of your 
HP Jornada 

• Synchronize Microsoft Pocket Outlook data and e-mail 
messages with Microsoft Outlook or Exchange 

• Transfer files between your HP Jornada and a desktop PC 

• Connect to and transfer files between your HP Jornada and a 
corporate network or home desktop PC over the Internet or by 
telephone line 

Connecting for the first timeConnecting for the first timeConnecting for the first timeConnecting for the first time    
You can connect your HP Jornada to a desktop PC using a serial 
connection (with either the docking cradle—optional for the HP 
Jornada 710—or the serial sync cable), a USB connection (using 
the cradle only, USB A-to-B cable not included) or a network 
connection (with an optional PC Card network interface card). 
You can also connect to an infrared-equipped desktop or notebook 
PC (using the infrared port). Before you connect, you must install 
Microsoft ActiveSync on the desktop PC. Then, you can connect 
your HP Jornada and establish a partnership. 
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Setting up Microsoft ActiveSync and establishing  
a partnership 
Microsoft ActiveSync enables you to synchronize the information 
on your desktop PC with the information on your HP Jornada. 
Synchronization compares the data on your device with your 
desktop PC and updates both computers with the most recent 
information. For example: 

• Keep your Pocket Outlook data current by synchronizing your 
HP Jornada with  Microsoft Outlook 2000 on your desktop PC.  
(Inbox synchronization with Outlook Express is not 
supported.)  

• Synchronize Word and Excel documents, Access and other 
ODBC databases and tables, Mobile channels, and InkWriter 
documents between your HP Jornada and desktop PC. Your 
files are automatically converted to the correct format. 

With Microsoft ActiveSync, you can: 

• Back up and restore your HP Jornada data 

• Add and remove programs on your HP Jornada  

• Move and copy files (rather than synchronize files)  
between your device and your desktop PC 

Microsoft ActiveSync includes several components. The Microsoft 
ActiveSync Setup Wizard detects which software components are 
needed and prompts you to set up only the necessary components. 
For instance: 

• If you do not already have Outlook installed, the Setup Wizard 
will attempt to install Outlook 2000.  

• The Setup Wizard can add Inbox extensions to enable 
 you to transfer messages to your desktop mail client—
Exchange or Outlook. 
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The Microsoft ActiveSync compact disc includes the following 
software options for your desktop PC. 

• Microsoft® ActiveSync—Enables you to connect your 
HP Jornada to a desktop or notebook PC running Windows 
95/98/NT/2000. 

• Microsoft® Outlook 2000—Desktop PC software for 
managing your contacts, appointments, tasks, e-mail, and 
important documents, keeping them synchronized with your 
HP Jornada. 

• Microsoft® Internet Explorer —Browse the Web with the 
latest version of the Microsoft browser software for your 
desktop PC. 

• Microsoft® Money 2000—Synchronize the accounts on your 
HP Jornada with the US version of Microsoft Money 2000 on 
your desktop PC. 

Please Note: Some software programs on the Microsoft 
CD-ROM are designed for Pocket PC devices, and are not 
compatible with your HP Jornada 700 Series Handheld PC.  
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There are many MS Windows for H/PC 2000 programs 
available, including freeware and shareware. Go to 
www.microsoft.com/mobile, or try searching the Web on the 
keyword “MS Windows for H/PC 2000” to find additional 
programs for your HP Jornada. Be sure to install only 
programs that are compiled for the StrongARM SA111X 
processor family. 

Installing Microsoft ActiveSync  
The minimum PC requirements for running Microsoft ActiveSync 
are as follows:  

• Microsoft® Windows® 2000, Microsoft® Windows NT® 
Workstation 4.0 with Service Pack 3 or greater, or Microsoft® 
Windows 95/98.. 

• Pentium processor for Windows NT (166 MHz required for 
Windows 2000)  

—or— 

486/66  DX or higher processor (Pentium® P90 recommended) 
for Windows 95/98. 

• 16 MB of memory  for Windows 95/98 (more memory will 
improve performance), or 32 MB of memory for Windows NT 
4.0 or Windows 2000 (64 MB recommended). 

• Hard disk drive with 10 to 50 MB of available hard disk space 
(actual requirements will vary, based on selection of features 
and current system configuration). 

• Available 9 or 25-pin communications port (adapter required 
for 25-pin communication port), Infrared port, or USB port 
(available for Windows 95/98 or Windows 2000 only).  

• CD-ROM drive. 

• VGA or higher resolution graphics card (SVGA 256-color 
recommended). 

• Keyboard. 

• Microsoft® Mouse or compatible pointing device. 
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Optional components: 

• Audio card/speakers for sound. 

• Modem and/or Ethernet LAN connection for remote 
synchronization. 

• Microsoft Internet Explorer 4.0 or higher for Mobile Channels 
or Mobile Favorites support. (Internet Explorer 5.0 is included 
on the ActiveSync CD-ROM.)  

• Additional 153 MB of disk space for Microsoft Outlook® 2000. 
24MB system RAM recommended. (Microsoft Outlook 2000 is 
included on the ActiveSync CD-ROM.) 

To install Microsoft ActiveSync 

1. Insert the Microsoft ActiveSync compact disc into the 
CD-ROM drive on your desktop PC. 

2. The Microsoft ActiveSync Setup Wizard should start 
automatically. If it does not start, click Run on the 
Start menu, and then type d:\setup, where d is the 
letter assigned to your CD-ROM drive. 

3. Follow the instructions that appear on your screen to set 
up Microsoft ActiveSync.  

4. After you complete the installation, the Microsoft 
ActiveSync Get Connected dialog box appears, 
prompting you to connect your HP Jornada.  

• If you connect via serial port using the docking cradle 
(optional on the HP Jornada 710) or sync cable, connect 
your device as described below in Connecting by serial 
port, and then click Next. 

• If you connect via USB port with the docking cradle, 
connect your device as described below in Connecting 
by USB port, and then click Next. 

• If you connect by infrared, click Cancel, and then skip to 
the section Connecting by infrared, later in this 
chapter. 

Your HP Jornada will automatically detect the connection 
method (serial or USB) that you have used to connect to your 
desktop PC. Connect the cable type of your choice according to 
the instructions below, click Next, and ActiveSync will prompt 
you to complete the New Partnership Wizard. 
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Connecting by serial port 
The HP Jornada uses a serial port to communicate with a 
desktop PC. Use the serial sync cable that was included 
with your HP Jornada to connect either the device or the 
cradle (optional on the HP Jornada 710) to a 9-pin serial 
communications port on your desktop PC. If the 9-pin 
serial port on your PC is in use by another device, or if your 
computer has no 9-pin serial port, you can obtain an 
adapter from your computer’s manufacturer. 

 
Turn on your desktop PC before connecting the sync cable or 
placing your HP Jornada in the docking cradle (optional on the 
HP Jornada 710). If the desktop PC is off, your HP Jornada or 
desktop PC may freeze on startup, forcing you to reset or 
restart. For information on resetting your HP Jornada, see 
Resetting in chapter 8. 

To connect directly (without the docking cradle) 

1. If it is attached, disconnect the telephone cable from 
your HP Jornada. 

2. Connect the ac adapter to the dc jack on the right side of 
the HP Jornada, and then plug in the power cable. 

3. Insert the 9-pin end of the serial sync cable into a serial 
port on your desktop PC. 

4. Fully insert the flat end of the serial sync cable, arrow 
side up, into the serial port on your HP Jornada. 

 

HP Jornada serial port connection 
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To connect via serial port using the docking 
cradle (optional on the HP Jornada 710) 

1. Connect the 9-pin end of the sync cable to a serial port 
on your desktop PC. 

2. Slide the port cover on the back of the docking cradle to 
the right to expose the Serial port. 

3. Fully insert the flat end of the sync cable, arrow side 
up, into the serial port on the back of the docking cradle. 

4. Turn off your HP Jornada and disconnect any cables 
(telephone cable, ac adapter, sync cable, etc.) from your 
HP Jornada. 

5. Connect the ac adapter to the dc jack on the back of the 
docking cradle, and then plug in the power cord. 

Do not connect your HP Jornada to more than one source of ac 
power. You must disconnect the ac adapter from your HP 
Jornada before placing in it in the docking cradle to avoid 
damaging your HP Jornada. 

 

6. Align your HP Jornada in the docking cradle, and push 
down firmly until the HP Jornada snaps into place.  

 

HP Jornada shown with docking cradle, ac adapter, and 
serial/USB methods of connection to a desktop PC 
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 Connecting by USB port 
Using the cradle (optional on the HP Jornada 710) you can 
also make a USB connection to your desktop PC. A 
standard USB A-to-B cable (not included) is required in 
order to make a USB connection. 

To connect via USB port using the docking cradle 

1. Connect the flat USB "A" connector to an available USB 
port on your desktop PC (cable not included). 

2. Slide the port cover on the back of the docking cradle to 
the left to expose the USB port. 

3. Insert the square USB "B" connector into the USB port 
on the back of the docking cradle 

4. Turn off your HP Jornada and disconnect any cables 
(telephone cable, ac adapter, sync cable, etc.) from your 
HP Jornada. 

5. Connect the ac adapter to the dc jack on the back of the 
docking cradle, and then plug in the power cord. 

6. Align your HP Jornada in the docking cradle, and push 
down firmly until the HP Jornada snaps into place.  

Your HP Jornada should start automatically and establish a 
connection to the desktop computer. To remove your HP Jornada 
from the docking cradle, push the release button on the cradle, 
and carefully lift your HP Jornada from the cradle. 

If you are traveling without your docking cradle or you need to 
synchronize files with your home computer while the docking 
cradle is connected to your office PC, you can connect your HP 
Jornada directly to a desktop PC using only the serial sync cable. 
(See Connecting by serial port earlier in this chapter.) 

 
You can also connect and synchronize by infrared. For more 
information, see the Connecting by infrared section in this 
chapter. 

Establishing a partnership  
After you set up Microsoft ActiveSync on your desktop PC, you 
are prompted to establish a partnership between your desktop PC 
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and your HP Jornada. The partnership enables your desktop PC 
to recognize your HP Jornada when transferring files or 
synchronizing data.  

You can establish partnerships between your HP Jornada and up 
to two desktop PCs; for example, your home PC and your office 
PC. If you regularly synchronize your HP Jornada with both 
desktop PCs, you can ensure that important files, contacts, and 
calendar information are always up-to-date and identical on both 
desktop PCs, as well as on your HP Jornada.   

Although you can establish partnerships with two desktop 
PCs, you can synchronize e-mail messages with only one 
desktop PC. 

 

A single desktop PC can partner with many H/PCs or palmtop 
PCs. This is useful if you have more than one MS Windows for 
H/PC 2000 device, or if several mobile professionals share a 
single desktop PC. 

The New Partnership Wizard 
The first time you connect, the New Partnership Wizard on your 
desktop PC helps you establish a partnership and set options for 
synchronizing Pocket Outlook data, e-mail messages, and files 
between your HP Jornada and desktop PC.  

To establish a partnership 

1. When the New Partnership dialog box appears on your 
desktop PC screen, click Yes to synchronize, and then follow 
the instructions to complete the New Partnership Wizard. 

2. At the prompt, type a name and description for your HP 
Jornada. The name must start with a letter, and it can be 
anything you choose (up to 15 characters, no spaces). 

3. Select whether you want your HP Jornada to synchronize 
through a single partnership or multiple partnerships 
desktop PCs, by selecting the appropriate button. 

4. Select the personal information manager (PIM) application 
you plan to use from the list boxes. 

5. Set options for synchronization, indicating the types of files 
and information you want to synchronize. 
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If you choose to establish partnerships with more than one 
desktop PC, the desktop PCs must be configured with the 
same synchronization settings. In addition, each desktop PC 
must use the same PIM program (for example, Microsoft 
Outlook). 

  

 
Regardless of the options you choose while completing the 
wizard, you can also synchronize at any moment by choosing 
the Synchronize Now command from the File menu of the 
ActiveSync window. For more information, see the 
Synchronizing data section in this chapter. 

 

 Troubleshooting partnerships 

Your HP Jornada is designed to automatically detect the 
connection type and configure itself to communicate with you 
desktop PC. However, if you are unable to establish a connection 
between your HP Jornada and your desktop PC, double-tap the 
connection icon in the status area of the taskbar on your HP 
Jornada. The Connection Status dialog box may provide 
information about the problem. 

Connection Methods 

Each of these connection methods works with the HP Jornada 
H/PC; however, USB and infrared connectivity are not supported 
by Windows NT. A serial sync cable and cradle (optional on the 
HP Jornada 710) with serial/USB capability are included with 
your Jornada. Additional cables and cradles are available as 
optional accessories. 
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Connection  
method 

Desktop PC operating system 

 Windows 
95 

Windows 
98 

Windows 
2000 

Windows 
NT 

USB No Yes Yes No 

Serial Yes Yes Yes Yes 

Infrared Yes Yes Yes No 

Checking connection methods on your H/PC and desktop PC 

One possible source of trouble with making connections may be 
incompatible connection settings on either your HP Jornada or 
your desktop PC. 

To check and set the desired connection method 
on your HP Jornada 

1. From the Start menu, tap Settings, tap Control Panel, then 
double-tap Communications. 

2. On the PC Connection tab, under Connect using make 
sure that the connection method you wish to use is displayed. 
If the correct connection method is not displayed, tap 
Change. 

 
 
3. In the Change Connection dialog box, choose the desired 

connection method from the drop-down list. 
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4. Tap OK twice to save your settings and exit. 

 
To check the connection settings in ActiveSync 
on your desktop Computer 

 
1. Depending upon your connection method, verify that the sync 

cable from your docking cradle (optional on the HP Jornada 
710) or HP Jornada is connected to the listed serial port in 
the Connection Settings dialog box, or that Allow USB 
Connection with this desktop computer is selected. 

2. If you are connecting via infrared, be sure that Allow serial 
or infrared connection to this COM port is selected 
and that the correct IrDA COM port is displayed. 

3. If you continue to have difficulty synchronizing, in  the 
Connection Settings dialog of the Microsoft ActiveSync 
window, clear the Allow check box for the type of connection 
you are using, and then click OK. 

4. After the connection is disabled, re-select the appropriate 
Allow check box and click OK to enable the connection again. 
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If these steps fail to correct the problem, use the ActiveSync 
Troubleshooter. The ActiveSync Troubleshooter provides detailed 
diagnostic steps to identify and correct common problems.  

To start the ActiveSync Troubleshooter 

1. On the desktop PC Start menu, point to Programs, 
click on Microsoft ActiveSync, and then choose 
Connection Settings from the File menu. 

2. In the Connection Settings window, click Help to 
open the ActiveSync Troubleshooter. 

Connecting to your desktop PC Connecting to your desktop PC Connecting to your desktop PC Connecting to your desktop PC     
After you have established a partnership, you have several 
options for connecting your device to your desktop PC in the 
future. You can set Microsoft ActiveSync to automatically detect 
your HP Jornada and establish a connection whenever you 
connect a sync cable. Using the COM port on your desktop PC is 
the easiest way for you to connect, unless the port is in use for 
other peripherals. 

To enable automatic connection 

1. On the desktop PC Start menu, point to Programs and 
click on Microsoft ActiveSync. 

2. On the Tools menu in the Microsoft ActiveSync window, 
click Options. 
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3. On the Sync Mode tab, select either the "Continuously 
while the device is connected" or the "Only on 
connection" check box to activate automatic connection. 

If you use the COM port of your desktop PC for other devices, or 
if you have disconnected your HP Jornada and need to re-
establish the connection, you can establish a manual connection 
using the PC Link program on your HP Jornada. 

 
To connect manually 

1. On the HP Jornada Start menu, point to Programs, 
point to Communications, and then tap PC Link.  

2. The Connection Status dialog box appears. 

3. After a few moments a sound indicates that the 
connection has been established. 

To close the connection  

1. On your HP Jornada, double-tap the connection  
icon in the status area of the task bar.  

2. In the Connection Status dialog box, tap  
Disconnect.  

Connecting by infrared 
 The infrared port on your HP Jornada provides a 
convenient way to connect to an IrDA-equipped PC without 
using a cable or cradle (optional on the HP Jornada 710). 
Many notebook computers have built-in infrared ports; 
however, you may need to install and configure an infrared 
port on a desktop PC. To install the port, follow the 
manufacturer’s instructions. More information about 
infrared drivers for Windows 95/98 or Windows 2000 is 
available on the MS Windows for H/PC 2000 Web site at 
www.microsoft.com/mobile. (Infrared connection is not 
available for Windows NT.) 
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Once connected, you can transfer files and synchronize Pocket 
Outlook data and e-mail messages just as if you had connected 
using a sync cable or a docking cradle.  

To configure Microsoft ActiveSync for infrared 
connection 

1. Open the ActiveSync window. 

2. Choose Connection Settings from the File menu. 

3. Click on Allow serial cable or infrared connection 
to this COM port. 

To configure your HP Jornada for infrared 
connection 

1. On your HP Jornada Start menu, point to Settings, tap 
Control Panel, and then double-tap the 
Communications icon. 

2. On the PC Connection tab, if it does not say Connect 
using Infrared Port, tap Change, and then select 
Infrared Port from the list of available connections.  

To establish an infrared connection 

1. Line up the infrared port on your HP Jornada with the 
infrared device on your notebook or desktop PC. 

2. On your HP Jornada Start menu, point to Programs, 
point to Communications, and then tap PC Link. 

Connecting to another PC Connecting to another PC Connecting to another PC Connecting to another PC     
In some cases, you may need to connect your HP Jornada to a 
desktop PC other than your partner. Or, if you have logged on to 
your desktop PC under a different user name or performed a 
factory default reset of your H/PC, your desktop PC will not 
recognize your HP Jornada as its partner.  

In these cases, when you connect your HP Jornada to the desktop 
PC, the New Mobile Device Detected dialog box appears, 
offering you the option to synchronize, browse, or to restore data 
from an existing backup file. 

If you choose Synchronize, the New Partnership Wizard will 
begin, and your HP Jornada will be designated as a partner of 
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the desktop PC. Contacts, Calendar, and Task information and 
information from any other services you choose to synchronize 
will be copied from the desktop PC to your HP Jornada. 

If you choose Browse, your HP Jornada will be connected as a 
guest. As a guest, you can view files and folders on the 
HP Jornada, transfer files and folders, and manually back up or 
restore; however, you cannot synchronize data or automatically 
back up and restore data. 

If you choose Restore, you are given the option to restore data 
from an existing backup file on the desktop PC. Restoring data in 
this way will replace all existing data on the HP Jornada with the 
data in the backup file on your PC.  

 

If you have lost your HP Jornada or replaced it with another HP Jornada, 
you can use the Restore function to set up a new device with the exact 
same data and settings as the old one, provided you had previously 
performed a full backup to the desktop PC. When you connect the new 
device to your desktop PC for the first time, choose Restore rather than 
Synchronize or Browse. For more information, see the Backing up and 
restoring data section in chapter 5. 

Browsing your HP Jornada desktopBrowsing your HP Jornada desktopBrowsing your HP Jornada desktopBrowsing your HP Jornada desktop    
While your HP Jornada is connected to a desktop PC, you can use 
Microsoft ActiveSync to browse the contents of your HP Jornada 
from your desktop. The ActiveSync window has an Explore icon 
on the toolbar. When you click the Explore icon, the contents of 
your HP Jornada are displayed just like any other folder on your 
desktop PC. You can cut, paste, and copy files between folders on 
your HP Jornada or transfer files between your HP Jornada and 
your desktop PC simply by dragging the file icons between the 
appropriate folders. 

 
For more information about transferring files, including details 
on converting file types between Pocket Office and Office 2000 
programs, see the Transferring files section later in this 
chapter. 

You cannot open files or start programs stored on your 
HP Jornada by double-clicking their icons in the Mobile Device 
window on your desktop PC. When you double-click the icon for a 
file or program that is stored on your HP Jornada, Microsoft 
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ActiveSync displays the properties for that file or program, as if 
you had clicked Properties on the File menu. 

 

The Mobile Device window on your desktop PC displays 
the contents of your HP Jornada. 

Synchronizing dataSynchronizing dataSynchronizing dataSynchronizing data    
Microsoft ActiveSync enables you to synchronize data 
between your HP Jornada and desktop PC, so the names 
you add to your Contacts database and the appointments 
you add to your Calendar while traveling can be 
automatically updated on your desktop PC when you 
return. You can also synchronize messages in your 
HP Jornada Inbox with Microsoft Outlook or Microsoft 
Exchange on your desktop PC. And, you can synchronize 
files in the Synchronized Files folder on your HP Jornada. 
with files in a Synchronized Files folder inside your My 
Documents folder (Windows 95/98) or Personal folder 
(Windows NT and Windows 2000) on your desktop PC. 

You can set ActiveSync either to synchronize automatically 
each time you connect your HP Jornada to your desktop PC 
or to synchronize continuously whenever the synchronized 
information changes, for as long as the computers are 
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connected. You can also synchronize at any moment by 
choosing clicking on the Synchronize button on the 
toolbar  in the ActiveSync window. 

 

Do not remove your HP Jornada from the docking cradle, 
disconnect the sync cable, or turn off your HP Jornada while 
synchronization is in progress. 

Synchronizing selected data 
You can synchronize some or all of the following items:  

• Pocket Outlook data—Synchronize the Calendar, Contacts, 
or Tasks information on your HP Jornada with information 
stored in Outlook 2000 on your desktop PC.  

• E-mail messages—Share messages between selected folders 
in your HP Jornada Inbox and Microsoft Exchange or Outlook 
2000 on your desktop PC. For more information, see the 
Synchronizing e-mail messages section in this chapter. 

• Files—Synchronize the contents of the Synchronized Files 
folder (inside My Documents) on your HP Jornada with files 
stored in your My Documents folder (Windows 95/98) or in 
your Personal folder (Windows NT) on your desktop PC.  

To specify data to synchronize 

1. On your desktop PC, open the ActiveSync window. 

2. On the Tools menu, click Options. 

3. On the Sync Options tab of the ActiveSync Options 
dialog box, select the check boxes beside the services you 
want to synchronize. 

4. To set specific options (for example, to indicate how 
many weeks of Calendar data to synchronize or to 
synchronize only active tasks), select the appropriate 
service, and then click Settings.  

 
Reducing the amount of data to synchronize, for example, by 
synchronizing only 1 or 2 weeks of Calendar data, can 
significantly speed up the synchronization process. If you use 
Microsoft Outlook, Microsoft ActiveSync synchronizes only 2 
weeks of calendar data by default. 
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Resolving synchronization conflicts  
If the same item (for example, an appointment or a task) has 
been modified on both the desktop PC and on the HP Jornada, 
ActiveSync will indicate that a Synchronization conflict has 
occurred. When the Resolve Conflicts dialog box appears, you 
can either resolve the conflict by selecting one of the items to 
replace or you can ignore the conflict, leaving the data on both 
computers unchanged.  

 
 
You can resolve each conflict manually, at the time of 
synchronization, or you can resolve conflicts automatically by 
setting a default option for conflict resolution.  

To set a default option for conflict resolution 

1. Open the Microsoft ActiveSync window. 

2. On the Tools menu, click Options. 

3. Click on the Rules tab of the Options dialog box. 

4. Under Conflict Resolution, select the option you prefer 
to resolve conflicts.  

Synchronizing e-mail messages 
You can synchronize your HP Jornada Inbox with the e-mail 
program (Microsoft Outlook or Exchange) on your desktop PC 
partner. By synchronizing, you can take important messages with 
you when you travel, or you can use your desktop PC to send 
messages that you create on your HP Jornada.  
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When you synchronize: 

• Messages are copied from the Inbox folder on your desktop 
computer to the Inbox folder on your HP Jornada (by default, 
only the messages received in the past 3 days are 
synchronized, and no attachments are copied). 

• Messages on the two computers are linked. So, for instance, if 
you delete a message on your HP Jornada, it will also be 
deleted on your desktop PC the next time you synchronize. 

• Messages in the Outbox folder on your HP Jornada are 
transferred to the Outbox on your desktop PC and then sent 
from that program. 

Synchronizing from a remote location 
The ActiveSync program on your HP Jornada enables you 
to synchronize files, e-mail messages, and Pocket Outlook 
data with your desktop PC, even when you are away from 
the office. You can do this by remote dial-up connection or 
LAN connection to your desktop PC. You can also connect 
to a computer not on a network (such as your home 
computer) and synchronize using a modem. 

 
You can quickly and easily make connections to the Internet or 
a corporate network from remote locations using HP dialup. 
For more information on using HP dialup see Creating 
Connections in Chapter 6. 

 
Before you can synchronize remotely, the desktop PC or network 
server must be configured for Remote Access Services (Windows 
NT) or Dial-Up Networking (Windows 95/98), and you must 
create a connection on your HP Jornada by using either the HP 
Jornada dialup application or the Remote Networking program. 
For information about setting up connections with HP dialup, 
see the Setting up a remote connection to your network 
section in chapter 6. For Remote Networking information, see the 
Accessing a computer not on a network section in this 
chapter. After you have set up for either type of connection, you 
can synchronize data. See the To start remote 
synchronization procedure later in this chapter. 
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Accessing a computer on your corporate network 
To access a PC on your corporate network from a remote location, 
you must have an account provided by your network 
administrator, and you must set up a connection to your network 
server using HP dialup (see chapter 6). In addition, you must set 
up the target PC to receive your calls as follows. 

• The target PC must be turned on. 

• Microsoft ActiveSync must be set up on the target PC. (See the 
Installing Microsoft ActiveSync section earlier in this 
chapter.) Also, the synchronize setting on the Sync Mode tab 
under ActiveSync Options should be set to one of the 
automatic options.  

• Microsoft ActiveSync must be running, and the Waiting for 
mobile device to connect status message must be shown in 
the ActiveSync window.  

• In the Microsoft ActiveSync Connection Settings dialog box, 
the Allow network (Ethernet) and Remote Access 
Service (RAS) server connection with this desktop 
computer checkbox must be selected. 

• Any folders or drives you want to access must be shared.  

If you will be dialing in to a desktop PC running Windows 95, 
you must also have Dial-up Networking components set up on 
the target desktop PC. 

 

Accessing a computer not on a network  
If you want to dial in to a computer that is not on a network (such 
as your home PC with Windows 95/98), you must set up the 
target PC to receive your calls as follows. 

• The target desktop PC must be turned on. 

• The target desktop PC must have a modem installed and 
configured and must be set to receive incoming calls. (Refer to 
the instructions from the manufacturer of your desktop PC 
modem.) 

• Dial-up Networking (Windows 95/98) or Remote Access 
Service (Windows NT) must be set up and configured so that 
your target PC can act as a server. (See your Windows 
documentation for further instructions.)  
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• Microsoft ActiveSync must be set up on the target PC (for 
instructions, see the Installing Microsoft ActiveSync 
section in this chapter). The synchronize setting on the Sync 
Mode tab under ActiveSync Options should be set to one of 
the automatic options. 

• Microsoft ActiveSync must be running, and the Waiting for 
mobile device to connect status message should appear in 
the ActiveSync window.  

• In the Microsoft ActiveSync Connection Settings dialog 
box,  the Allow network (Ethernet) and Remote Access 
Service (RAS) server connection with this desktop 
computer checkbox must be enabled. 

• Any folders or drives you want to access must be shared.  

You need the following information to establish a Remote 
Networking connection:  

• Your Windows user name and password, if you are required to 
log on to your computer  

• Telephone number of the modem 

To create a connection to a computer not on a network (such as a 
home computer), you will need to create a new connection using 
Remote Networking on your HP Jornada. 

 
To create a Remote Networking connection 

1. On the Start menu, point to Programs, point to 
Communication, and then tap Remote Networking. 

2. In the Remote Networking folder, double-tap Make New 
Connection. 

3. In the Make New Connection dialog box, tap  
Dial-up, and then tap Next. 

4. If your HP Jornada is equipped with a built-in modem, 
select Built-In Modem from the list of modems. If you 
use a PC Card modem∗, select the appropriate option for 
the PC card modem you have installed 

                                                                 
∗ Modem purchased separately. Some Web sites/content may not be 
available. 
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5. Tap TCP/IP Settings, and then tap the General tab. 
Make sure the Use Server-assigned IP Address check 
box is selected. 

6. On the Name Servers tab, tap Server-assigned 
addresses, and then tap OK. 

7. Tap Next, and then fill in the telephone number you 
wish to dial. Tap Finish. A new icon appears, labeled 
with the name you chose, in your Remote Networking 
folder. This connection will also appear in your remote 
synchronization dialog box. 

To set a dialing location for a Remote Networking connection, 
double-tap the icon for the connection in the Remote 
Networking folder. In the Dial-up Connection dialog box, tap 
Dial Properties, and then fill in the information as you would 
for a network or ISP connection using the HP Jornada dialup 
application. 

 

To start remote synchronization 
 

1. On your HP Jornada Start menu, point to Programs, 
point to Communication, and then tap ActiveSync. 

2. If you are connecting using a modem or dial-up 
connection, select the connection you will use from the 
list. All connections you have created either with the HP 
Jornada dialup application or Remote Networking will 
appear in this list. 
–or– 
If you are connecting over a network, tap Network 
Connection. 

3. In the Connect to list, select the name of the desktop 
PC to which you will connect. The Connect to list 
displays only the PCs with which you have already 
established a partnership. 

4. In the User Logon dialog box, type your user name, 
password, and domain if necessary, and then tap 
Connect. 
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Transferring filesTransferring filesTransferring filesTransferring files    
You can copy files between your HP Jornada and desktop PC by 
dragging icons to or from the folders in the Mobile Device 
Explorer window, or by using the Cut, Copy, and Paste 
commands on the Edit menu. 

Some files may need to be converted before you can use them on 
your HP Jornada. By default, Microsoft ActiveSync automatically 
converts files to the appropriate file type. However, you can 
choose not to convert files, or you can specify the conversions for 
each file type by changing options in the File Conversion 
Properties dialog box.  

To set file conversion options 

1. Open the ActiveSync window. 

2. On the Tools menu, click Options, click the Rules tab, and 
then click Conversion Settings. 

3. Click either the Device to Desktop or Desktop to Device 
tab. 

4. Select the file type, and then click Edit to change conversion 
options. In most cases, you will be offered a single conversion 
option or no conversion at all. 

When Microsoft Office files are converted to their corresponding 
Pocket Office formats, the Pocket Office files are compressed, so 
they require much less storage memory than they do on your 
desktop PC. During conversion, certain formatting or attributes 
may also be removed from the Pocket Office version; however, all 
formatting should be restored when the file is returned to the 
desktop PC. For specific details, see the sections on Microsoft 
Office programs in chapter 5 or refer to online Help for that 
program on your HP Jornada. Only Microsoft PowerPoint® 97 
and 2000 files can be converted to Pocket PowerPoint.  
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4 | Staying organized4 | Staying organized4 | Staying organized4 | Staying organized    

With your Hewlett Packard Jornada Handheld PC (H/PC), you 
can keep in touch with your office, home, and clients through e-
mail and the Internet. You can connect in many ways using your 
HP Jornada and various accessories. This chapter will guide you 
through the options best suited to your needs. 

Pocket Outlook also lets you set alarms and reminders so that 
you never forget an appointment or meeting. And, if you want a 
personal reminder, you can record voice memos to yourself with 
Microsoft Voice Recorder.  

In this chapter you will find program information and basic 
procedures for: 

• Pocket Outlook 

• HP viewer 

• HP quick pad 

• Voice Recorder 

For more information on these and other programs that come 
with your HP Jornada, see online Help. 

Using Microsoft Pocket OutlookUsing Microsoft Pocket OutlookUsing Microsoft Pocket OutlookUsing Microsoft Pocket Outlook  
Your HP Jornada comes with Microsoft Pocket Outlook, which 
includes Calendar, Contacts, Tasks, and Inbox. Using Microsoft 
ActiveSync, you can synchronize information on your HP Jornada 
with information in Microsoft Outlook or Microsoft Exchange on 
your desktop computer. Each time you synchronize, Microsoft 
ActiveSync compares the changes you made to data on your 
device and desktop PC and updates both computers.  

With Inbox, you can send and receive e-mail messages, either by 
synchronizing with the mail program on your desktop PC (either 
Outlook or Exchange) or by connecting directly to your mail 
server through an Internet or network account. 
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To start Pocket Outlook 

·  On the Start menu, point to Programs, point to Pocket 
Outlook, and tap either Calendar, Contacts, Inbox, or 
Tasks.  

–or– 

Press one of the Calendar, Contacts, Inbox, or Tasks hot 
keys.  

 
To switch quickly from one Pocket Outlook applications to 
another, tap the Go menu on the toolbar of the current Pocket 
Outlook application. 

Keeping appointments with Calendar 
Use Calendar to schedule appointments, meetings, and other 
events. Quickly check your appointments in one of several views 
(Day, Week, Month, Year, and Agenda).  

 To create a new appointment 

1. On the Start menu, point to Programs, point to Pocket 
Outlook, and tap Calendar.  

–or– 

Tap the Calendar hot key. 

2. On the File menu, tap New Appointment. 

3. Type a description and the location of your appointment. 

4. Select the time and date of your appointment. 

5. To add notes, tap the Notes button, and then tap once in 
the notes area. Type your notes. 

6. To assign the appointment to a category, tap the 
Categories button, and then select a category from the 
list. 

7. Select other desired options, and when you are finished 
tap OK. 

If you need to schedule a meeting with other people who use 
Outlook or Pocket Outlook, you can use Calendar to schedule the 
meeting. When attendees receive a meeting request, they can 
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choose to accept or decline the meeting. If they accept, the 
meeting is automatically placed in their schedule. In addition, 
their response is automatically sent back to you, and your 
calendar is updated. 

Before you can send a meeting request, you must enter e-mail 
addresses in Contacts and set up Inbox to send and receive 
messages (see the Using Inbox section in chapter 6).  

To create a meeting request  

1. On the Start menu, point to Programs, point to Pocket 
Outlook, and then tap Calendar.  

–or– 

Tap the Calendar hot key. 

2. On the Tools menu, tap Options, and then choose a 
mail transport: 

• If you send and receive messages using 
synchronization, select ActiveSync.  

•  If you connect to an ISP or network, select the 
service you set up in Inbox or the HP Jornada dialup 
application. 

3. Tap OK. 

4. On the File menu, tap Make Meeting. 

5. Enter the meeting information. 

6. Select the contacts you want to invite. 

Select other desired options, and then tap OK. 

Inbox automatically creates a meeting request and sends it to the 
attendees the next time you connect to your mail server or 
synchronize with your desktop PC. 

Your HP Jornada will remind you about your appointments 
and meetings by playing a sound, flashing the notification 
light, and/or displaying a message on the screen. To choose the 
way you prefer to be notified, open the appointment or 
meeting, tap  , and then tap Reminder Options. You can 
silence an alarm without even opening your HP Jornada by 
pressing the blinking alarm-notification LED on the cover. 
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Managing names and addresses with Contacts 
The Contacts program maintains a list of your friends and 
colleagues so that you can easily find the information you 
are looking for, whether you are at home or on the road. 
Using the infrared port, you can also quickly share 
Contacts information with other MS Windows for H/PC 
2000–based mobile device users. 

 To create a new contact 

1. On the Start menu, point to Programs, point to Pocket 
Outlook, and tap Contacts.  

–or– 

Tap the Contacts hot key. 

2. On the File menu, tap New Contact. 

3. Type a name. 

4. Tap Business or Personal and type information in the 
appropriate fields. Supply an e-mail address to send 
meeting requests and e-mail messages to this contact. 

5. To add a note or assign the contact to a category, tap 
Notes/Categories. Then, select the notes area and 
enter your notes, or select a category from the list. 

6. When you are finished, tap OK. 

 
You can send groups of contacts to another IrDA-equipped 
H/PC 2000–based device. To do this, line up the infrared ports 
on the two devices so that they are within 1 meter (3 feet) of 
one another. On the Contacts list, select the item(s) you want 
to send, and then on the File menu, tap Send. If you are 
receiving items, tap Receive. Category information and notes 
are not transmitted with the contact. 

Keeping track of your workload with Tasks 
The Tasks program helps you keep track of what you need 
to do. Enter the details for a task on the task card, and 
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then assign a category. You can even associate a date with 
the task and then set a reminder for yourself. 

 

You can sort the list on any column by tapping the column 
heading (the column used for sorting the list displays a triangle 
in the heading). If you sort by status, active tasks are listed 
before completed tasks. Or, you can filter your list to show only a 
specific status of a task or tasks belonging to a specific category. 
When your list is filtered, the filter button is selected. Overdue 
tasks are displayed in red, bold text. 

To create a new task 
 

1. On the Start menu, point to Programs, point to Pocket 
Outlook, and tap Tasks.  

–or– 

Tap the Tasks hot key. 

2. On the File menu, tap New Task. 

3. Type a description of the task. 

4. Select the start date, due date, and other information. 

5. To add a note to a task, tap the Notes button, and then 
tap once in the note-taking area. Type your note, and 
then tap OK. 

6. When you are finished, tap OK. 

Managing your e-mail with Inbox 
Use Inbox to send and receive e-mail messages. You can access 
your e-mail by synchronizing with your desktop PC or by 
connecting to a mail server through an Internet or network 
account. (For more information, see the Using Inbox section in 
chapter 6 and the Synchronizing e-mail messages section in 
chapter 3.) 
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Using HP viewerUsing HP viewerUsing HP viewerUsing HP viewer    
HP viewer gives you a quick and versatile way to view the 
information in your Pocket Outlook Calendar, Contacts, and 
Tasks databases. HP viewer displays the information you choose 
in as much detail as you want, including detailed contact 
information, tasks and notes on a single screen, or all the 
appointments and tasks scheduled for a single day, a week, or up 
to 6 months at a time. HP viewer also enables you to view a 
single field for any record or to switch instantly to Pocket Outlook 
for editing. 

By default, the HP viewer icon is displayed on the MS Windows 
for H/PC 2000 desktop.  

 
To start HP viewer 

·  On the Start menu, point to Programs, point to HP 
Applications, and then tap HP viewer. 

–or– 

Press the HP viewer hot key. 

HP viewer shows your Pocket Outlook information quickly. 

 
HP viewer uses the same font settings as Internet Explorer. 
Changing the font or font size in Internet Explorer will also 
change the way information is displayed in HP viewer. 

You can quickly switch from HP viewer to Pocket Outlook to look 
at the selected date in all Calendar views. 

To switch to Pocket Outlook  

·  On the Go menu, tap the appropriate program or view. 
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HP viewer displays the current date and your next scheduled 
appointment below the toolbar in the Today Banner of the HP 
viewer window. To quickly view detailed information about the 
appointment, tap the appointment title in the Today Banner. 

To switch between Calendar, Contacts, and Task 
information 

·  Tap the appropriate icon on the left side of the HP viewer 
window. 

Viewing Calendar information 
HP viewer lets you view your calendar in Day, Week, Month, or 
n-Month view.  

·  Tap the Calendar icon on the left side of the HP viewer 
window to display Calendar information. 

·  Tap a View button on the toolbar to change views. 

·  Tap the Go to Date button on the toolbar to view information 
for a specific date. 

 n-month (displays up to 6 months) 

 Month 

 Week 

 Day 

 Today (GoTo Today command) 

 Date (GoTo Date command) 
 
Day View offers a fast way to browse your schedule for the 
current day or up to 7 days that you select.  
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To enable Day Zoom in n-Month View, Month View, or Week 
View, press the spacebar to display appointments and tasks for 
the selected date(s). Tap an icon next to an appointment or event 
to expand a note or to display more information about that 
appointment or event. 

 
You can set HP viewer to always display Day Zoom for the date 
you select by tapping  on the toolbar. 

 
Week View enables you to display 1, 2, or 3 weeks of your 

calendar at a time. Press  as you tap  or  on the 

scroll bar to increase or decrease the number of weeks displayed. 
Tap an event to display detailed information about that event. 

Use Month View to display 5 weeks of data on a single screen, or 
use n-Month View to display calendars for up to 6 months at a 
time. Tap a day to display detailed information about 
appointments or events scheduled on that day. 

 
To show six months in n-month view, set the Task bar to auto-
hide. Tap Start, Settings, then tap Task Bar to access the 
Task Bar settings dialog. 

Viewing Contacts information 
HP viewer lets you view all information for a particular contact 
on a single screen.  

• Type in the Find File As box to display only contacts 
matching the letter(s) you type. 

• Tap a tab on the left side of the contact list to jump to contacts 
that begin with a letter on the tab. To jump to contacts that 
begin with the second letter on the tab, tap the tab again. 

• To change the field on which the contact list is sorted, tap the 
field name at the top of the list, and then choose a field from 
the Select Primary Key dialog box. 

Viewing Tasks information  
You can also use HP viewer to view task information for any 
field, including Notes. 
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• Type in the Find Task box to display only tasks that match 
the letter(s) you type. 

Capturing data with HP quick padCapturing data with HP quick padCapturing data with HP quick padCapturing data with HP quick pad    
Use HP quick pad to enter all the notes and information 
you acquire during your day. Quickly record names, 
telephone numbers, and quick notes to yourself. You can 
save this information in HP quick pad or create 
appointments, tasks, e-mail messages, and even Pocket 
Word documents from a single application. 

 

With quick pad, you can check the date and time at a glance, 
review your current appointments and tasks, and quickly find a 
telephone number or address from your contact list.  

Quickly jot notes and reminders or new contact information on 
the notepad. Then, save your notes in quick pad or send them to 
the appropriate database, such as your Contacts or Tasks list. 

To start HP quick pad  

·  On the Start menu, point to Programs, point to HP 
Applications, and tap HP quick pad. 

–or– 

Press the HP quick pad hot key. 
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To save information in HP quick pad 

·  On the File menu, tap New Page to create a blank notepad 
page. 

·  Tap once in the notepad area, and then type the information 
you want to save. 

·  On the File menu, tap Rename Page, and then type a 
descriptive name for the information. 

·  On the File menu, tap Save. 

You can create as many pages as you like. Retrieve information 
by selecting the page title from the drop-down list, or by tapping 
Find in Page on the Edit menu, and then typing a word or 
words to search for.  

To organize information for use in other programs 

1. In HP quick pad, open the page containing the information, 
and select the text you want to export. 

2. On the Send menu, select the program in which you want to 
use the information: 

•  Tap As E-mail Message to create an e-mail message 
containing the selected text. 

•  Tap To Calendar, To Contacts, or To Tasks to 
create an entry in one of the Pocket Outlook 
databases. 

•  Tap As New Pocket Word Document to create a 
Pocket Word document containing the selected text. 

3. In the dialog box that appears, add any necessary 
information (for example, the start or end date of a task or 
appointment, or addressees for an e-mail message), and then 
tap OK. 

Infrared send/receive of PIM data Infrared send/receive of PIM data Infrared send/receive of PIM data Infrared send/receive of PIM data     

HP info exchange allows you to send and receive Contacts, 
Calendar and Task items between your HP Jornada and 
other IrDA-equipped, non-Windows powered PDA devices 
(i.e., Palm devices). You can also receive (but not send) 
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memos from some PDA devices and store them as a text 
file in the "My Documents" folder of your HP Jornada. 

Using HP info exchange with non-Windows powered 
PDA devices 

HP info exchange allows you to send and receive PIM data 
to and from non-Windows powered PDA devices from 
within Pocket Outlook Calendar, Contacts and Tasks. (HP 
info exchange is not available in Pocket Outlook Inbox.) 

HP info exchange runs only on your HP Jornada – no 
additional software is required for IrDA equipped PDA devices.  

Sending data to a non-Windows PDA device 

To send PIM information from your HP 
Jornada to a non-Windows PDA device: 

 

1. Highlight items to send in your PIM application. 

2. Make sure the PDA device is powered on. Align the IR 
windows of the two devices so that they are aimed directly at 
each other. 

3. Select Send(non-Windows) from the Tools menu of a PIM 
application on your HP Jornada. The HP info exchange 
Send window will appear indicating that it is looking for a 
receiving device. 

4. The PDA device will receive the transmitted items 
automatically. 
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HP info exchange menu items in Pocket Outlook Contacts 

Receiving data from a non-Windows PDA device 

 

To receive PIM information on your HP 
Jornada from a non-Windows PDA device: 

1. Set the PDA device to beam selected item(s). 

2. Align the PDA device IR window so that it is aimed directly 
at the IR window on the rear of your HP Jornada. 

3. Select Recv(non-Windows) from the Tools menu of a PIM 
application on your HP Jornada. The HP info exchange 
Receive window will appear indicating that it is looking for 
a sending device. 

 

4. The PIM item(s) sent by the PDA device will be received and 
automatically placed in the appropriate location. 

5. Messages will be displayed confirming the number and type 
of items transferred. 
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About the data being transferred 
HP info exchange makes it easy to send and receive essential 
information to or from non-Windows PDA devices. The important 
data fields of your HP Jornada PIM applications are mapped to 
the data fields on the PDA device to allow capture of important 
PIM information. Supported field mappings include: 

• Supports sending and receiving multiple contacts, 
appointments and tasks. 

• A number of Pocket Outlook fields are not used (e.g. Children, 
Spouse) since they are not used by non-Windows PDA devices, 
or are not supported by the VCard standard. 

• Multiple entries of important field types will be placed in the 
Notes section. 

• For standard Contact fields multi-line text is converted into a 
single line with spaces for line breaks 

• Supports a 'Business Card' beamed over from a Palm device 
and treats it as another contact. 

For more information about field mappings and data exchange, 
see HP info exchange online help. 

Recording and playing voice memosRecording and playing voice memosRecording and playing voice memosRecording and playing voice memos    
You can use Microsoft Voice Recorder to quickly capture 
thoughts, reminders, and ideas. Since your recordings are 
captured in the compatible Wave (.wav) format, you can send 
personalized voice messages to friends and colleagues as e-mail 
attachments that can be opened in most Web browsers on a 
desktop PC.  

Voice Recorder is intended for recording personal voice memos 
and is not suitable for recording presentations, music, or 
lectures. Some static or electrical noise may be heard during 
playback. 
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To record and to play a voice memo with Voice 
Recorder 

1. On the Start menu, point to Programs, point to 
Accessories, and then tap Voice Recorder. 

–or– 
Press the Voice Recorder hot key. 

2. Tap the Record button on the toolbar. A beep sounds when 
recording begins, and the red Status LED indicates that 
recording is in progress. 

3. Speak into the microphone to record your voice memo. 

4. To stop recording, tap the Stop button on the toolbar. The 
new recording appears in the recording list. 

5. To play a recording, double-tap it in the recording list. To 
pause playback, tap Play/Pause. Tap Play/Pause again to 
resume playback.  

 
You can play all of your recordings, one after another. Select 
the recording you want to play first, tap Control and then tap 
Play Sequential. The selected recording and following 
recordings will be played. A short beep will sound between 
recordings. 

Recording formats 
Your HP Jornada supports several formats for voice notes. The 
formats vary in both the quality of the recording and the size of 
the sound file. When selecting a recording format, you should 
consider the quality you need as well as how much storage 
memory the recording will use on your HP Jornada. 

In addition, not all recording formats are compatible with other 
software or computers. If you will share your recordings with 
others or transfer a recording to your desktop PC, be sure to 
choose a recording format that is supported by the software used 
to play recordings on the other computer.  

To select a recording format 

1. On the Start menu, point to Programs, then point to 
Accessories and then tap the Microsoft Voice Recorder 
icon. 
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—or— 
 Press the Voice Recorder hot key on the HP Jornada 

keyboard. 

2. On the Tools menu tap Recording Format…, and then 
select a recording format from the drop-down list.  

The table below lists the compatibility of various recording 
formats with other computers. The list of recording formats on 
your HP Jornada indicates the sample rate, whether the format 
is stereo or mono, and how much storage memory is required per 
second of recording. You may need to experiment with different 
sample rates and formats to determine which format best suits 
your voice. 

Compatibility 

Format Quality HP Jornada 
700 Series 

Windows 
CE 2.0 
device 

PC with 
ActiveSync 

installed 

Windows 
95/98/NT 

PCM High yes yes yes yes 

GSM 6.10 Medium yes yes no no 

Conserving memory 
Voice memos may consume large amounts of storage memory on 
your HP Jornada. If you record or store lots of voice memos, you 
may need to take steps to conserve memory. 

• Delete voice memos you no longer need. Select the recording in 
the list, and then tap Delete on the File menu. Note that 
voice memos are deleted immediately; they are not moved to 
the Recycle Bin and cannot be recovered. 

• Adjust the amount of storage memory available on your HP 
Jornada using the Memory tab in the System control panel.  

• Add more memory to your device with a CompactFlash Card 
or PC Card. (For a list of recommended cards, go to the 
Hewlett-Packard Web site at www.hp.com/jornada.) 
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5555 | Getting| Getting| Getting| Getting down to  down to  down to  down to 
businessbusinessbusinessbusiness    

 

 

Your Hewlett-Packard Jornada 700 Series Handheld PC can help 
you stay productive and be efficient, even when you are away 
from your desktop or notebook PC. You have access to Microsoft 
Pocket Office and other pre-installed programs to help you 
calculate expenses and conduct searches. Your HP Jornada also 
includes the HP Jornada backup application, which keeps things 
running smoothly.  

In this chapter, you will learn more about: 

·  Microsoft Pocket Office, which includes: 

- Microsoft Pocket Word 

- Microsoft Pocket Excel 

- Microsoft Pocket PowerPoint 

- Microsoft Pocket Access 

·  Microsoft InkWriter 

·  HP Jornada backup application 

·  OmniSolve from LandWare  
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Working with Microsoft Pocket OfficeWorking with Microsoft Pocket OfficeWorking with Microsoft Pocket OfficeWorking with Microsoft Pocket Office    
Microsoft Pocket Office makes it easy to work in the familiar 
Office environment, even when you are away from your desktop 
or notebook PC. You can start any of the Pocket Office programs 
by double-tapping the appropriate icon on the desktop or by 
pressing the appropriate HP hot key. For more detailed 
information about these programs, see the Microsoft Pocket 
Office topic in online Help. 

Using Microsoft Pocket Word 
You can create and edit documents or templates in Pocket Word 
just as you do in Microsoft Word on your desktop computer. Begin 
by placing the cursor in the document page and start typing in 
either Outline or Normal view. A spelling checker is provided to 
verify spelling accuracy, and you can quickly format text using 
buttons and menu commands similar to those found in Microsoft 
Word on your desktop PC. You can access international 
characters and symbols for currencies from the Tools menu.  

Pocket Word allows you to save documents in several file formats 
so that your files can be opened by other users or other programs. 
If you transfer documents between your HP Jornada and desktop 
PC, Microsoft ActiveSync automatically converts the files to the 
appropriate file type. If you send files by e-mail, be sure you save 
your document in a format that can be opened by the recipient: 

file type extension open with 

Pocket Word document .pwd Pocket Word 

Pocket Word template .pwt Pocket Word 

Word 6.0/95/97/2000 
document 

.doc Microsoft Word 
2000 

Word 6.0/95/97/2000 
template 

.dot Microsoft Word 
2000 

Rich Text Format .rtf most word 
processing 
programs 

ASCII text .txt any text editor 
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To start Pocket Word 
 

·  On the Start menu, point to Programs, point to Office, and 
then tap Microsoft Pocket Word. 
–or– 
Press the Microsoft Pocket Word hot key. 

To create a document using Pocket Word  

1. On the File menu, point to New, and then tap Document. 

2. Type the document. 

3. On the File menu, tap Save. 

4. Type a name for your file, and then tap OK. 

To see more of your document, on the View menu, tap  
Full Screen.  

Using Microsoft Pocket PowerPoint 
You can deliver professional online presentations with Pocket 
PowerPoint. Simply create the presentation in Microsoft 
PowerPoint 97 on your desktop PC and transfer the presentation 
to your device. You cannot create slides on your HP Jornada; 
however, you can customize the title slide in the presentation and 
change the order of the subsequent slides to suit a particular 
client or audience. 

You can show the presentation directly on your HP Jornada, or 
you can use an HP VGA out card to connect an external monitor 
or a projector and show the presentation to a large group. This 
option allows you to view PowerPoint speaker notes on the HP 
Jornada display while your presentation is showing on the 
external monitor. Your Pocket PowerPoint file will include the 
text, pictures, notes, and layout position of the original Microsoft 
PowerPoint presentation, but will not include animations or slide 
transitions. Animations are displayed as a single, still frame. 
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 To start Pocket PowerPoint 

·  On the Start menu, point to Programs, point to  Office, 
and tap Microsoft Pocket PowerPoint. 
–or– 
Double-tap the Microsoft Pocket PowerPoint icon on the 
desktop. 

 To show a presentation 

1. Using Microsoft ActiveSync, copy the presentation from your 
desktop PC to your HP Jornada. 

2. On the Start menu, point to Programs, point to Office, and 
tap Microsoft Pocket PowerPoint. 

3. In the Open Presentation dialog box, select the 
presentation you want to show, and then tap OK. 

4. To change the presentation display and slide-advance 
options, on the Tools menu, tap Set Up Show. 

5. To show the presentation, tap View Show on the View 
menu. If you chose Manual under Presentation Display in 
step 4, use the Previous and Next buttons to control the 
slides. 

 
You can tailor a presentation by adding a new title slide to 
your presentation. To do so, tap Title Slide on the 
Tools menu. 

 To show a slide presentation on a VGA-
compatible monitor 

1. Insert an HP VGA out card into your HP Jornada, and then 
connect the card to a monitor or projector according to the 
instructions that came with the card. 

2. Start PowerPoint, and open the presentation (see To show a 
presentation earlier in this chapter). 

3. On the Tools menu, tap Set Up Show. 

4. From the View Show On list, select one of the VGA out 
options. 
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5. To start the show, tap View Show on the View menu. 

You can make the display fade to black during a presentation. 
To do so, press . To make the screen fade to white, press 

. Press  or  again to resume the presentation. 

 

Using Microsoft Pocket Excel 
You can use Pocket Excel to create workbooks, such as expense 
reports and mileage logs. Pocket Excel provides fundamental 
spreadsheet tools, such as formulas, functions, sorting, and 
filtering. You can split panes to easily view different areas of a 
large worksheet. You can also “freeze” the top and leftmost panes 
in a worksheet to keep row and column labels or other data 
visible as you scroll through a sheet.  

Pocket Excel allows you to save workbooks in several file formats 
so that your files can be opened by other users or other programs. 
If you transfer workbooks between your HP Jornada and desktop 
PC, Microsoft ActiveSync automatically converts the files to the 
appropriate file type. If you send files by e-mail, be sure you save 
your workbook in a format that can be opened by the recipient.  

To start Pocket Excel  

·  On the Start menu, point to Programs, point to  Office, 
and then tap Microsoft Pocket Excel. 
–or– 
Double-tap the Microsoft Pocket Excel icon on the desktop. 

To create a workbook using Pocket Excel  

1. On the File menu, point to New, and then tap Workbook. 

2. Create your worksheet. 

3. On the File menu, tap Save. 

4. Type a name for your file, and then tap OK. 

If your workbook contains sensitive information, you can 
protect it with a password. To do so, open the workbook and 

Password File
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workbooks cannot be synchronized. 

Using Microsoft Pocket Access 
You can use Pocket Access to view and update data derived from 
Microsoft Access, Microsoft SQL Server, and other ODBC 
databases on your HP Jornada. You can open the database and 
update data in the corresponding tables or you can fill out 
electronic forms. Eventually, you should synchronize the new 
information with a larger database on your desktop PC or your 
corporate network. You can also use Pocket Access to create new 
databases, tables, and SQL procedures directly on your device.  

 
Programmers can use Microsoft ActiveX™ Data Objects for MS 
Windows for H/PC 2000 (ADOCE) and Microsoft Visual 
Basic™ or Microsoft Visual C++™ to develop custom database 
solutions. For more information on creating custom database 
solutions, go to the Microsoft Web site at 
www.microsoft.com/mobile. 

 
To create a new database and table 

1. On the Start menu, point to Programs, point to Office, and 
then tap Microsoft Pocket Access. 
–or– 
Double-tap the Microsoft Pocket Access icon on the desktop.  

2. On the View menu, tap Database View, and then tap 
Open/New Database on the File menu. 

3. Type a name for the database and tap OK. 

4. Double-tap the Create a New Table icon. 

5. In the Field Name box, type a name. 

6. From the Data Type list, select a data type. 

·  The data type of a field cannot be changed after the table is 
saved.  

·  Text boxes have a size limit of 255 characters. To enter 
longer notes, select the Memo data type. 

·  To enter numbers with decimal points, select the Float data 
type. 

·  To enter numbers between -32,768 and +32,767, select the 
Integer data type. 
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·  To enter smaller numbers, select the Small Integer data 
type. 

7. To set the size limit of a field, enter an amount in the Field 
Size box. You cannot change field sizes after the table is 
saved. 

8. To index the field, select Yes from the Indexed list. Indexing 
a field allows Pocket Access to find and sort information 
faster for that field. 

9. Repeat these steps until you have created all the fields you 
want for your table. 

10. On the File menu, tap Save Table. 

If you have tables that you do not want to keep updated on the 
device (such as product catalogs), mark them as read-only 
when transferring them from the desktop to the device to save 
time during future synchronization sessions. Microsoft 
ActiveSync will not check for updates the next time you 
synchronize. 

 

Printing your Pocket Office documents 
You can print your Pocket Office and other documents from your 
HP Jornada in three different ways: 

·  By connecting directly to a PCL printer using the optional 
HP parallel printer cable (F1274A). For a list of compatible 
printers, refer to the HP parallel printer cable User’s Guide 
that came with your HP Jornada.  

·  By connecting via infrared port (only with an infrared-
equipped PCL printer). 

·  By transferring the file to your desktop PC and printing it 
from within a program on the desktop PC. 

For instructions on printing directly to a printer using the HP 
parallel printer cable, see the HP parallel printer cable User’s 
Guide.  

To print directly to a printer via infrared  

1. Open the file or document you want to print. 

2. On the File menu, tap Print. The Print dialog box appears. 
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3. Choose the PCL printer you will be printing to and select the 
IrDA port option. 

4. Set other print options as necessary. 

5. Tap OK, and then line up the infrared port on your HP 
Jornada with the infrared port on the printer. 

Using Microsoft InkWriterUsing Microsoft InkWriterUsing Microsoft InkWriterUsing Microsoft InkWriter    
InkWriter, a text, graphics, and ink processor with Rich Ink 
technology, makes it easy to write and draw the way you do on 
paper, but with the benefit of being able to edit and format your 
writings and drawings. With InkWriter, you can enter 
information in the way that is easiest for you: type using the 
keyboard or write or draw on screen using the stylus. 

 
To create an InkWriter document 

1. On the Start menu, point to Programs, point to 
Accessories, and then tap InkWriter. 

2. Create your document: 

·  To type, tap Writing on the View menu, and then use the 
keyboard. 

·  To draw, tap Drawing on the View menu, and then drag the 
stylus to draw on the touch screen. You can also create a 
drawing in Writing view by crossing three of the ruled lines on 
the first stroke of the drawing. 

3. When you are finished, tap Save on the File menu. 

Backing up and restoring dataBacking up and restoring dataBacking up and restoring dataBacking up and restoring data    
To prevent loss of data, you should back up your HP Jornada 
data frequently. You can back up your HP Jornada two 
convenient ways: 

·  Use Microsoft ActiveSync to back up all data to your desktop 
PC. 

·  Use the HP Jornada backup application to back up all data 
or only PIM data (Contacts, Calendar, Tasks and Inbox 
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databases) to a PC Card or CompactFlash Card or to internal 
memory. 

Using Microsoft ActiveSync Backup 
The Microsoft ActiveSync Backup feature creates a complete 
duplicate of all data stored on your HP Jornada. If you routinely 
connect to your desktop PC, this is the best method of data 
backup. The backup file is saved on the hard disk of your desktop 
PC.  

Backing up data with ActiveSync on your desktop PC 
If you have established a partnership between your HP Jornada 
and desktop PC, you can set ActiveSync to back up data 
automatically each time you connect. You can also back up your 
HP Jornada manually any time you want. ActiveSync lets you 
decide whether to back up all information each time, or only new 
and updated information.  

To back up data with ActiveSync 

1. Connect your HP Jornada to your desktop PC. 

2. In the ActiveSync window on your desktop PC, on the 
Tools menu, tap Backup/Restore, and then tap the 
Backup tab. 

3. Select either Full Backup (to back up all information 
every time) or Incremental Backup (to backup only 
new or updated information). 

4. Click Change to change the name of your backup file or 
to specify a location for your backup file. 

5. Tap Back Up Now. 

Restoring data with ActiveSync from your desktop PC 
When you restore data from a backup file created by ActiveSync, 
all data on your HP Jornada is replaced by the data in the 
backup file, including files you have created, programs you have 
installed, and any system settings and options you have set.  

Restoring data from ActiveSync replaces all information stored 
on your HP Jornada. Any data added after the backup file was  
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created will be lost. 

 

To restore data with ActiveSync 

1. Connect your HP Jornada to your desktop PC. 

2. Close all running applications on your HP Jornada. 

3. In the ActiveSync window on your desktop PC, on the 
Tools menu, click Backup/Restore, and then click the 
Restore tab. 

4. Click Restore Now. Do not use your device until the 
restore process is complete. 

5. Disconnect the serial sync cable or remove your HP 
Jornada from the cradle (optional on the HP Jornada 
710), remove the CompactFlash card (if installed), and 
perform a soft reset on your HP Jornada. See the 
Resetting your HP Jornada section in chapter 9.  

Using the HP Jornada backup application  
To ensure the complete safety of your data, use the HP Jornada 
backup application to back up to an optional CompactFlash Card. 
By backing up to a CompactFlash Card, you can safeguard your 
data even while you are traveling or while you are away from 
your desktop PC. HP backup lets you choose to back up all data 
or only PIM data (Calendar, Contacts, and Tasks, and Inbox). For 
information on using CompactFlash Card accessories with your 
HP Jornada, see the Using PC Cards, CompactFlash Cards 
and Smart Cards section in chapter 7. 

 

If you have both a CompactFlash Card and a PC Card 
installed, two folders appear in the My Handheld PC folder. 
The folders appear in My Handheld PC in the order in which 
the storage cards are inserted. 

You can also back up data to a folder on your HP Jornada; 
however, this will not preserve the information in case you lose 
power or need to perform a factory default reset. (See the 
Resetting section in chapter 8.)  
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Backing up data with HP backup 

To back up data  

1. On the Start menu, point to Programs, point to HP 
Applications, and then tap HP backup. 

2. Tap Backup. 

3. Choose what you want to backup: 

·  Select Full backup to back up all information stored in RAM, 
including files you have created and programs you have 
installed. (Certain system settings and passwords are not backed 
up.) 

·  Select Backup only databases to back up only your Contacts, 
Tasks, and Calendar databases and/or Inbox databases 

4. Choose other Backup options to password protect or 
encrypt your backup file. 

5. Tap Backup Now and choose a file name and folder location 
for your backup file. Then tap OK to complete the backup 
process. 

For additional protection, you can copy the backup file (*.dbe 
or *.dbb) from your HP Jornada to your desktop PC.  

Restoring data with HP backup 

To restore from a backup file  

1. First, remove the backup battery, the main battery, and the 
ac Power adapter. Wait for five full minutes, then reinstall ac 
power and the batteries in the reverse order. 

2. On the Start menu, point to Programs, point to HP 
Applications, and then tap HP backup. 

3. Choose what you want to restore, Full restore or Restore 
only databases, then tap Restore Now. 

4. Select the backup file you want to restore from, and then tap 
OK to complete the restore process. 
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5. After completion, perform a soft reset before using your HP 
Jornada (see the Resetting section in chapter 8). 

 
When you restore, your HP Jornada must have the same 
regional settings as when you completed the backup. 
Otherwise, you will not be able to restore the files. To change 
regional settings, on the Start menu, point to Settings, tap 
Control Panel, and then double-tap the Regional Settings 
icon. Select your region from the drop-down list. 

Using OmniSolve from LandWareUsing OmniSolve from LandWareUsing OmniSolve from LandWareUsing OmniSolve from LandWare    
OmniSolve is a financial application that offers the same features 
as the HP business calculator. It is designed specifically for real 
estate, retail, and business professionals who use Handheld PCs 
to make financial decisions quickly and accurately. OmniSolve 
employs a “form filling” metaphor to provide you with a rich 
problem-solving environment that is unparalleled in its ease of 
use, power, and flexibility. 

 
To start OmniSolve 

·  On the Start menu, point to Programs, point to 
Accessories, and then tap OmniSolve. 

For detailed procedures about using OmniSolve, refer to 
OmniSolve online Help. 

Using Yahoo! MessengerUsing Yahoo! MessengerUsing Yahoo! MessengerUsing Yahoo! Messenger    

To get started using Yahoo! Messenger 

1. To activate Yahoo! Messenger you must create a free Yahoo 
account by visiting the Yahoo! Messenger Web site at: 
http://messenger.yahoo.com/messenger/. When you sign up 
for your free account you will create a login ID and password. 

2. Open Yahoo! Messenger and enter your login information at 
the login screen. 

3. Next, choose your connection preference (you will be 
prompted for this after you login). Enter the username and 
password for your ISP, and click "Connect". 
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That's all there is to it! Now you are ready to share instant 
messages with family, friends and associates. For more detailed 
information about using Yahoo! Messenger, go to the Yahoo! 
Messenger help page on the Web at: 
http://help.yahoo.com/help/us/mesg/ 
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6 |6 |6 |6 | Accessing e Accessing e Accessing e Accessing e----mailmailmailmail    

With your HP Jornada Handheld PC (H/PC), you can keep in 
touch with your office, home, and clients through e-mail and the 
Internet. You can connect in many ways using your HP Jornada 
and various accessories. This chapter will guide you through the 
options best suited to your needs. 

This chapter provides information that allows you to: 

• Decide why and how you want to connect 

• Set up your HP Jornada to access personal or e-mail and the 
Internet 

• Set up your HP Jornada to access corporate e-mail and your 
network or PC when you are away from the office (offsite) 

• Set up your HP Jornada to access corporate e-mail and 
network resources when you are in the office (onsite) 

• Set up additional connections with the HP Jornada dialup 
application or Remote Networking 

• Use your connections with Inbox and Microsoft Internet 
Explorer 4.01 for H/PC 

Deciding how and why you want to connectDeciding how and why you want to connectDeciding how and why you want to connectDeciding how and why you want to connect    
The method you use for sending and receiving your e-mail, 
browsing the Internet, and accessing other remote resources 
depends on your goals and situation. Do you: 

• Need access to personal (non-corporate) e-mail and the 
Internet? 

• Need access to corporate e-mail and network services when 
you are on the road or out of the office? 

• Need access to corporate e-mail and network services when 
you are onsite at your company? 
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• Have more than one e-mail account (for example, personal and 
business)? 

Your answers to these questions will help you determine which 
equipment you can use in combination with your HP Jornada to 
keep in touch online. The following illustration depicts the 
different solutions to your online needs. 

Which connection options are right for you? 

 
For explanation of some of the terms used in the descriptions 
that follow or in the HP dialup application, check the glossary 
at the end of this User’s Guide. 

Accessing e-mail, the Internet, and corporate 
intranets  

Typical personal Internet connection 

 

If you want e-mail and Internet service only (with no access to a 
company network), you will need: 

• An installed modem—If your HP Jornada is equipped with a 
built-in modem, you are ready to go. If not, you can choose 



 Chapter 6 | Accessing e-mail | 87 

  

from a variety of available PC Card modems∗, Bluetooth 
devices, and LAN cards. (For more information about 
compatible PC Card modems and other PC Card 
communication devices, go to the HP Jornada Accessories page 
on the HP Jornada Web site at www.hp.com/jornada.) 

• A PPP (Point-to-Point Protocol) or SLIP (Serial Line 
Internet Protocol) account—An Internet service provider 
(ISP) will provide you with important information, such as a 
user name, password, dial-up telephone number, server 
names, and so on. 

• A dial-up connection set up on your HP Jornada—HP 
dialup makes this step easy.  

• Access to a telephone line—You can connect to an analog 
telephone line if your HP Jornada has a built-in modem. If you 
use a PC card modem, check the manufacturer’s instructions 
for telephone line compatibility.  

If you use the HP Jornada internal modem, you must use an 
analog telephone line to connect your modem. Connecting to a 
digital telephone line can damage your modem. 

 

Connecting to corporate e-mail and network from 
off-site 
 

 

Typical corporate LAN remote (off-site) connection 

If you want dial-up access to corporate e-mail and Internet 
services when you are offsite, then, in addition to the items 
necessary for a personal internet connection listed above, you will 
need: 

                                                                 
∗ Modem purchased separately. Some Web sites/content may not be 
available. 
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• An account with your corporate network set for dialing 
in to your network server—Your network administrator 
can provide you with important information, such as a user 
name, password, dial-up telephone number(s), server names, 
and so on. 

Connecting to corporate e-mail and network  
resources on-site 

 

Typical corporate LAN on-site network connection 

If you want corporate e-mail and Internet service only (with no 
access offsite), you will need: 

• An installed network interface card (NIC)—that is 
properly configured with the IP address of your DNS and 
WINS servers (your network administrator can give you this 
information)  

• An account with your corporate network—including an 
IP address for your HP Jornada, if it is not dynamically 
assigned 

• A network (LAN) connection—a network cable with the 
appropriate connector for your NIC 

• For detailed instructions on how to connect your HP Jornada 
to a network via LAN cable, see Connecting directly to 
corporate e-mail and network resources through a 
network interface card (NIC) later in this chapter. 

Creating ConnectionsCreating ConnectionsCreating ConnectionsCreating Connections    
Once you have decided what type of connection method you need, 
you easily create and configure a Internet, intranet or network 
connection by following the instructions in the following pages. 

Since personal Internet and off-site corporate dialup connections 
methods are quite similar they are addressed first, followed by 
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instructions for creating an on-site connection to a local area 
network (LAN). 

Personal and corporate dialup connections 

Installing and configuring a modem 
If you purchased an HP Jornada with a built-in 56K V.90 modem, 
it is already setup for easy communication. No installation is 
required.  

The 56Kbps modem complies with V90 ITU 56K specifications 
and has a design capability of receiving data at up to 56Kbps 
from a compatible service provider, and transmitting data at 
up to 31.2Kbps. Public networks currently limit maximum 
download speeds to about 53Kbps. Actual speeds depend upon 
many factors and are often less than the maximum possible. 

 

 
Note that the UK version of HP Jornada does not support certain 
dialing properties. The HP Jornada built-in modem (on models 
equipped with a built-in modem) does not detect a dial tone 
before dialing. By default, the Wait for dial tone before dialing 
box is checked. The modem will dial even if there is no dial tone. 
It also does not support the pulse dial option. The modem dials 
using tone dial only. By default, tone dialing is selected. 

The HP Jornada supports a variety of available PC Card 
modems*. (Check www.hp.com/jornada for more information on 
compatible PC card modems.) Follow the manufacturer’s 
instructions included with the PC Card modem to install and 
configure it for use with your HP Jornada. 

Getting an account with an Internet service provider  
To access the Internet and e-mail, you will need to contact an ISP 
to set up a PPP account. SLIP accounts are offered by some ISPs 
instead of PPP accounts. Your HP Jornada supports the use of 
SLIP as well as PPP.  

                                                                 
*Modem purchased separately. Some Web sites/content may not be 
available. 
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Your ISP will be able to give you all the configuration information 
you need to connect your HP Jornada to the Internet and e-mail 
service. Be sure to note the following: 

• Your account user name. 

• Your account password. 

• Telephone number of your ISP modem. 

• IP and DNS addresses, if necessary (most dial-up accounts are 
assigned addresses dynamically each time you connect). 

• Your e-mail user name or ID. (This may be the same as the 
user name for your ISP account.) 

• Your e-mail password. (This may be the same as the password 
for your ISP account.) 

• The POP3 or IMAP4 host name of your ISP.  

• The SMTP host name of your ISP (if required by your ISP). 

Setting up a dial-up connection to your ISP 
Use HP dialup to create a dial-up connection to the Internet or to 
a corporate network and to configure e-mail and Web services. 

After you have established an account with an ISP, you can set 
up a connection on your HP Jornada and connect to the Internet 
and your e-mail whenever you want. To make this configuration 
process easier, use the HP Jornada dialup application. The HP 
dialup Setup Wizard leads you through the process of 
configuring your connections. 

The first time you start HP dialup, the Setup Wizard leads you 
step-by-step through the processes of creating and configuring: 

• a connection to your service provider 

• a dialing location 

• an e-mail service 

• a Web service. 

The settings you create in HP dialup are used by several 
programs, including Remote Networking, Inbox, and Internet 
Explorer. 
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Starting HP dialup 

To start HP dialup  
 

·  On your Jornada desktop, double-click the HP dialup icon. 

—or— 

On the Start menu, tap Programs, tap HP 
Applications, and then tap HP dialup. 

If you have already created a connection, use the Connect! 
screen to connect to your service provider or to add or modify a 
connection or location. 

 

 

Running the HP dialup Setup WizardRunning the HP dialup Setup WizardRunning the HP dialup Setup WizardRunning the HP dialup Setup Wizard    
If this is the first time you have used HP dialup, follow the 
instructions on your screen to complete the Setup Wizard and 
create a connection to your Internet service provider or corporate 
network, and set up e-mail and Web services. Each tab on the HP 
dialup window has a corresponding section in the setup wizard 

 

Service Provider 

If you use several locations for connecting to the same service, 
create a unique service provider setup with settings for each 
location. 
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Domain 
If your service provider requires you to specify a domain when 
you log on (for example, when connecting to a Windows® NT® 
network), select the Network Domain check box, and then type 
the domain name in the box. 

Internet Service Provider (ISP) 
If your ISP is listed, select it from the Service Provider list, 
and then select your country, state, and city to ensure you get the 
local dialup number for your ISP. 

When you select an ISP from the list, the country code, area code, 
and telephone number fields are automatically filled in. If you 
need to make any changes, you can edit the numbers in the box 
where they appear 

If you are connecting to a corporate network or if your ISP is not 
listed, select (Not in the list), and then enter the country code, 
area code, and telephone number for your service provider 
directly into the boxes provided. 

 

If your country or city (area code) is not on the list, you can 
edit the database in World Clock. To do this, go to the Control 
Panel, and double-tap the World Clock icon. On the Options 
tab, tap Add. The dialog boxes will guide you through adding 
your customized city information to the database. 

Modem Settings 
On the Port Settings tab, enter your connection preferences. (If 
you are not sure about these settings, check with your service 
provider or network administrator.) 

On the Call Options tab, set your preferences for canceling the 
call, and enter any extra modem commands to add to the dialing 
string. 

TCP/IP 
Tap TCP/IP to set the IP addresses for your HP Jornada and 
your service provider's DNS and WINS servers.  

If your ISP assigns IP addresses each time you connect (dynamic 
connection), choose the  Server-assigned IP address in the IP 
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Address section, and Server-assigned address under Name 
Server Configuration. 

If you selected an ISP from the list, the IP addresses will be 
filled in automatically  

If you are connecting to a corporate network, or your ISP 
was not in the list, you will need to provide the IP 
addresses. Contact your ISP or network administrator for more 
information. Tap OK to return to the setup wizard. 

You also have the option to choose software and IP header 
compression options. Ask your ISP if these options are 
recommended for your account. 

If you have created one Service Provider using HP dialup, you 
can create another by tapping the New button on the HP 
dialup Service Provider Tab. Then, follow the Setup Wizard to 
create a new ISP connection.    

 

E-mail Service 
Select your service provider's e-mail protocol from the drop-down 
list. Inbox supports both the POP3 and IMAP4 protocols. POP3 
OpenMail is not supported. 

The default options represent the settings used by many ISPs. 
If you are not sure, or you do not have guidance from your ISP, 
try the default settings. 

 

If your service provider requires you to specify a domain when 
you log on (for example, when connecting to a Windows NT 
network), select the Network Domain check box, and then type 
the domain name in the box. 

Depending on your service provider, you may have different 
addresses for your incoming mail (POP3 or IMAP4) server and 
your outgoing mail (SMTP) server. 

Under Connection Options you can choose a variety of settings 
for connecting to your e-mail account. 

By default, Inbox checks for new messages every 15 minutes 
while connected. If you want to change this setting, or if you wish 
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to change other connection options, click Change to display the 
Connection Options dialog box. 

 

You can also change the connection settings and download 
settings later from within the Inbox program. For more 
information, see Inbox Help. 

Under Download Options you can choose settings for 
downloading message headers, full messages, meeting requests 
and attachments. By default, Inbox downloads only message 
headers and the first 100 lines of text in a message, as well as 
any file attachments. If you want to use different settings, tap 
Change to display the Download Options dialog box. 

Web Service 
If you are required to use a proxy server, select the Use proxy 
server check box, and then type the server address and port 
number, then tap Next. 

 
If you connect to the Internet over a corporate network, you 
may need to use a proxy server. Your network administrator 
can tell you whether you need to use a proxy server, and if so, 
the server address and port settings. 

Your home page is displayed when you start Internet Explorer 
using this service. It can be a page on the Internet or on a 
corporate intranet. 

Your search page is displayed when you click the search button 
on the IE toolbar. 

Get Connected 
After you have completed the Setup Wizards, use HP dialup to 
quickly select your dialing location and the connection you want 
to dial, then connect to your service provider. You can also use 
HP dialup to add or modify connections, dialing locations, and e-
mail or Web services 
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Connecting the telephone line 
After you have configured your connection to your ISP or LAN, 
you are ready to connect your telephone line to your built-in 
modem (on models equipped with a built-in modem) or PC Card 
modem and then dial in. Use this procedure to connect to an 
analog telephone line. If you are using a PC Card modem, follow 
the instructions provided by your modem manufacturer for 
connecting to a telephone line type supported by your modem. 

To connect an analog telephone line to your HP 
Jornada 

1. Connect the telephone cord to the telephone jack. 

2. Connect the other end of the telephone cord to the telephone 
connector on the side of your HP Jornada or to your PC Card 
modem (following the instructions provided by your modem 
manufacturer). 

 

 

Connecting to your Service Provider  

To establish a connection 
 

1. On your Jornada desktop, double-click the HP dialup 
icon. 
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2. Select your service provider from the list. (A service 
provider may be either an Internet Service Provider 
(ISP) or a corporate network.) 

3. Select your dialing location from the list. 

4. Verify that the phone number box displays the dialing 
string exactly as it should be dialed, including any 
special dialing codes (for example, codes that are 
required to reach an outside line or to disable call 
waiting).  

 
For more information on dialing codes, see the Dialing strings 
topic in HP dialup online help. 

5. If you want to check your e-mail when you are 
connected, select the Launch Inbox check box, and then 
select your e-mail service from the list. When a dial-up 
connection is established, Inbox will start automatically 
and download any new messages. 

6. If you want to browse the Web or your corporate intranet 
using Internet Explorer, select the Launch Internet 
Explorer check box, and then select the Web service to 
use. When a dial-up connection is established, Internet 
Explorer will automatically open the Home page 
associated with this Web service. 

7. Click Dial. 

 
When you use HP dialup to connect to your ISP, the Web 
options you set in HP dialup take precedence over any options 
you may have set in Internet Explorer. 
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After you are connected to your ISP, use the Inbox program to 
send and receive e-mail or use Internet Explorer to browse the 
Web. (For more information, see the Sending, receiving, and 
processing your e-mail and Browsing the Web or your 
intranet with MS Internet Explorer 4.01 for H/PC sections 
in this chapter.) 

A dialup connection cannot be made while synchronization is 
in process, or after synchronizing while still connected to your 
desktop PC when the autodial option is selected. You must 
disconnect from the desktop PC in order to make a connection. 

 

To disconnect from your ISP or dialup LAN 
connection 

1. Double-tap the HP connection icon in the status area of the 
taskbar.  

2. In the HP dialup window, tap Disconnect.  

When the HP connection icon is displayed in the status area of 
the taskbar, your HP Jornada is connected to your service 
provider. Be sure to disconnect from your service provider and to 
unplug the phone line from your HP Jornada when it is not in 
use.  

If you have already created one connection profile using HP 
dialup, you can add another by tapping the New button on the 
Service Provider tab in the HP dialup window. The Service 
Provider Setup Wizard will start. 

 

Connecting directly to corporate e-mail and network 
resources through a network interface card (NIC) 
You must use an NIC to connect your HP Jornada directly to a 
LAN. NICs are available from several manufacturers  
as PC Card accessories. (For a list of recommended  
PC Card NICs, go to the Hewlett-Packard Web site at  
www.hp.com/jornada.) Install the PC Card NIC in the PC Card 
slot on your HP Jornada, and then attach the network cable 
according to the instructions provided by your card 
manufacturer. 
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In addition to the PC Card NIC, you will need to install the 
appropriate driver software to configure the NIC. Drivers for the 
following LAN cards are included on the HP Jornada: 

Socket LP-E LAN card 

Proxim RangeLAN2 wireless LAN card 

Cisco Aironet 4800 series wireless LAN cards 

Drivers for other cards must be obtained from the card 
manufacturer. Install software drivers as you would any other 
third party program. (For more information, see the Installing 
programs section in chapter 7.) 

Establishing an account or guest privileges on the network 
Contact your network administrator to set up an account or guest 
privileges on the network. The network administrator will give 
you the information you need to log on to the network, including 
user name, password, domain name, and IP address (if 
applicable).  

Use the Network control panel to configure the NIC with the 
information your network administrator has provided.  

To configure the NIC 

1. On the Start menu, point to Settings, and then tap Control 
Panel. 

2. Double-tap the Network icon. The Network Configuration 
dialog box appears. 

3. On the Adapters tab, select the driver or adapter, and then 
tap Properties. Check with your network administrator if 
you do not know which settings to use. 

4. On the Identification tab, enter your user name, password, 
and domain name. This information will be saved, so you will 
not have to type it every time you connect to a network 
resource. 

Connecting the network cable and logging on 
Connect your NIC to the network cable. Follow the manufacturer’s 
instructions included with your PC Card. Contact your network administrator 
for further assistance.. 



 Chapter 6 | Accessing e-mail | 99 

  

To log on to the network with your HP Jornada 
1. Insert the NIC into the PC Card slot on your HP Jornada 

and connect the network cable. The network will establish a 
connection automatically. 

2. Once you are connected a connection icon will appear in the 
status area of the taskbar. (For more information, see the 
Inserting a PC Card section in chapter 7.) 

After you have connected your HP Jornada to the network, you 
can access a file on a network file server by typing the complete 
path to the file in the Windows Explorer address bar.  

To access a file on a network 
1. On the Start menu, point to Programs, and then tap 

Windows Explorer. 

2. Be sure the address bar is visible—on the View menu, be 
sure a check mark appears next to Address Bar. 

3. In the address bar, type the full network path  
to the file you want to open, using the format  
file:///servername/share/filename. 

 
 

Windows Explorer keeps a list of the most recently used 
Internet and network resources, so you will not have to type 
the path each time. Select a network path or URL from the 
drop-down list.    
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Creating and modifying connections  
You may set up more than one connection using HP dialup; for 
example, you may create separate connections for access to your 
personal e-mail and for network access. After you have set up the 
first e-mail/Internet or network connection, use HP dialup to 
create another connection. You can also use HP dialup to modify 
existing connections; for instance, you may want to change the 
dial-up telephone number or the dialing location. 

 

 
To create an additional connection or location 

1. Double-tap the HP dialup icon on your desktop. The HP 
dialup window appears. Select the tab for the type of service 
or location that you want to add. 

2. Under the service name list box, tap New to start the setup 
wizard for that service or location type, and follow the 
prompts to enter information and create a new service. 

3. When you are finished, tap Done. Your new connection or 
location will appear in the drop-down list on the service tab 
in the HP dialup window.  

To modify an existing connection or location 

1. Double-tap the HP dialup icon on your desktop. 

2. Select the tab of the service or location that you want to 
modify. 

3. Tap Edit More to activate the setup wizard for the service to 
guide you through editing the information on the setup 
screens 

—or— 

Edit the values directly in the input boxes on the 
selected tab. 

4. Close the HP dialup window and your changes will be saved 
automatically. 
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Tapping on New in the Dialing Location tab does not start a 
setup wizard. When you click on New, only the Prefix for 
calling values change. 

 

Creating connections without the HP Jornada dialup 
application  

You can also create connections to your ISP or network by 
configuring the necessary programs manually. Before you can 
dial up, you will need to: 

• If your HP Jornada does not have a built-in modem or you do 
not want to use the built-in modem, install and configure a PC 
Card modem*. Follow the instructions provided by your 
modem manufacturer. 

• Establish an account with an Internet Service Provider (ISP) 
or your corporate network administrator (for remote access to 
your corporate network). Note the same information that is 
presented in the previous sections in this chapter. 

• Set up a Remote Networking connection. 

• Set dialing patterns and dialing locations. 

• Set up an e-mail service in Inbox and/or a Web service in 
Internet Explorer. For more information, see the Using Inbox 
and Browsing the Web or your intranet with MS 
Internet Explorer for H/PC sections later in this chapter. 

• Connect your HP Jornada to a telephone line. 

To set up a Remote Networking connection  

1. Use either the HP Jornada built-in modem (on models with 
built-in modem), or install a PC Card modem. 

2. Get the following information from your service provider (ISP 
or network administrator): dial-up access telephone number, 
user name, password, and domain name. 

3. On the Start menu, point to Programs, point to 
Communication, and then tap Remote Networking. 

                                                                 
* Modem purchased separately. Some Web sites/content may not be 
available. 
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4. Double-tap the Make New Connection icon. The Make New 
Connection dialog box appears. 

5. Enter a name for the connection, such as “Corporate Dial-
Up,” tap Dial-Up Connection, and then tap Next. 

6. Select your modem type from the list. You should not need to 
change settings in the Configure or TCP/IP Settings 
dialog boxes (if you are not sure, check with your network 
administrator). When you are finished, tap Next. 

7. Enter the access telephone number and tap Finish. 

Once you have created the dial-up connection, simply double-tap 
the connection, enter your user name, password, and domain, and 
tap Connect any time you want to connect.  

Once connected, you can use Internet Explorer to visit Web pages 
and use Inbox to send and receive e-mail. Before you can use 
Inbox, you need to set up an e-mail service. See the Using Inbox 
section later in this chapter. 

 
To set a dialing location for a Remote Networking connection, 
double-tap the icon for the connection in the Remote 
Networking folder. In the Dial-up Connection dialog box, 
tap Dial Properties, and then fill in the information as you 
would for a network or ISP connection using HP dialup. 

Using your connectionsUsing your connectionsUsing your connectionsUsing your connections    
After you have set up for the connection that best meets your 
needs, you are ready to use that connection for sending and 
receiving e-mail, or browsing the Web. 

Using Inbox 
You can use the Inbox program to send and receive e-mail over 
the Internet with your HP Jornada. You can also exchange e-mail 
over your company’s intranet, either by remote dial-up (using 
your modem) or by direct connection (with an NIC). 

Using Microsoft ActiveSync, you can synchronize information in 
Microsoft Outlook or Microsoft Exchange on your desktop 
computer with your HP Jornada. Each time you synchronize, 
Microsoft ActiveSync compares the changes you made on your 
HP Jornada and desktop PC and updates both computers, 
including changes to the messages in your Inbox. For more 
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information, see chapter 3, Connecting to your desktop or 
refer to online Help.  

HP dialup automatically sets up an Inbox service for you. 
However, you can also set up Inbox services from within the 
Inbox program. 

 

To set up an e-mail service 

1. On the Start menu, point to Programs, point to Pocket 
Outlook, and then tap Inbox. 

2. In Inbox, on the Services menu, tap Options. 

3. On the Services tab, tap Add. 

4. The Mail Service Setup wizard will guide you through 
the steps required to create a mail service. Enter the 
appropriate information on each of the three setup 
screens. (Refer to Inbox online help for more detailed 
information.) 

5. Tap Finish to complete the setup of this new service. If 
this is the first time you have created an e-mail service, 
click No in the Enable Address Issue dialog box. 

For more information about Inbox settings, see the Inbox 
settings section later in this chapter.  
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Sending, receiving, and processing your e-mail 

You can use a dial-up connection to send messages directly from 
your HP Jornada, or you can use Inbox synchronization to send 
the messages you compose on your HP Jornada from your 
desktop computer (see the Synchronizing data section in 
chapter 3). 

If you send messages directly from your HP Jornada, you will 
first need to configure a connection to your ISP or network, and 
then set up an e-mail service. You can use the HP dialup 
application to set up both the connection and the e-mail service, 
or you can create a connection using Remote Networking, and 
then set up the e-mail service in Inbox. 

After you have created the connection and e-mail service, use 
Inbox to connect to your service provider and retrieve your mail. 

To connect to your service provider from Inbox 

1. On the Services menu, tap the connection you would like to 
dial, then pull the Services menu down again and tap 
Connect. 

2. Type your user name, password, and domain name, if 
necessary. 

3. Tap Dial Properties if you need to modify a location or 
choose a different one. 

4. Tap Connect. A message will appear to show you the status 
of your connection. When your connection is established, you 
can send and receive mail. 

 
You can connect to most e-mail accounts and download 
messages to your HP Jornada even if your desktop PC 
(partner) e-mail service uses a client other than Outlook or 
Exchange (for instance, if your e-mail client is Lotus Notes). 
However, you can only synchronize e-mail with your desktop 
PC inbox if your desktop PC uses either Outlook or Exchange 
as its mail client. Access to e-mail on a POP3 OpenMail 
account is not supported on your HP Jornada. 
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Inbox settings 

When you connect to a mail server, the messages on your device 
and mail server are synchronized: new messages or message 
headers are downloaded to the HP Jornada Inbox folder, 
messages in the HP Jornada Outbox folder are sent, and 
messages that have been deleted from your Inbox are removed 
from the server.  

You can choose settings to control what will be downloaded. 

• Set Inbox to download all your messages or only new message 
headers to the Inbox folder. 

• Downloading only message headers saves storage space and 
requires less connect time. 

• By default, only messages from the last 3 days are 
downloaded. 

• By default, only message headers and the first 100 lines of text 
are downloaded, and the original messages remain on the mail 
server. If you read a message header and decide that you want 
the full copy, tap the Get Full Copy button on the Inbox 
toolbar. The full text of the message will be retrieved the next 
time you connect. 

To change the default settings, or to set options 
for retrieving file attachments and meeting 
requests 

1 Tap Options on the Services menu, select the service 
you want to modify, and then tap Properties. 

2 The E-mail Service Definition dialog displays two panels, 
Required and Optional. Choose the options you want 
for the selected service. 

Attachments 

When you send an attached file, such as a Pocket Word file, be 
sure the recipient can read the file type you are sending. Pocket 
Word files (.pwd) can only be read by other H/PC 2000 devices 
such as the HP Jornada. You can choose to save the file as .txt or 
.rtf if you are unsure, or you can choose to save the file as a Word 
file (.doc). For information about the file types associated with a 
particular program, refer to the Pocket Office section in chapter 5. 
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Inbox supports the use of MIME encoding for binary 
attachments; however, you must be sure that both the sender’s 
and the recipient’s mail servers also support MIME. If your mail 
server does not support MIME encoding, file attachments that 
you receive may be corrupted or even cause your HP Jornada to 
freeze .  

 

If you experience problems sending or receiving file 
attachments, or if you are not sure whether your mail server 
supports MIME, check with your ISP or network 
administrator. 

 
By default, Inbox will use MIME when sending attachments. To 
turn off MIME encoding, tap Options on the Services menu, 
select the service, tap Properties, tap Next, and then deselect 
the Send using MIME format check box 

For detailed descriptions of the settings related to reading and 
sending e-mail attachments, see the Inbox topic in online Help. 

If you choose to download attachments along with your messages, 
you can save them on your HP Jornada or storage device. To save 
memory, you can save attachments automatically to a storage 
card.  

To save attachments automatically to a storage 
card 

1. On the Services menu, tap Options. 

2. On the Storage tab, select the External Storage Card 
radio button. Tap OK. 

Message deletion 

Deleting messages in Inbox also deletes them on your service 
provider's e-mail server. If you delete a message while off-line, 
the message is deleted from the server the next time you connect. 

Message deletion is permanent. Deleted messages are not moved 
to the Recycle Bin, and they cannot be recovered. 

When you delete a message, any files attached to the message are 
also deleted. To save a file attachment before you delete the 
message, open the file attachment in the program that created it 
(for example, Pocket Word), and then tap Save As on the File 
menu. See online Help for more information. 
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Browsing the Web or your intranet with Microsoft 
Internet Explorer 4.01 for H/PC 
You can use MS Internet Explorer for H/PC to browse the Web or 
your corporate intranet with your HP Jornada. Internet Explorer 
allows you to view Web sites directly on your HP Jornada, 
download forms from your corporate intranet and save them for 
later use, or save your favorite online news page to read later 
when you are offline. 

After you have set up an online connection with your ISP or your 
network account, you are ready to dial up and start browsing the 
Web or your intranet. You can set Internet Explorer to 
automatically dial a connection you create whenever you start it. 

If you have not yet created an ISP or network connection, you 
must set up a service provider before you can browse the Web. 
Use either HP dialup or Remote Networking to set up your 
connection. (If you choose to use Remote Networking, see the 
Creating connections without HP dialup section in this 
chapter.)      

 

 
If you set up the Web service using HP dialup, you can set 
different Web browsing options and preferences for each 
connection. The options you set in HP dialup determine how the 
connection is made and what home and search pages are 
displayed. 

To edit or set connection information in MS 
Internet Explorer for H/PC  

1. In Internet Explorer, on the View menu, tap Internet 
Options. 

2. On the Connections tab under Auto Dial, tap the Use Auto 
Dial checkbox. 

3. Choose the Dial-Up networking connection to be used. 

4. Select the Auto Disconnect checkbox if you wish to 
disconnect automatically from the Internet after a specified 
period of idle time. 

5. If you are required to use a Proxy Server on a network, tap 
Use Proxy Server and enter the server address. 
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6. Use the other Internet Options tabs to set information 
such as Default Pages, Cache, History, Security and 
Advanced features. 

7. When you are finished, tap OK to save the changes. 

 If you set up AutoDial in Internet Explorer, you can 
connect to the Internet simply by starting the program and 
entering the address of a Web site. (Be sure your telephone 
line is connected properly first.) If you prefer to dial up 
independently of Internet Explorer, you may want to clear 
the AutoDial option. To connect using HP dialup, use the 
following procedure. 

 

 

To browse the Web or your company intranet 

1. Double-tap the HP dialup icon on your desktop. The HP 
dialup window appears. 

2. Select your network service provider and a dialing 
location from the drop-down boxes. 

3. Choose the Launch Internet Explorer check box 
option. 

4. Check the telephone number, and then tap Dial. A 
progress message appears to tell you when you are 
connected to your ISP, and then an icon appears in the 
taskbar while you remain connected. 

5. Internet Explorer starts up automatically and you are 
ready to browse the Web or your corporate intranet. 
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If you did not use HP dialup to create your connection, you will 
need to activate the connection you want in Remote 
Networking. On the Start menu, point to Programs, point to 
Communication, and then tap Remote Networking. In the 
Remote Networking folder, double-tap the icon of the 
connection you want. Tap Connect to begin dialing.  

 

Although it is based upon the outstanding content delivery 
features of the Microsoft Internet Explorer Web browser 
for desktop PCs, Microsoft Internet Explorer for Handheld 
PC has been specially created to work efficiently on the 
compact HP Jornada Handheld PC. 

Most Web animations and graphical elements display well 
on your HP Jornada, but some third party animations and  
graphics may appear as a single still frame, or may not 
appear at all. You may also have difficulty viewing Web 
pages that require ActiveX controls or plug-ins.  

For more detailed information on MS Internet Explorer 4.01 
for H/PC features, settings and customization, see the 
extensive, online, context-sensitive help files. 

 

HP ChaiVM brings the Java™ virtual Machine to the Jornada 
H/PC 

HP ChaiVM adds Java capability to Internet 
Explorer  

For users, the ability to view Java applets in Internet Explorer. 

·  HP ChaiVM allows users to experience many web effects 
written in Java while browsing the Web with Internet 
Explorer. Many dynamic Java-based web page elements are 
automatically displayed, adding to the quality of the Web 
browsing experience. HP's ChaiVM software is included in 
ROM on your Jornada 700 Series H/PC. 
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For developers, an HP embedded Java virtual machine. 

·  HP ChaiVM allows development of custom Java applications 
for use on the HP Jornada H/PC. ChaiVM is an HP 
developed virtual machine, compliant with the Java™ Virtual 
Machine Specification, and tailored specifically for devices 
like the Jornada H/PC. 

For more information about HP ChaiVM visit the Chai 
Web site at http://www.chai.hp.com. 

Using HP ChaiVM with Internet Explorer 
HP ChaiVM is enabled in Internet Explorer by default. Java 
applets are automatically displayed in the browser screen for you 
without any special action required.  

With HP ChaiVM enabled, a minimum of 16MB of system 
program memory is required. If necessary, you can adjust 
memory settings using the System control panel.  

To open the System control panel, on the Start menu, tap 
Settings, tap Control Panel, and then tap the System icon. Adjust 
the slider to change memory allocation settings. (For more 
detailed information about adjusting memory settings see 
Managing Memory in chapter 7.) 

Disabling HP ChaiVM in Internet Explorer 
Occasionally you may encounter a Web page using Java applets 
that does not load properly, preventing you from accessing the 
site or causing Internet Explorer to shut down. Disabling HP 
ChaiVM may make the site accessible, but you will not be able to 
view the Java applet. 

To Disable HP ChaiVM in Internet Explorer 

1. Tap Start, tap Programs, tap HP Applications, and then 
double-tap HP ChaiVM. 

2. Tap Options to open the ChaiVM Options dialog box and 
uncheck the Enable HP ChaiVM plug-in in Internet 
Explorer check box. 

3. Tap OK to save your changes and exit the ChaiVM Options 
dialog. 
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4. Close HP Chai VM and try Internet Explorer again. 

Clearing the HP ChaiVM cache 
Some Java applets cause temporary files to be saved in HP 
ChaiVM. These files can unnecessarily take up precious storage 
memory, causing programs to run slowly, or causing the Jornada 
to freeze. It is a good idea to periodically clear the ChaiVM cache 
to remove these unwanted files and free up the memory they 
consume. 

To clear the cache in HP Chai VM 

1. Tap Start, tap Programs, tap HP Applications, and then 
double-tap HP ChaiVM. 

2. Tap Options to open the ChaiVM Options dialog box. 

3. Tap Clear Cache to remove all ChaiVM temporary files. 

4. Tap OK to exit the ChaiVM Options dialog and then close 
HP ChaiVM. 
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7 | Optimizing your HP 7 | Optimizing your HP 7 | Optimizing your HP 7 | Optimizing your HP 
JornadaJornadaJornadaJornada    

This chapter details ways you can optimize your HP Jornada 
using Control Panel and HP Utilities, and ways you can expand 
the features and functionality of your HP Jornada by adding 
software and accessories. This chapter also offers tips on 
traveling with your HP Jornada and keeping your HP Jornada 
safe. These tips will help you become more efficient and make 
working with your HP Jornada more comfortable and fun.  

In the following pages, you will learn about: 

• Adding to your HP Jornada—Add programs, fonts, sounds, 
and desktop wallpaper. 

• Using accessories—Use CompactFlash cards, PC Cards, and 
Smart Cards to expand the storage capacity, security and 
power of your HP Jornada.  

• Managing memory—Learn how to allocate storage and 
program memory for optimal performance. 

• Managing battery power—Learn how to replace, and how to 
get the most from, your batteries. 

• Fine tuning performance—Use control panel to set various 
options, including customizing the HP hot keys and setting 
general system settings. 

• Traveling with your HP Jornada—Follow simple guidelines for 
optimizing your device for use while away from the office, 
including a check list of everything you need to take with you. 

• Protecting your HP Jornada—Safeguard your HP Jornada 
from theft and data loss. 
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Adding programs, fonts, sounds, and Adding programs, fonts, sounds, and Adding programs, fonts, sounds, and Adding programs, fonts, sounds, and 
imagesimagesimagesimages    
This section describes how to add functionality to your 
HP Jornada by installing software and how to customize the MS 
Windows for H/PC 2000 desktop and working environment.  

Installing programs 
You can add even more functionality to your HP Jornada by 
installing third party software. A wide variety of commercial 
software is available for the MS Windows for H/PC 2000 
operating system, ranging from custom business applications and 
system utilities to games and entertainment. Some programs are 
available on the Microsoft ActiveSync compact disc included with 
your HP Jornada. 

 

The only programs that will run on your HP Jornada are those 
designed specifically for MS Windows for H/PC 2000.  You 
cannot run programs designed for Windows 95/98/NT/2000 or 
other Windows Mobile platforms, like Pocket PC, on your HP 
Jornada. 

The HP Jornada Web site (www.hp.com/jornada/solutions/) 
includes many downloadable productivity-enhancing programs 
such as:  

·  Inso® Quick View Plus®—view e-mail attachments or 
documents in multiple text, with embedded tables and 
selected graphic formats. 

·  MusicMatch® Jukebox—record, organize and play digital 
music on your desktop PC. 

 
Please Note: Software is available in English language 
versions only—please refer to the HP Jornada Web site for 
conditions of usage and support that apply. 
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At the Jornada Web site, you will also find links to extensive 
H/PC resources on the Web, and information on a wide variety of 
accessories and programs for your HP Jornada. 

You can visit the HP Jornada Web site by simultaneously 
pressing the  key and the  hot key  (the Internet 

Explorer  hot key).  

(Please note: When using Internet Explorer, you may 
encounter a splash screen or an IE favorite labeled for the HP 
Jornada 720, even if this is not the model you own. These 
links will connect you to the HP Jornada Web site where you 
can quickly access the online resources for your particular 
model.) 

 

 
Many other useful programs are available from the Hewlett-
Packard Web site at www.hp.com/jornada. Hewlett-Packard does 
not support the use of programs that have not been certified by 
Microsoft. 

Typically, you install software to your H/PC by first loading the 
installation files onto your desktop PC, as described in the 
following procedure. 

If a program is designed for direct installation, you may be 
able to download or install the program from the Web to your 
HP Jornada. The software developer's Web site should provide 
instructions for installing the program. 

 

To install software 

1. Look for programs that are compatible with the HP 
Jornada's StrongARM SA111X processor. 

Be sure to choose only programs that have been designed for 
your HP Jornada's StrongARM SA111X processor.  

 
2. Download the program to your desktop computer 

—or— 

insert the CD or floppy disk that contains the program.  

3. Connect your device and desktop computer. 
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4. Double-click the *.exe file. 

·  If the program includes an installer program (typically 
named Setup.exe or Install.exe), double-click the installer 
program on the desktop PC and installation wizard will 
begin. Follow the directions on the screen. Once the software 
has been installed on your desktop computer, the installer 
will automatically transfer the software to your device.  

·  If the program does not have an associated installer or setup 
program, drag the program file (typically an *.exe file type) 
to the My Handheld PC icon in the Mobile Device window. 

5. If prompted by the installer, perform a soft reset of your 
H/PC. For more information, see the Resetting section 
in chapter 8. 

 

Install software by dragging the program file to the Mobile 
Device window only if no installer program is available. 
Software installed in this way may not appear on the Remove 
Programs list, and you may have to manually delete the 
program if you wish to remove it from your HP Jornada 

After you have installed a program on your HP Jornada, you can 
use the ActiveSync Add/Remove Programs tool to remove the 
program or to reinstall the program after it has been removed. If 
you do not have enough storage memory on your HP Jornada, you 
may want to use Add/Remove Programs to temporarily remove 
programs you no longer use or programs that you use 
infrequently. 

To add or remove programs with Add/Remove 
Programs 

1. Connect your HP Jornada to your desktop PC, and then 
open the ActiveSync window. 

2. On the Tools menu in the ActiveSync window, click 
Add/Remove Programs. 

3. In the list of programs, activate the check box next to the 
program you wish to install. –or– Clear the check box of 
the program you want to delete. 

4. If the program you want to remove is not shown on the 
list, your must remove it manually. 



 Chapter 7 | Optimizing your HP Jornada | 117 

  

Removing programs 
You can use either Add/Remove Programs (on your desktop PC) 
or the Remove Programs control panel (on your HP Jornada) to 
remove programs.  

To remove a program from your HP Jornada with 
the Remove Programs control panel 

1. On the Start menu, point to Settings, and then tap 
Control Panel. 

2. Double-tap the Remove Programs icon. 

3. In the Programs list, select the program you want to 
remove. 

4. Tap Remove. 

Programs stored in ROM cannot be removed. (For a list of 
these programs see the HP Jornada programs section in 
chapter 1.) 

 

Adding fonts 
Your HP Jornada comes with a selection of built-in fonts. You can 
add Windows fonts (.fon files) or TrueType fonts (.ttf files) to your 
HP Jornada for use in Pocket Word documents and Pocket Excel 
spreadsheets. Because fonts take up a significant amount of 
storage memory, install only the fonts you need, and delete those 
you do not need. (The built-in fonts cannot be deleted.) 

To add fonts 

1. Connect your HP Jornada to a desktop PC, and then 
start Microsoft ActiveSync. 

2. In Windows Explorer on the desktop PC, select the font 
files you want to copy. 

3. Drag the font files to the Windows\fonts folder on your 
HP Jornada. If you are copying a Windows font, you will 
be prompted to select the point sizes and styles you want 
to copy.  
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Adding sounds 
Your HP Jornada can play Wave sounds (.wav files). You can 
copy a sound file from your desktop PC to your HP Jornada 
without converting the file. If you want to use a sound as part of 
a sound scheme or to signal an alarm or a reminder, copy the 
sound file to the Windows folder on your HP Jornada. For more 
information, see the Setting Alarms topic in online Help. 

Adding desktop wallpaper 
Your HP Jornada can display 65,536-color bitmap images (.bmp 
files) or MS Windows for H/PC 2000 bitmaps (.2bp files). You can 
copy bitmap images from your desktop PC to your HP Jornada 
without converting the files, and you can use these images as 
desktop wallpaper on your MS Windows for H/PC 2000 desktop.  

To add desktop wallpaper 

1. Connect your HP Jornada to a desktop PC and start 
Microsoft ActiveSync. 

2. Drag the bitmap image you want to copy from its 
location on your desktop PC to the My Handheld PC icon 
in the Mobile Device window. 

3. On your HP Jornada Start menu, point to Settings, and 
then tap Control Panel. 

4. Double-tap the Display icon. 

5. On the Background tab, tap Browse, and then select 
the bitmap file to display as your background.  

AccessoriesAccessoriesAccessoriesAccessories    
The following optional accessories also are available  
from Hewlett-Packard. (HP item numbers are listed in 
parentheses.) Check the Hewlett-Packard Web site at 
www.hp.com/jornada for updates to this list. 

• Serial sync cable (HP F1258A)— Connect your HP Jornada to 
a serial communications port on a desktop PC running 
Windows NT, Windows 95/98, or Windows 2000. 

• Docking Cradle (HP F1822A)—Instantly connect to your PC 
partner via serial port (running Windows NT, Windows 95/98, 
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or Windows 2000) or USB port (Windows 98 and Windows 
2000 only). Includes serial sync cable and USB cable. 

• ac Adapter (HP F1279B)— Connect to ac power anywhere in 
the world with this World Wide Voltage adapter 

• Standard Battery (HP F1281A)—Rechargeable Li-ion battery 
pack provides up to 9 hours of battery life (depending on 
usage) 

• Extended Battery (HP F1840A)— Rechargeable, extra 
capacity Li-ion battery pack provides up to 24 hours of battery 
life (depending on usage) 

• External Charger (HP F1841A)— Allows simultaneous 
charging of your HP Jornada and an additional battery 
(additional battery available separately). 

• Leather case (HP F1227A)—Protects your HP Jornada in style 

• Parallel printer cable (HP F1274A)—Allows connection to 
PCL3 printers. (For a list of recommended printers, see the HP 
Web site www.hp.com.) 

• HP VGA out card (HP F1252A)—Enables you to connect your 
HP Jornada to an external monitor or projector for 
presentation 

• Serial adapter (HP F1295A)—Provides a standard 9-pin 
mechanical interface 

• Stylus Pen (HP F1842A)—Replacement for lost or damaged 
stylus 

UsinUsinUsinUsing PC Cards, CompactFlash Cards, and Smart Cardsg PC Cards, CompactFlash Cards, and Smart Cardsg PC Cards, CompactFlash Cards, and Smart Cardsg PC Cards, CompactFlash Cards, and Smart Cards    
PC Cards, CompactFlash Cards and Smart Cards provide a wide 
range of additional functionality, such as additional memory, 
removable storage, connection to an external monitor, connection 
to a network, or data security and user authentication. For a list 
of recommended compatible cards, go to the HP Jornada Web site 
at www.hp.com/jornada. 

Before you can use a particular card, you may need to install the 
software driver for that card. Drivers for the MS Windows for 
H/PC 2000 operating system should be included with the card or 
available from the card’s manufacturer. Install software drivers 
as you would any other software. For more information, see the 
Installing programs section in this chapter. 
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Non-memory CompactFlash Cards that require a cable 
connection (i.e. network interface cards, pagers, or modem 
cards), must be inserted in the PC Card slot rather than the 
CompactFlash Card slot. To do this, you will need a PC Card 
adapter. For a list of recommended PC Card adapters, go to 
the HP Jornada Web site at www.hp.com/jornada. 

Installing a PC Card, CompactFlash Card or Smart Card 
The HP Jornada accommodates PC Cards, CompactFlash Cards 
and Smart Cards separately or in combination. 

 
Many PC Cards use considerable power, and can quickly drain 
your battery. Connect to ac power while using PC Cards. 

PC Card and CompactFlash memory modules appear as folders 
in the My Handheld PC folder. If you have two cards installed, 
the folders are displayed in the order they were inserted. In some 
cases, additional folders may appear. You can eliminate unused 
folders by performing a soft reset. (For more information, see the 
Resetting section in chapter 8.) 

 

PC Card insertion on the HP Jornada, with extended 
release tab indicated by curved arrow 
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Using PC Cards, CompactFlash Cards, and Smart 
Cards 
The HP Jornada is equipped with a PC card slot, a CompactFlash 
Card compartment, and a Smart Card reader slot that make it 
incredibly expandable and versatile. You can install either a PC 
Card, CompactFlash Card, or Smart Card, or install all of them 
at the same time. 

PC Card 
The PC Card fits in the slot on the left side of the HP Jornada. 

To install a PC Card 

·  Carefully slide the card into the PC Card slot face up. 

To remove a PC Card 

1. Press the PC Card release tab. Do not obstruct the slot 
opening. The PC Card will be pushed out of the slot 
slightly. 

2. Grasp the PC Card and pull it completely out of the slot. 
When using thicker PC Cards (for instance PCMICIA I/O 
Cards), you may initially feel some slight resistance 
when pulling out the card. 

3. Fold the PC Card release tab back into the side of the 
device. 

Smart Card 
The Smart Card fits in the slot on the left side of the HP Jornada 
just above the PC Card slot. 

For the information about Smart Card applications for your 
HP Jornada, go to the HP Jornada Web site at: 
www.hp.com/jornada 

 

To install a Smart Card 

• Carefully slide the card face down into the Smart Card 
reader slot. 
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To remove a Smart Card 

• Grasp the Smart Card firmly and pull it gently out of the 
Smart Card reader slot. 

CompactFlash Card 
The CompactFlash Card slot door is located on the bottom of the 
unit, near the stylus slot. Slide the latch in the direction of the 
arrow printed on its face to open the door. 

To install a CompactFlash Card 

1. Slide the CompactFlash Card slot door latch in the direction 
of the arrow with your finger. The door will spring open. 

 

2. Slide the CompactFlash Card into the slot, pressing the card 
gently but firmly until it snaps into place in the slot. 

 
The CompactFlash card can only be inserted in the slot one 
way, connector edge inserted first, with the finger pull (raised 
edge) of the card exposed on the closing side of the door. 

 
3. Close the CompactFlash Card slot door by pressing it down 

until it clicks into place. 
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To remove a CompactFlash Card 

1. Slide the CompactFlash door latch in the direction of the 
arrow with your finger. The door will spring open. 

2. Grasp top edge of the card, holding the finger pull (raised 
edge) firmly between your fingers, and gently pull the card 
from the slot. 

3. Close the CompactFlash Card slot door by pressing it down 
until it clicks into place. 

Do not use excessive force installing or removing a PC Card, 
Smart Card or CompactFlash Card.  

Managing memoryManaging memoryManaging memoryManaging memory    
The memory on your HP Jornada is allocated between storage 
memory and program memory. You can specify how much of the 
total memory is used for storage and how much is used for 
running programs. If you notice that your HP Jornada is running 
slowly or that your programs do not run consistently, try 
increasing program memory. If you need more memory for files 
and documents, increase storage memory. 

To adjust memory allocation 

1. Exit any applications that are running. 

2. On the Start menu, point to Settings, and then tap Control 
Panel. 

3. Double-tap the System icon. 

4. On the Memory tab, move the slider to the left to increase 
program memory, or move the slider to the right to increase 
storage memory. 

You may be able to make more memory available by refreshing 
your system memory.  

To refresh your system memory 

1. Close all open documents and exit any applications that are 
running. 
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2. Use the stylus to press the reset button on the left side of the 
keyboard, performing a soft reset. (For more information, see 
the Resetting section in chapter 8.) 

The Recycle Bin on your HP Jornada desktop works in the same 
way as the Recycle Bin on your desktop PC. When you delete a 
file on your HP Jornada, the file is moved to the Recycle Bin. It is 
not actually removed from memory until you empty the Recycle 
Bin.  

You can set options that limit the amount of memory reserved for 
the Recycle Bin or to bypass the Recycle Bin and delete files 
immediately.  

To set Recycle Bin options 

1. Press the  key as you tap the Recycle Bin icon. 

2. On the pop-up menu, tap Properties.  

Tips for conserving memory 
• Synchronize only one or two weeks of Calendar data and only 

selected Contacts or Tasks. (For more information, see the 
Synchronizing selected data section in chapter 3.) 

• Set options in Inbox to download only message headers and 
not to download attachments. (For more information, see the 
Using Inbox section in chapter 6.)  

• Use Application Manager to remove programs you do not need 
(see the Installing programs section in this chapter). 

• Remove fonts, sounds, and wallpaper you do not need.  

• Delete files and voice memos you do not need, or transfer them 
to your desktop PC for storage and delete them from your 
HP Jornada. 

• Clear the cache in HP Chai VM, removing unneeded 
temporary files to free up storage memory. (See Clearing the 
HP ChaiVM cache in chapter 6 for detailed instructions.)  

 
You can increase the storage memory by adding a memory 
module on a CompactFlash or PC card. For more information, 
see the Accessories section in this chapter. 
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Managing battery powerManaging battery powerManaging battery powerManaging battery power    
Because the data you save on your HP Jornada is stored in RAM, 
it is extremely important that you maintain a continuous power 
supply to your HP Jornada at all times. If your HP Jornada loses 
power, all information you have entered will be lost. The MS 
Windows for H/PC 2000 operating system and programs are 
stored in ROM, and cannot be erased; however, any programs you 
have added and custom settings in existing programs will be lost.  

Data stored on a PC Card or CompactFlash Card will be saved, 
even if your H/PC loses power. To protect your data, back up 
regularly to a PC Card or CompactFlash Card with HP 
backup.. 

 

 
HP Jornada uses two types of batteries. The main battery 
supplies power whenever your HP Jornada is not connected to ac 
power. The backup battery protects your data when the main 
battery is not installed (for instance, while you exchange the 
main battery). 

Main battery 
The main battery is the HP Jornada Standard Battery, a 
rechargeable lithium-ion battery pack. Use only the HP Jornada 
Standard Battery (HP F1281A) or the HP Jornada Extended 
Battery (HP F1840A) with your HP Jornada. These batteries are 
designed only for use with the HP Jornada and should not be 
used to power other devices.  

Under normal circumstances, the main battery will provide up to 
9 hours of continuous use without recharging. Actual battery life 
will vary depending on screen brightness, what applications you 
use, and operating conditions. When the main battery runs very 
low, your HP Jornada will shut down, and you will be unable to 
restart it until you replace the main battery, recharge the 
battery, or connect to ac power. 

When you replace the main battery, your new battery must be 
charged before your HP Jornada will turn on. For information on 
charging the main battery, refer to the Connecting the ac 
adapter section in chapter 2.  
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Ensure that the backup battery is in good condition before you 
remove the main battery. If the backup battery is low or you 
are not sure, connect to ac power before you remove the main 
battery. 

To replace the main battery 

1. Turn off your HP Jornada and disconnect the serial sync 
cable if it is attached, or remove it from the docking cradle 
(optional on the HP Jornada 710). 

2. Slide the battery release tab on the bottom of the HP 
Jornada and hold it in the open position while pulling the 
battery pack away from the device. 

3. Insert the replacement battery pack and push firmly until it 
clicks into place. 

Backup battery 
The coin-sized, lithium ion backup battery does not provide 
enough power to operate your HP Jornada. It is intended only to 
protect your data until the main battery is recharged (up to a 
week if the coin-cell battery is in good condition). When a low 
battery warning message is displayed, immediately charge the 
main battery to avoid data loss. 

 
Ensure that the main battery is charged before you remove the 
backup battery. If the main battery is low or you are not sure, 
connect to ac power before you remove the backup battery. 

To replace the backup battery  

1. Turn the Jornada upside-down and open the 
CompactFlash door. 

2. Pivot the backup battery cover out of the way to 
completely expose the backup battery. 

The backup battery is under some spring tension. As you 
attempt to remove it, cover the battery with your fingers 
to prevent it from flying out of the compartment. 

3 With the stylus or some other small, blunt tipped 
instrument, gently pry the backup battery out of the 
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compartment. (Be careful not to damage the stylus or the 
battery compartment.) 

4 Make sure that the backup battery cover is open and 
insert the replacement battery printed side up into the 
battery compartment. 

5 Close the backup battery cover to secure the battery, 
then close the CompactFlash door. 

The backup battery cover is designed to be easily opened and 
closed with the tip of the stylus. Just insert the tip in the small 
hole to quickly pivot the cover open or closed. 

 

 

Be sure to close the backup battery cover before closing 
the CompactFlash door in order to avoid damaging these 
components. 

 

 

 

Installing the backup battery 

 CompactFlash door  shown open 

 Coin-cell 3V CR2032 backup battery 

 Backup battery compartment 

 Backup battery cover in open position 
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Do not mutilate, puncture, or dispose of batteries in fire. The 
batteries can burst or explode, releasing hazardous chemicals. 
Replace batteries with only the types recommended in this 
User’s Guide. Discard used batteries according to the 
manufacturer’s instructions. 

Using the Power control panel 
Use the Power control panel to check the status of your main and 
backup batteries and to set options that can increase battery life. 
These include setting options for auto-suspend, power on, and 
setting controls to automatically dim or turn off the display. 

To open the Power control panel 

·  On the Start menu, point to Settings, tap Control Panel, 
and then double-tap the Power icon. 
–or–  
Double-tap the power status icon in the status area of the 
taskbar. 

 

The power status icon appears in the taskbar only under 
certain conditions, such as when battery power is low or when 
your HP Jornada is connected to external power and charging 
the main battery. 

Checking battery status 
The power area in the Power control panel indicates whether 
your HP Jornada is running on battery power or connected to ac 
power, and displays the status of both the main and backup 
batteries. In addition, the battery icon in the status area of the 
taskbar indicates whether the HP Jornada is operating on ac or 
battery power and displays the status of the main battery:  

Icon Indicates 

      
Running on ac power 

 
Main battery charging 
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Running on battery power, main battery low 

   
Backup battery low 

    
Backup battery very low 

 

It is important that you respond immediately when a low 
battery power warning is displayed. When the main battery is 
low, simply connect the HP Jornada to ac power to recharge. 
(You can use your HP Jornada while the battery is charging.) 
When the backup battery is low, replace it as soon as possible. 
It is recommended that you back up your data and run the HP 
Jornada only on ac power until you have replaced the backup 
battery. 

 

Conserving battery power  
Under normal circumstances, the HP Jornada Standard Battery 
should provide up to 9 hours of continuous use; however, certain 
tasks require more battery power and deplete the main battery 
faster. Follow these tips to maximize battery life.  

Setting auto-suspend 
To conserve battery power, MS Windows for H/PC 2000 will 
automatically turn off or suspend your HP Jornada after a period 
of continuous idle time. 

To set or shorten auto-suspend time 

1. On the Start menu, point to Settings, tap Control Panel, 
and then double-tap the Power icon.  
–or– 
Tap the HP settings hard icon, and then tap the battery icon. 

2. On the Power Saving tab, under While on battery power 
and no user input, next to Auto-suspend after, adjust the 
number of minutes before auto-suspend occurs. 
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 The default idle time is 3 minutes. To change the idle 
time, select a number from the list. Increasing the idle 
time may decrease your battery life. 

 
The HP Jornada uses Intelligent Power Management to 
automatically power off after an extended period of inactivity, 
and to detect and warn you about active connections when 
powering off 

Setting power on option 
You can also set your HP Jornada to automatically turn on when 
you touch the screen. 

To set the power on option 

1. On the Start menu, point to Settings, tap Control Panel, 
and then double-tap the Power icon. 
–or– 
Tap the HP settings hard icon, and then tap the battery icon 
on the HP settings window. 

2. On the Power On tab, select Touch screen to Power On. 

Setting the Jornada display to automatically dim or turn off 
Dimming or shutting off the display on your HP Jornada will 
help conserve battery power. Use the Power Saving tab of the 
Power Properties dialog to set options for automatically dimming 
while on battery power, or shutting off the display when system 
processes that are running (e.g. playing music or an Internet 
Connection) will not allow your Jornada to auto-suspend.  

 
The option to turn off the display when the Jornada cannot 
auto-suspend is selected by default. 

 

To set automatic dimming 

1. On the Start menu, point to Settings, tap Control Panel, 
and then double-tap the Power icon. The Power Properties 
dialog will appear. 
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2. On the Power Saving tab, under While on battery power 
and no user input, select the Dim display after check 
box. 

3. Select a time interval from the list box at the right to set how 
long your HP Jornada must be idle before the display is 
dimmed. 

4. Click OK to save your settings and exit. 

To set or disable the display off option 

1. In the Power Properties dialog, on the Power Saving tab, 
select the Turn off the display when system cannot 
auto-suspend due to active system processes check box. 
(To disable the display off option, uncheck the box.) 

2. Click OK to save your settings and exit. 

Other tips for conserving battery power 
• Reduce the brightness of the display—Compensate for 

low light by increasing the contrast. (See the Using the HP 
settings application section in this chapter.) Use the Power 
control panel to set the auto-dimming feature. 

• Turn off the display manually—To save battery power 

when connected to your desktop PC, use the alt +  hot 
key combination to manually turn off the display without 
waiting for the automatic display-off feature. 

• Suspend frequently—Use the Power control panel to 
shorten the length of continuous idle time before your 
HP Jornada auto-suspends. Press the On/Off key or tap 
Suspend on the Start menu to turn off your HP Jornada 
when it is not in use, even for a short time. 

• Always use ac power when connecting your 
HP Jornada to your desktop PC—Note that your 
HP Jornada will not auto-suspend while it is connected. 

• Turn off sounds—Use the HP settings application to mute 
the HP Jornada speaker, or use the Sound & Volume control 
panel to turn on only the most necessary system sounds.  

• Avoid using PC Cards while on battery power—Some PC 
Cards (especially PC Card modems) use considerable power 
and will quickly drain your battery. 
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Use the ac adapter to plug your HP Jornada into external 
power whenever possible, especially when connecting to a 
desktop PC, when using a PC Card modem, network interface 
card (NIC), or other peripheral. Do not let the alarm 
notification LED flash for a long time. 

FineFineFineFine----tuning performancetuning performancetuning performancetuning performance    
This section offers information that will help you  customize your 
HP Jornada to match your working style.  

Setting general options 
As on your desktop PC, use Control Panel to change most of your 
HP Jornada options. 

To open Control Panel 

·  On the Start menu, point to Settings, and then tap Control 
Panel.  

Double-tap any of the icons in Control Panel to explore the 
options for that feature. Specific Control Panel options are 
described below. For more information about a particular control 
panel, see the Settings topic in online Help.  

• Communications—Use the Communications control panel to 
set options for establishing a connection between your HP 
Jornada and desktop PC. 

• Dialing—Use the Dialing control panel to manually create 
dialing locations and set dialing options for connecting to a 
service provider or remote computer.  

• Display—The Display control panel allows you to  
set the background image and the appearance of your MS 
Windows for H/PC 2000 desktop. 

• HP hot keys—Use the HP hot keys control panel to customize 
your HP Jornada hot keys and hard icons. For more 
information, see the Customizing the HP hot keys and 
hard icons section in this chapter. 

• HP security—Set primary and reminder password protection 
to control access to your HP Jornada, and use the security log 
to record access attempts. 
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• Internet Options—Contains controls for browser settings 
including connection and auto-dialing, Internet security levels, 
default home and search pages, cache settings and history 
settings. 

• Keyboard—The Keyboard control panel allows you to set 
options for how quickly characters repeat when you hold down 
a key on your HP Jornada keyboard. 

• Network—Use the Network control panel to configure your 
network interface cards and drivers, and to type your user 
name and password for connecting to a network. 

• Owner—The Owner control panel allows you to store personal 
information, such as your name and address, and to choose 
whether to display this information each time you turn on 
your HP Jornada.  

• Power—The Power control panel is the place to check the 
condition of your batteries and set options that can conserve 
battery power. For more information, see the Managing 
battery power section in this chapter. 

• Regional Settings—The Regional Settings control panel 
allows you to set the format for time, date, numbers, and 
currency based on your geographic region. Choose from preset 
schemes or set individual options. 

• Remove Programs—The Remove Programs control panel is 
the best way to delete or uninstall programs you no longer use.  

• Socket LP-E/EIO—Control panel allows you to check 
network IP information and control status icons, program 
launching and ethernet driver delay settings for use with 
Socket LP-E/EIO LAN PC cards. 

• Stylus—The Stylus control panel enables you recalibrate the 
stylus or to set options for double-tap speed and area. 

• System—The System control panel displays information 
about the hardware and software configuration and enables 
you to adjust the allotment of program memory and storage 
memory. 

• Volume & Sounds—The Volume & Sounds control panel 
allows you to set the speaker volume and turn on and off the 
sounds associated with different system events. You can save 
your options as a sound scheme, just as you do with Windows 
95/98.  
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• World Clock—The World Clock control panel allows you to 
set the system time, set alarms and reminders, and select your 
Home and Visiting cities. World Clock also displays almanac 
information, such as the nearest airport, sunrise and sunset 
times, and travel distance between selected cities.  

 
To open the World Clock control panel, double-tap the clock in 
the status area of the taskbar. 

Customizing the HP hot keys and hard icons 
The HP hot keys (on the top row of the keyboard) and the 
HP hard icons (along the right edge of the screen) give you one-
touch access to your favorite programs. Simply press a hot key or 
tap a hard icon to open the corresponding program.  

Use the HP hot key application to assign any program or file on 
your HP Jornada to one of the hot keys or hard icons.  

Icon Indicates 

 
Open HP settings 

 
Open HP backup 

 
Open HP dialup 

 
Open Windows Media Player 

HP hard icon default program assignments 

 To start the HP hot keys application 

·  On the Start menu, point to Programs, point to HP 
Utilities, and then tap HP hot keys.  
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When you start the HP hot keys application, the current 
hot key assignments are displayed in a list on the Hot 
keys tab. The default key assignments correspond to the 
program icons printed on the HP hot keys. 

You can also customize the hot keys to fit your personal 
preferences by assigning different programs or files to each hot 
key or hard icon 

To assign a program or file to a hot key or hard 
icon  

1. Start the HP hot keys application. 

2. On the Hot keys tab or the Hard icons tab, select the key 
or icon you want to change. 

3. Under Assign to, select a program from the drop-down list. 
–or– 
Tap Browse to select a program or file that is not displayed. 
(Certain files or programs will not run when invoked by a hot 
key or hard icon.) 

4. Tap OK to save you new settings and close the HP hot keys 
application. 

To see which programs are currently assigned to the HP hard 
icons, tap and hold any hard icon. A pop-up window shows the 
current hard icon assignments. 

 

To restore the default hot keys or hard icons, which correspond to 
the icons printed on the keys or the screen, tap Restore defaults 
on the Hot keys tab or the Hard icons tab. 
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Using the HP settings application 

The HP settings application allows you to change or adjust 
display and sound settings and allows you to check the 
status of constantly changing information about your 
HP Jornada at a glance, such as available memory and 
battery power. 

To open HP settings 

·  On the Start menu, point to Programs, point to HP 
Utilities, and then tap Settings.  
–or– 

Press the HP settings  hard icon. 

Setting brightness and contrast. 
The Display Profiles tab includes slider controls for brightness 
and contrast, and buttons to select saved settings profiles. Move 
the sliders to adjust the display settings to a comfortable level. 

 

Setting volume levels. 
The Volume Profiles tab includes slider controls for audio 
volume and modem volume, and buttons to select saved 
volume settings profiles. Move the sliders to adjust the 
volume settings to a comfortable level. 

 
 

The modem slider is available only on HP Jornada models with 
built-in modem; the modem volume slider is not functional on  
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non-modem versions of the HP Jornada. 

  

 

On the Volume Profiles tab, tap  to open the Volume & 

Sounds Properties dialog box. 
 

Setting bass and treble levels 
On the Volume Profiles tab, the current bass and treble levels are 
shown as percentages. To adjust the bass and treble settings, 
press the Advanced button. In the Bass/Treble Settings dialog, 
use the slider controls to adjust the bass and treble settings to 
the desired level. 

 

Customizing HP settings profiles 

Your HP Jornada has four preset HP settings profiles on 
both the Display Profiles and Volume Profiles tabs  
You can launch any profile on either tab by selecting it. 
You can also adjust any of the settings in any profile to suit 
your preference.  
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To change HP settings profiles 

1. On the Start menu, point to Programs, point to HP 
Utilities, and then tap Settings. 
–or– 

Press the HP settings  hard icon. 

2. On the either the Display Profiles or the Volume Profiles 
tab, select the profile you want to change. 

3. Adjust the brightness and contrast sliders to your 
preference, 

—or—  
adjust the audio volume and modem volume (only on 
HP Jornada models with built-in modem) sliders to your 
preference. 

4. Tap OK to exit and save your settings. 

Changing HP settings profiles 

To quickly change the current display or volume 
profile: 

·  Press the  +  hot key combination to choose a 
different display profile. 

—or— 

·  Press the  +  hot key combination to choose a different 
volume profile. 

 

Alt hot keys are indicated by blue icons stenciled above the 
three left-hand hot keys on the HP Jornada keyboard, 
immediately below the display panel. To activate them, hold 
down the  key and press any of the hot keys listed in the 
table below.  

 
Icon Indicates 

 Open HP Jornada Home Page 

 Open Display profile selection menu 

 Open Volume profile selection menu 

HP Jornada Alt hot key icons 
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Displaying power and memory information 

The HP Settings window also displays the power status of 
your main battery. The Memory tab shows the available 
Program memory, Storage memory, and Storage Card 
memory. 

On the Memory tab, tap  to start the System Properties 

dialog,  
—or—  

at any time in the HP settings window, tap  to display the 

Power Properties dialog. 

 

SecuritySecuritySecuritySecurity    
This section provides some tips to safeguard your 
HP Jornada—and the data it holds—from theft or loss. 

Adding owner information 
If you lose your HP Jornada, owner properties can provide 
an easy way for someone to identify you as the rightful 
owner and return your HP Jornada. You may have entered 
your name and address as part of the MS Windows for 
H/PC 2000 Welcome Wizard. If you did not, or if you want 
to update your information (for example, to include the 
address of the hotel or office you are visiting), use the 
Owner control panel.  

To add or change Owner properties 

1. On the Start menu, point to Settings, and tap Control 
Panel. 

2. Double-tap the Owner icon. 

3. On the Identification tab, type your name, address, 
and/or phone number. 

4. On the Notes tab, type any other information  
you want displayed (for example a temporary  
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address or to offer a reward for the safe return of your 
HP Jornada).  

 
To display your owner properties information each time you 
turn on your HP Jornada, on the Identification tab under At 
Power On, select the Display Owner Identification check 
box. 

HP security control panelHP security control panelHP security control panelHP security control panel    
Use the HP security application to prevent unauthorized 
access to your HP Jornada and to protected the 
confidentiality and integrity of your important data. 

 Using HP security you can: 

·  Set a password to control access to your HP Jornada 
and protect your data. 

·  Set a reminder password to gain access to your HP 
Jornada if you forget your primary password. 

·  Use the security log to record any attempts to access 
data on your HP Jornada. 

 
Caution:  If you forget both your primary and reminder 
passwords, you may be unable to access your HP Jornada until 
you perform a factory default reset, erasing all information you 
have saved. For more information, see the Resetting section 
in chapter 8. 

To start HP security  

·  On the Start menu, tap Settings, tap Control Panel, then 
double-tap the HP security icon. 

—or— 

On the Start Menu, tap Programs, tap HP Applications, 
then tap HP security. 



 Chapter 7 | Optimizing your HP Jornada | 141 

  

Setting a Primary Password 
Use the Primary tab to set your primary password, and 
enable primary password protection. With primary 
password protection enabled, you must enter your 
password each time you start your HP Jornada or open the 
HP security application.  

To set a primary password and enable primary 
password protection:  

1. On the Primary tab, tap the Primary Password text input 
box and type the password of your choice. (A password may 
contain up to 40 case-sensitive, alpha-numeric characters.) 

2. Tap the Confirm text input box and type the password you 
have chosen again. 

3. Select the Enable Primary Password Protection check 
box to activate password protection. 

4. Click OK to exit and save your settings. 

Passwords are alpha-numeric and case-sensitive. Be sure to 
deactivate the numeric keyboard ( +  ) and /or 

capslock ( +  ) before setting or entering your 
password. Keystrokes may not be recognized as you intended if 
either of these   icons appear in the status area of the 
task bar. Use the key combinations shown above to deactivate 
these keyboard features before setting or entering your 
passwords. (See Using the HP Jornada keyboard in Chapter 2 
for information about using the numlock and capslock keys.) 

 

To disable primary password protection:  

·  On the Primary tab, tap the Enable Primary Password 
Protection check box to remove the check mark and     disable 
password protection. 

 
NOTE: Even with primary password protection disabled, you 
will be prompted for your password each time you open HP 
security unless you delete your password as described below. 
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To remove your primary password:  

1. On the Primary tab, highlight the text (double tap) in the 
Password text input box, then press the delete key. 

2. Double-tap the Confirm text input box and press the delete 
key again. 

3. This will remove your password and you will no longer be 
prompted for your password when you open the HP security 
control panel. 

4. Click OK to exit and save your settings. 

Password Activation Delay 
If you frequently turn your HP Jornada off for short 
periods of time to conserve power, set a password 
activation delay. When you turn your HP Jornada on again 
within the delay period, you will not be prompted for your 
password. 

 
With a password delay set, you can use the  + "on/off" 
keys to shut down the system and enable password protection 
immediately, bypassing the delay. 

To set a password delay:  

1. Set your primary password. 

2. On the Primary tab under Activation, select the 
Delay password activation after suspend for check 
box. 

3. In the minutes input box, type the number of minutes 
you want password prompting to be delayed. 

4. Click OK to exit and save your settings. 

Setting a Reminder Password 
Use the Reminder tab to set a reminder password, and 
enable reminder password protection. With reminder 
password protection enabled, you will be prompted to enter 
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your reminder password after a set number of failed 
primary password logon attempts.  

To set and activate a reminder password:  

1. On the Reminder tab, under Reminder Password, tap the 
Question text input box and type a question of your choice. 
(A password may contain up to 40 case-sensitive, alpha-
numeric characters.) 

2. Tap the Answer text input box and type the answer to the 
question in step one 

3. Select the Enable Reminder Password check box. 

4. In the Prompt for Reminder Password after box, enter 
the permitted number of primary password entry errors 
before you are prompted with the question for your reminder 
password. 

5. Click OK to exit and save your settings. 

Using the Security Log 
Use the Log tab to record all attempts to access your HP 
Jornada, and any attempts to modify the password 
settings. 

You can view the log on your HP Jornada or export it as a file 
to save, view or edit on your desktop PC.  

To enable security logging:  

1. On the Log tab, select the Enable logging check box. 

2. Entries appear in the table on the Log tab. 

3. To clear all entries, tap Clear Log. 

4. To export the log to a file, tap Export Log. 

5. Click OK to exit and save your settings. 
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Traveling with your HP JornadaTraveling with your HP JornadaTraveling with your HP JornadaTraveling with your HP Jornada    
The compact size and portability of the HP Jornada make 
it the perfect traveling companion. With the 
synchronization and connectivity solutions of the HP 
Jornada, the power of your desktop computer is always at 
your fingertips, whether you are working from across town 
or from across the country. 

Follow the tips in the sections below to make sure your trip 
goes smoothly. 

What to take with you 
Be sure to pack everything you need to use your HP Jornada: 

• ac adapter and power cable—If you are traveling to a 
foreign country, be sure you also obtain an adapter for the 
plug on your power cable. Or, you may be able to buy a power 
cable for the country you are visiting in a local store or HP 
distributor. 

• Modem card and cable—If you do not have an HP Jornada 
with internal modem, you’ll need your PC Card modem* to 
connect to the Internet or dial in to your office.  

• Access numbers—Check with your service provider or 
network administrator to find out if they provide local dial-up 
access. A local number can save plenty in long-distance 
charges. 

• Serial sync cable—If you will connect to a desktop PC at 
your destination, pack the sync cable. You do not need to take 
a docking cradle. 

• Extra main battery (F1281A)—Carry a spare in case you 
are stranded or unable to connect to ac power for a long period 
of time.  

• CompactFlash Card—Protect your data while you travel by 
backing up to a CompactFlash Card. 

                                                                 
* Modem purchased separately. Some Web sites/content may not be 
available. 
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Before you leave 
Before you put your HP Jornada in your briefcase, take a few 
minutes to prepare, and your trip will run smoothly.  

• Identify your HP Jornada—If you will be traveling for an 
extended period, update the owner properties to include your 
address or contact information at your destination. 

• Synchronize—Make sure your calendar, contacts, and tasks 
databases are up-to-date before you leave. Synchronize all 
items just before you back up and disconnect. 

• Back up your data—Perform a full backup to your desktop 
computer and to a PC Card or CompactFlash Card. Carry the 
storage card with you—if your HP Jornada loses power during 
the trip, you will be back up and running in no time. For more 
info, see the Backing up section in chapter 5. 

• Charge batteries—Make sure that your main battery is fully 
charged and that your backup battery is good. Use the Power 
control panel to check battery status, and connect to ac power 
if the main battery is low or replace the backup battery if it is 
low. For more information, see the Managing battery power 
section in this chapter.  

• Lock the audio buttons to prevent inadvertent 
activation of Windows Media Player—Slide the audio lock 
to the left, so the playback functions will not be activated by 
accident. 

• Set your desktop computer to allow dial-in—If you plan 
to dial in to your desktop computer or synchronize from your 
destination, make sure you prepare your desktop computer 
accordingly, and that no one will turn it off while you’re away. 
For details on setting up your desktop computer for remote 
synchronization, see the Synchronizing from a remote 
location section in chapter 3. 
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8 | Troubleshooting 8 | Troubleshooting 8 | Troubleshooting 8 | Troubleshooting  

If you encounter difficulties while using your HP Jornada 
Handheld PC, this chapter will help you find answers. If you need 
information about troubleshooting Microsoft ActiveSync, click 
Connection Settings on the File menu, then click the help 
button.  

The information in this chapter will help you: 

• Maintain your HP Jornada in its best working order  

• Troubleshoot basic problems 

• Troubleshoot problems with remote connections 

• Troubleshoot problems with the display 

• Troubleshoot problems connecting by infrared 

• Reset your HP Jornada 

Maintaining Maintaining Maintaining Maintaining your HP Jornadayour HP Jornadayour HP Jornadayour HP Jornada    
When treated properly, your HP Jornada will be a reliable 
desktop PC companion. Follow these tips to ensure long and 
trouble-free use: 

Keep the unit clean 
Touching the HP Jornada screen with your hand will leave a 
trace of natural oil that may make it difficult to read the screen. 
To clean the screen, use a commercial glass cleaner sprayed on a 
soft cloth. Avoid spraying the screen directly.  

Be sure to turn off your HP Jornada before cleaning the touch 
screen  
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Be careful not to get sand and dirt inside the unit. If you think 
your HP Jornada has sand or dirt inside the unit case, contact 
your authorized Hewlett-Packard dealer. 

Follow general safety precautions 
To keep your HP Jornada in good operating condition, follow 
these guidelines: 

• Only open your HP Jornada case as far as the hinges allow. 

• Do not use excessive force when inserting or removing 
CompactFlash Cards or PC Cards or when opening or closing 
the CompactFlash Card door. 

• Always keep the cable attached while synchronizing with your 
partner PC until synchronization is complete. 

Avoid damage 
Be careful to keep your HP Jornada from being dropped, bumped, 
or crushed. Dropping or placing something heavy on top of your 
HP Jornada can cause damage to delicate components such as 
the display. Accidental damage is not covered under the Hewlett-
Packard express warranty.  

Avoid radiated interference 
Radiated interference from other electronic equipment may affect 
the appearance of the display and the modem function of the HP 
Jornada. Removing the HP Jornada from the source of the 
interference will return the display and the modem function to 
normal. 

Avoid high temperatures 
Your HP Jornada is designed to operate at temperatures between 
0 to 40 ºC (32 to 104 ºF) and to maintain data at temperatures 
between 0 to 55 ºC (32 to 131 ºF). Subjecting the device to 
temperatures outside this range may damage the unit or result in 
loss of data. Be especially careful not to leave your HP Jornada in 
direct sunlight or in a car where temperatures can rise to 
harmful levels. 
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Troubleshooting basic problemTroubleshooting basic problemTroubleshooting basic problemTroubleshooting basic problemssss    
If you have a specific problem, review the information below to 
see if you can quickly find the answer. Or, visit the HP Jornada 
Web site at www.hp.com/jornada for current information about 
common difficulties. 

 

Problem Diagnosis/Remedy  

HP Jornada does not 
turn on when connected 
to ac power 

HP Jornada is locked up. Connect 
the HP Jornada to external power, 
and perform soft reset. (See the 
Resetting section in this chapter. 
Caution: You will lose any unsaved 
data when performing a soft reset.) 

HP Jornada does not 
turn on when not 
connected to ac power 

Battery power is too low to run 
device. Connect to ac power, and 
then turn on your HP Jornada. 
(Charge the battery regularly to 
avoid running out of battery 
power.) For information on 
charging the main battery and 
checking battery status, refer to the 
Installing the main battery 
section in chapter 2. 

Battery runs out of 
power very quickly. 

You may be using your HP Jornada 
in ways that drain the batteries 
quickly. See the Managing 
battery power section in  
chapter 7. 

HP Jornada does not 
auto-suspend when 
connected to a desktop 
PC or when using the 
modem. 

The HP Jornada is designed to stay 
on while connected to a computer. 
This is the correct behavior. No 
action is needed. However, the 
device will go into display off mode 
to conserve battery power if there is 
no keyboard or touch screen input. 
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Problem Diagnosis/Remedy  

HP Jornada 
automatically shuts 
down/suspends. 

Main battery is too low to run device. When 
a critically low-battery condition is 
encountered, the HP Jornada initiates 
a safety shutdown. Connect to ac 
power and charge the main battery. 
Do not remove the backup battery. 

—or— 

Auto-suspend activated. To 
conserve power, the HP Jornada 
auto-suspends if it is idle for 
1 minute immediately after power 
is turned on. It also auto-suspends 
if it is continuously idle for 3 
minutes. 

—or— 

HP Jornada is locked up. Connect 
the HP Jornada to external power, 
and perform soft reset. (See the 
Resetting section in this chapter. 
Caution: You will lose any unsaved 
data when performing a soft reset.) 

HP Jornada locks up 
when running 
applications. 

Program memory is low. For 
detailed instructions on making 
more program memory available, 
see the Memory management 
section in chapter 7. 

—or— 

HP Jornada is locked up. Connect 
to ac power and perform a soft 
reset. (See the Resetting section in 
this chapter.)  

Note: Check battery power level 
regularly to ensure that the main 
battery is not running low on 
power. 
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Problem Diagnosis/Remedy  

HP Jornada does not 
turn on or display 
appears to be off, even 
though power is on. 

The display contrast is too light. 
Press   to increase contrast. 
(For more information, see the 
Using HP Settings section in 
chapter 2.) 

—or— 

Your HP Jornada main battery is 
discharged. Connect to ac power 
and charge the main battery. 

HP Jornada runs very 
slowly. 

There is insufficient program 
memory or the memory needs to be 
refreshed. For detailed instructions 
on making more memory available, 
see the Memory management 
section in chapter 7.  

You can add additional memory to 
your HP Jornada.  See the 
Accessories section in chapter 7 
for a list of accessories that will 
increase your HP Jornada memory. 

—or— 

Temporary files may have 
accumulated in HP ChaiVM, and 
you need to clear the ChaiVM cache.  

To clear the cache in HP ChaiVM, 
on the Start menu, tap Programs, 
then tap HP Applications. Open 
HP ChaiVM and tap Options, then 
tap Clear Cache. 
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Problem Diagnosis/Remedy 

Insufficient memory 
error occurs when 
running an application. 

HP Jornada has run out of program 
memory for the application. 

For detailed instructions on making 
more program memory available, 
see the Memory management 
section in chapter 7. 

—or— 

HP ChaiVM is enabled in Internet 
Explorer, consuming  a minimum of 
16MB of program memory. 

 Using the System control panel, 
adjust the memory settings to 
increase available program memory 
(see Memory Management in 
chapter 7). 

If you cannot sufficiently increase 
available program memory, disable 
the HP ChaiVM Internet Explorer 
plug-in. To do this, on the Start 
menu, tap Programs, then tap HP 
Applications. Open HP ChaiVM 
and tap Options, then remove the 
check mark to disable the ChaiVM 
IE plug-in. (See Disabling HP 
ChaiVM in Internet Explorer 
section in chapter 6 .)  

HP Jornada does not 
detect a PC Card. 

PC Card is not inserted properly or 
drivers are not installed on your HP 
Jornada. Remove and re-insert the 
PC Card correctly. If this does not 
fix the problem, check the 
documentation for the PC Card for 
information on installing drivers. 
(For more information about 
compatible PC Card modems, see 
the HP Jornada Web page at 
www.hp.com/jornada.) 
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Problem Diagnosis/Remedy 

HP Jornada will not 
establish a connection 
with a desktop PC. 

The HP Jornada is not properly 
seated in the docking cradle 
(optional on the HP Jornada 710), 
the serial sync cable is not 
connected properly to the PC or the 
HP Jornada, or communications 
are not configured correctly. 
Reconnect the cable correctly or see 
Microsoft ActiveSync Help for more 
information. 

Backup file created 
with the HP backup 
application on another 
HP handheld device 
cannot be restored to 
the HP Jornada. 

Only PIM data can be migrated to 
HP Jornada 700 Series. Because 
the HP Jornada 700 Series uses a 
newer operating system, it is 
recommended that you restore PIM 
data from an older device by using 
Microsoft ActiveSync or Microsoft 
Outlook rather than HP backup. 
Synchronize your older HP 
handheld device with Microsoft 
Outlook on your desktop PC, and 
then establish a new partnership to 
transfer data to your new HP 
Jornada. 

While performing full 
restore from 
ActiveSync, a warning 
message appears 
stating that  “Restore 
could not copy the file 
mdmlog6.txt to the 
device” 

Select “Skip All”. You should see a 
message that reads “Restore 
Complete”. 

Disconnect and then reset your 
device for the restore changes to 
take effect. 
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Problem Diagnosis/Remedy 

Unable to synchronize 
through USB port. 

The wrong version of Microsoft 
ActiveSync is installed on your 
desktop PC. Ensure that you have 
installed the version of Microsoft 
ActiveSync included with your HP 
Jornada 700 Series. 

–or– 

The USB connection is not enabled 
on your HP Jornada. On the Start 
menu, tap Settings, tap Control 
Panel, then double-tap the 
Communication icon. On the PC 
Connections tab, tap the Change 
button, and then select USB 
connection from the drop-down 
list. 

–or– 

The USB connection is not enabled 
in ActiveSync on your desktop PC. 
In ActiveSync, on the File menu, 
click Connection Settings, and 
then select the Allow USB 
connection with this desktop 
computer check box. 

The HP viewer seems 
to launch slowly. 

Contacts, Calendar, and Tasks 
databases are very big. Limit the 
size of your databases by 
synchronizing only selected 
contacts, appointments, and tasks. 
For more information, see the 
Synchronizing data section in 
Chapter 3. 

This only occurs the first time HP 
viewer is launched, or when HP 
viewer is launched after a soft 
reset. 
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Problem Diagnosis/Remedy 

Sometimes 
appointments entries 
are not shown in HP 
viewer but can be  
viewed in Calendar 

The appointment may not be 
updated real time in HP viewer 
after synchronization . Perform a 
soft reset to clear the cache and re-
start the HP viewer. 

 

HP Jornada will not 
send e-mail messages 
from Inbox. 

Message header is too big. If your 
address list exceeds 32 KB, Inbox 
cannot send the message.  

Data has been lost. Your HP Jornada has lost power. 
Restore data from a backup file on 
your desktop PC or a 
CompactFlash card. 

–or– 

Factory default settings have been 
restored. Restore data from a 
backup file on your desktop PC or a 
CompactFlash card. 

File attachments to e-
mail messages are 
corrupted.  

Sender’s or  recipients’ mail server 
does not support MIME encoding.  
Turn off MIME encoding. If you 
created your e-mail service using 
HP dialup, see Creating and 
modifying connections in 
chapter 6 for instructions on 
changing settings for the e-mail 
service. If you created your e-mail 
service in Inbox, tap Options on the 
Services menu to modify properties 
for the e-mail service. 
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Problem Diagnosis/Remedy 

While printing multiple 
files, printing message 
box does not disappear 
after finished printing 
the first file. 

There is insufficient program 
memory or the memory needs to be 
refreshed. For detailed instructions 
on making more memory available, 
see the Memory management 
section in chapter 7.  

You can add additional memory to 
your  HP Jornada.  See the 
Accessories section in chapter 7 
for a list of accessories that will 
increase your HP Jornada memory. 

Some of the icons from 
the desktop disappear. 

There is insufficient program 
memory or the memory needs to be 
refreshed. For detailed Instructions 
on making more memory available, 
see the Memory management 
section in chapter 7. You can add 
additional memory to your HP 
Jornada.  See the Accessories 
section in chapter 7 for a list of 
accessories that will increase your 
HP Jornada memory. 

It is difficult to install 
or run software from 
previous HP handheld 
devices on HP Jornada 
700 Series. 

Install software for StrongARM 
SA1100 or SA1110 SW processors 
only. Earlier versions of HP 
handheld devices (except for 
Jornada 820 series) use a different 
processor type. Software designed 
for other processor types is not 
compatible with the StrongARM 
SA111X family of processors. 

Internet Explorer will 
not display a page with 
Java applets, or 
unexpectedly quits 
when trying to display 
them. 

The Java applet may be consuming 
too much memory, causing Internet 
Explorer to behave erratically. Turn 
off the HP ChaiVM plug-in. On the 
Start menu, navigate to Programs / 
HP Applications / and open HP 
ChaiVM. Tap Options and 
uncheck the check box to disable 
the Internet Explorer ChaiVM 
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plug-in. This will prevent the 
offending Java applet from trying 
to run. 

Inaccurate response to 
stylus tap. 

The touch screen may need 
recalibration. To recalibrate the 
touch screen tap the Start menu, 
then Settings, then tap Control 
Panel, and then double-tap the 
Stylus icon. On the Calibration 
tab, tap the Recalibrate button 
and follow the prompts on the 
screen. 

Troubleshooting remote connectionsTroubleshooting remote connectionsTroubleshooting remote connectionsTroubleshooting remote connections    
This section offers troubleshooting help for trying to connect your 
HP Jornada to other computers. For problems communicating 
with your desktop, see Microsoft ActiveSync Help. 

Unable to dial out using the modem 
• If you are using a PC card modem, verify that the modem is 

installed correctly and connected to a telephone line. 

• If you are using the internal modem (on models equipped with 
a built-in modem), verify that you are using an analog 
telephone line. (Most home telephone lines are analog, while 
most office telephone lines are digital.) 

• Verify you have set dialing properties for this connection 
correctly.  

• Check to see if the modem is waiting for a dial tone. To do this, 
on the Start menu, point to Programs, point to 
Communication, and then tap Remote Networking. Select 
your connection, and then tap Properties on the File menu. 
In the Dial-Up Connection dialog box, tap Configure and 
then tap the Call Options tab. Verify that Wait for dial 
tone before dialing is selected.  

• In certain countries you may have to clear the Wait for dial 
tone before dialing check box. 

• Allow more time for the call to go through if you are 
attempting to make an international call. On the Call 
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Options tab described in the previous step, clear the Cancel 
the call if not connected within option or increase the 
number of seconds allowed. 

Able to dial out, but unable to make a proper  
connection 
• Verify that the network you are attempting to connect with 

supports PPP (Point-to-Point protocol) or SLIP (Serial Line 
Internet Protocol).  

• Verify that you have the correct dialing location selected. On 
the Start menu, point to Settings, tap Control Panel, and 
then double-tap the Dialing icon. Make sure that the location 
settings reflect your current location, that the dialing pattern 
for the location is appropriate, and that the local country and 
area code are correct. 

Connection is unreliable 
• Make sure the modem is firmly seated and connected to both 

your HP Jornada and the telephone jack. 

• Disable call waiting. On the Start menu, point to Settings, 
tap Control Panel, and then double-tap the Dialing icon. 
Select Disable call waiting by dialing and enter the disable 
code specified by your telephone company. 

Network connection is not listed in the ActiveSync 
dialog box 
• Close the dialog box, wait a few minutes, and try again. 

• Reset your HP Jornada. (See the Resetting section in this 
chapter.) 

Infrared transfer between MS Windows for H/PC 
2000–based devices 
If you are unable to transfer information between H/PC 2000 
devices by infrared, try the following. 

• Transfer only one file, or no more than 25 contact cards, at a 
time. 
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• Position the infrared ports so that they line up and are less 
than 1 meter (3 feet) but more than 5 centimeters (2 inches) 
apart. 

• Make sure nothing is blocking the path between the two 
infrared ports.  

• Adjust the room lighting. Some types of lighting interfere with 
infrared communication. Try moving to a different location or 
turning off some lights. 

DisplayDisplayDisplayDisplay    
If you are having trouble viewing your data, here are some 
suggestions. 

Screen is blank 
If your HP Jornada fails to respond when you briefly press the 
On/Off button, be sure you have pressed the button firmly. If that 
does not work: 

• Make sure the main battery is installed properly. 

• Adjust the display contrast. On some devices, the screen can 
darken or lighten to the point that it appears to be turned off. 

• Reset your HP Jornada. (See the Resetting section in this 
chapter.) 

• Recharge the main battery. 

Screen is dark 
Prolonged exposure to direct sunlight may cause your 
HP Jornada screen to temporarily darken. This is a normal 
occurrence with LCD screens and is not permanent. 

ResettingResettingResettingResetting    
Occasionally, you will need to reset your HP Jornada, for 
example, after you restore data from your desktop PC or when 
the operating system stops responding. There are two methods of 
resetting:  
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• Soft reset—A soft reset (also called “warm boot”) is similar to 
restarting your desktop PC. It restarts the operating system 
and preserves any saved data.  

• Factory default reset—A factory default reset (also called 
“hard reset”) restores your HP Jornada to its original state, 
erasing all information you have entered.  

To ensure the safety of your information in case a factory default 
reset is necessary, you should regularly back up your data to your 
desktop PC (using Microsoft ActiveSync) or to a CompactFlash or 
PC Card (using the HP Jornada backup application). For more 
information on backing up data, see the Backing up and 
restoring data section in chapter 5.  

 

Soft reset 
Perform a soft reset after restoring data from a backup file or 
when your HP Jornada appears to be frozen or locked up. 

To perform a soft reset 

1. Disconnect the sync cable and/or the telephone line from your 
HP Jornada, or remove it from the docking cradle (optional 
on the HP Jornada 710). 

2. Use the stylus to press the Reset button. 
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Using the stylus to perform a soft reset 

When you perform a soft reset you will lose unsaved data in all 
open documents or programs.  

Factory default reset 
Perform a factory default reset only when your HP Jornada does 
not respond to a soft reset. A factory default reset will erase all 
data you have entered, including all files, system settings, and 
programs you have installed. If you have forgotten your primary 
and reminder passwords, you will also need to perform a factory 
default reset. 

Performing a factory default reset erases all files, programs, 
and appointments you have entered. You can restore only data 
that has been backed up to your desktop PC or to a PC Card or 
CompactFlash Card. (For more information, see the Backing 
up and Restoring data section in chapter 5.) 

 

To perform a factory default reset 

1. Disconnect all cables, including the ac adapter from your 
HP Jornada. 

2. Remove the backup battery. For more information, see the 
Replacing the backup battery section in chapter 7.) 

3. Remove the main battery. 
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4. Wait at least 5 minutes, then reconnect the ac adapter,  
reinstall the main battery, and then reinstall the backup 
battery. (For more information, see the Setting up your 
HP Jornada section in chapter 2.) Your HP Jornada should 
turn on automatically and display the MS Windows for H/PC 
2000 Welcome Wizard. For more information about this 
wizard, see the Completing the Welcome Wizard section 
in chapter 2. 

5. Restore data to your HP Jornada from your most recent 
backup file. For more information, see the Backing up and 
Restoring data section in chapter 5. 
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9 | Support and service 9 | Support and service 9 | Support and service 9 | Support and service     

Web site Web site Web site Web site     
You can obtain product information as well as tips and hints on 
how to get more from the HP Jornada product at our worldwide 
Web site. This computer service is provided free of charge; you 
pay only for telephone charges and Internet service fees. To 
connect to this Web site from a computer via the Internet, go to 
www.hp.com/jornada.  

Customer support Customer support Customer support Customer support     
If you have questions that this User’s Guide or the Web site does 
not answer (after checking the contents and index), you can 
contact Hewlett-Packard Worldwide Support and Services for 
Handheld Products at the telephone numbers listed in the 
following table.  

If the device requires service, contact Hewlett-Packard for service 
information, shipping instructions, and out-of-warranty service 
charges before you send your device to HP for repair.  

In countries not listed in the table, contact the Hewlett-Packard 
authorized dealer or sales office.  

Service Service Service Service     
For diagnostic instructions and other service information, contact 
one of the technical support numbers listed. Please do not ship 
your device for service without first contacting a Hewlett-Packard 
office. If your device qualifies for in-warranty service, be ready to 
supply a dated proof of purchase.  In countries not listed in the 
following table, contact the Hewlett-Packard authorized dealer or 
sales office.  
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Before you contact us for help, be sure to:  

1. Review the manuals whenever possible. 

2. Have the following information about the product:  

·  Model number  

·  Serial number  

·  Purchase date  

3. Have your product ready to use. The support personnel may 
ask you to run tests and other operations. 

4. Organize your question or problem. The more detailed 
information you can provide, the quicker the support 
personnel can help you.  

Contacting HewlettContacting HewlettContacting HewlettContacting Hewlett----Packard worldwide Packard worldwide Packard worldwide Packard worldwide     
You will be pleased to know that our commitment to quality does 
not stop at the sale. Our worldwide customer support network is 
available to give you personal telephone service should you need 
it.  

Country/Region Telephone  

Argentina (Buenos Aires) (5411)-4778-8380 

Argentina (outside 
Buenos Aires 

0810-555-5520 Ext. 4778 / 
8380 

Australia  61-3-88778000  

Austria  43-711-4201080  

Belgium (Dutch) 32-2-6268806  

Belgium (French) 32-2-6268807  

Brazil (Saõ Paulo) 11-3747-7799 

Brazil (outside Saõ Paulo) 0800-157751 

Canada  1-905-2064663 

Chile  56-800-360999  

China  86-10-65645959  

Czech Republic 420-2-61307310  
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Denmark  45-39-294099  

Finland  358-20347288  

France  33-1-43623434  

Germany  49-1-805258143  

Greece  30-1-6896411  

Hong Kong  800-967729  

Hungary  36-1-3430310  

India  91-11-6826035  

Indonesia  62-21-3503408  

Ireland  353-1-6625525  

Israel  972-9-9524848  

Italy  39-2-26410350  

Japan  81-3-33358333  

Korea  82-2-32700700  

Malaysia  60-03-2952566  

Mexico (Mexico City) 52-58-9922 

Mexico (outside Mexico 
City) 

01-800-4720684 

Netherlands  31-20-6068751  

New Zealand  64-9-3566640 

Norway  47-22-116299  

Philippines  63-2-8673551  

Poland  48-22-8659999  

Portugal  351-13180065 

Russia  7-095-9169821  

Singapore  65-2725300  

South Africa  27-11-8061030  

Spain  34-91-7820109  
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Sweden  46-8-6192170  

Switzerland (German) 41-1-4332728 

Switzerland (French) 41-1-4332729 

Taiwan  886-2-27170055  

Thailand  66-2-6614000  

Turkey  90-212-2245925  

UK  44-870-6083003  

USA  

Pre-sales Information 

 
 

Support & Service 

 

1-800-4431254 

(toll-free, no operator is 
available) 

1-970-635-1000 

Palmtops & Organizers 
(toll call) 

Venezuela (in Caracas) 58-2-207-8488  

Venezuela (outside 
Caracas) 

58-800-47-777 

Vietnam 84-0-88234530 

All Customer Care Centers are available during office hours. Pre-
sales Information in the USA is available 24 hours per day, 7 
days per week. Support & Service in the USA can be contacted 
from 5 AM to 5 PM Pacific Time, Monday through Friday. 
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Appendix A | Appendix A | Appendix A | Appendix A | 
Ergonomics Ergonomics Ergonomics Ergonomics     

This chapter provides guidance and hints to help you work in a 
comfortable and ergonomically low-risk environment. If you 
experience pain or discomfort while using this or any other 
equipment, you should stop working and review this chapter. If 
the discomfort continues, stop using the equipment and consult a 
doctor as soon as possible. 

Setting up and using equipmentSetting up and using equipmentSetting up and using equipmentSetting up and using equipment    
Some people experience physical discomfort while using 
computers. Sometimes this discomfort leads to Repetitive Strain 
Injury (RSI), also known as cumulative trauma disorder or 
repetitive motion injury. Setting up and using equipment 
properly can help minimize this discomfort. Well-designed and 
properly adjusted equipment may not be sufficient to eliminate 
all potential problems. How you perform your computer activities 
is also important.  

What is RSI?What is RSI?What is RSI?What is RSI?    
RSI is a type of injury caused by the irritation or inflammation of 
soft tissues such as muscles, nerves, or tendons. In extreme cases, 
this irritation can lead to permanent tissue damage. RSI has 
been a documented problem for workers performing specific tasks 
such as assembly line work, meatpacking, sewing, playing 
musical instruments, and working with a computer. It may also 
result from other activities, such as tennis. 

What causes RSI?What causes RSI?What causes RSI?What causes RSI?    
RSI is caused by certain demanding activities that exceed the 
body’s ability. Common factors associated with RSI include too 
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many uninterrupted repetitions of an activity or motion, 
performing an activity in an awkward or unnatural posture, 
maintaining static posture for prolonged periods, failing to take 
frequent short breaks, and stress. Certain medical conditions, 
such as rheumatoid arthritis and diabetes, may contribute to 
RSI. 

RSI symptomsRSI symptomsRSI symptomsRSI symptoms    
By following the guidelines on proper setup and use of equipment 
and work environment, the risk of developing RSI can be 
minimized. However, if you experience any discomfort, seek 
professional advice immediately. Typically, the earlier a problem 
is diagnosed and treated, the easier it may be to resolve. 

Avoiding RSIAvoiding RSIAvoiding RSIAvoiding RSI    
Recent literature suggests that there may be a relationship 
between injury to soft tissues, especially in the hands and arms, 
and the prolonged use of keyboards or other equipment requiring 
repeated motion of the hands and forearms. Literature also 
suggests that there are many other risk factors that may increase 
the chances of such soft-tissue injury. You can minimize the risk 
of suffering from RSI by following the guidelines detailed in this 
chapter. 

Setting up your working environment Setting up your working environment Setting up your working environment Setting up your working environment     
You must have enough space to move around and vary your 
position. To avoid eyestrain, the ceiling, walls, and floors should 
have a medium level of reflectance (approximately 75 percent of 
ceiling reflectance, 40 percent of wall reflectance, and 30 percent 
of floor reflectance). Try to avoid excessive contrast between the 
screen and its surroundings. The work environment should be as 
quiet and distraction-free as possible, with background noise 
below 58 dBA. Where possible, relative air humidity should be in 
the range of 40 to 60 percent. Recommended room temperature is 
19 to 23 ºC (66 to 73 ºF). If possible, adjust the temperature to a 
comfortable level. The workplace should be well ventilated. 

Pay attention to your posture; relax your shoulders and keep your 
wrists straight. This is easier when your keyboard can be 
positioned right under your hands while bending your elbows at 
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90º. Pull your chin in to look down, and try to lean back in the 
chair. The backrest should support you in the hollow of your 
back.  

Reducing eye strain Reducing eye strain Reducing eye strain Reducing eye strain     
Have your eyes checked on a regular basis and ensure your 
eyeglass prescription is suitable for working on a computer 
screen. Look away from the screen from time to time. Focus on 
distant objects briefly. Blinking periodically helps to lubricate the 
eyes. 

Preventing muscle stiffnessPreventing muscle stiffnessPreventing muscle stiffnessPreventing muscle stiffness    
Avoid holding your muscles tense for long periods of time. Keep 
your fingers and body relaxed. Changing tasks frequently helps 
prevent muscle stiffness. Alternating between typing, writing, 
filing, and moving around in your work environment helps to 
keep muscles loose. 

Taking frequent short breaksTaking frequent short breaksTaking frequent short breaksTaking frequent short breaks    
When you are required to work on your computer for prolonged 
periods of time, take short breaks frequently. As a general rule, a 
5- and 10-minute break every hour is a good idea. It is better to 
take short breaks frequently than longer breaks less frequently. 
Data shows that people who work for long periods of time without 
a break are more prone to injury. Occasionally stretch the 
muscles in your hands, arms, shoulders, neck, and back. You 
should stretch at least once an hour. 
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Appendix B | Migrating Appendix B | Migrating Appendix B | Migrating Appendix B | Migrating 
data from other data from other data from other data from other 
devicesdevicesdevicesdevices    

Transferring data from a palmTransferring data from a palmTransferring data from a palmTransferring data from a palm----sized, sized, sized, sized, 
popopopocket or handheld PC cket or handheld PC cket or handheld PC cket or handheld PC     
If you are currently using a Windows-powered palm-size or 
handheld PC, you can transfer data to your HP Jornada. If you 
have offline folders in Inbox on your palm-size or handheld PC 
that contain e-mail messages you want to transfer to your Pocket 
PC, you will have to follow a separate procedure, included below. 

Transferring PIM data from an IrDA equipped palm-sized 
PDA device is easy with HP info exchange. See Using HP 
info exchange in chapter 4 of this guide. 

 

To transfer data from another Windows-powered 
device 

1. Install Microsoft ActiveSync 3.1 on your desktop PC. For 
information on installing ActiveSync, see the Getting Started 
with Microsoft ActiveSync booklet. 

2. Synchronize your device with your desktop PC, so that the 
information on your desktop PC is current. 

3. If you have files on your device that you want to transfer, 
such as Note Taker notes and recordings, turn file conversion 
off in ActiveSync options so that the files stay in device 
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format, and use ActiveSync Explorer to copy the files to your 
desktop PC. For specific instructions, see ActiveSync Help on 
the desktop PC. 

4. Synchronize your HP Jornada with your desktop PC. This 
will update your HP Jornada with the current data from your 
desktop PC. 

5. Reinstall programs. Check with the program vendors to find 
out if new versions that have been optimized for the HP 
Jornada are available. 

6. Using ActiveSync Explorer, copy the files you transferred to 
your desktop PC in step 3 to your HP Jornada. 

7. In ActiveSync, turn file conversion on again. 

8. Enter settings and connection information on the Pocket PC. 

To transfer offline folders 
1. Connect your palm-size or handheld PC to your desktop PC, 

and then click Windows CE Inbox Transfer on the 
Microsoft Outlook Tools menu. 

2. Select Copy or move selected messages to your desktop 
computer, and then click the Browse button. 

3. Select the offline folder that contains the messages you want 
to transfer to your desktop PC, and then click OK. 

4. Click the Transfer button and select the folder you want to 
transfer the messages to or click New Folder to create a new 
folder. Click OK to transfer the messages. Now you must 
transfer the messages from your desktop PC to your HP 
Jornada. 

5. In Inbox on your HP Jornada, tap Tools and then tap New 
Folder to create a folder for the messages you are going to 
transfer. 

6. In Outlook on your desktop PC, select the messages you want 
to transfer. 
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7. Connect your HP Jornada to your desktop PC, and then click 
Windows CE Inbox Transfer on the Outlook Tools menu. 

8. Select Copy selected messages to your mobile device, 
and then click the Browse button. 

9. Select the offline folder on your device that you want to 
transfer the messages to, and then click OK. 

10. Click the Transfer button. The selected messages are moved 
to your HP Jornada. 

Migrating data from PalmMigrating data from PalmMigrating data from PalmMigrating data from Palm devices devices devices devices    

Migrating from Palm III and newer products 
Palm V™ and Palm III™ series connected organizers can 
synchronize data with Microsoft Outlook. From MS Outlook you 
can synchronize the data to your HP Jornada using ActiveSync. 
Use PocketMirror® from Chapura™  (included with the Palm™ 
Desktop organizer software) to synchronize data between your 
Palm Computing handheld and Microsoft Outlook.  

To use Chapura’s PocketMirror conduit, first install the Palm™ 
desktop software that is included with your Palm IIIx™ or Palm 
V™ organizer. If you choose to synchronize with Microsoft 
Outlook, the PocketMirror conduit will be installed with the Palm 
desktop software. For more information, go to the Palm Web site 
at www.palm.com. 

Migrating from older Palm organizers  
If you would like to use PocketMirror to synchronize your Palm 
Pilot or Pilot organizer with Microsoft Outlook, you will need to 
purchase the commercial version of the software from Chapura, 
the maker of PocketMirror. Check the Chapura Web site at 
www.chapura.com. 
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Appendix C | Using the Appendix C | Using the Appendix C | Using the Appendix C | Using the 
Keyboard in Terminal Keyboard in Terminal Keyboard in Terminal Keyboard in Terminal 

Server ClientServer ClientServer ClientServer Client    

Creating extended keyboard characters in Creating extended keyboard characters in Creating extended keyboard characters in Creating extended keyboard characters in 
the Terminal Server Client window (TSC)the Terminal Server Client window (TSC)the Terminal Server Client window (TSC)the Terminal Server Client window (TSC)    

The  key combinations that normally create extended 
and international characters on the HP Jornada keyboard 
(color-coded yellow symbols on selected keys)  are not 
available when typing in the TSC application. However, 
you can still create these characters using special, 
alternative keystroke combinations when you are typing in 
a TSC session. 

Using the alt key in conjunction with specific numeric key 
combinations will produce these extended and 
international text characters in a TSC session window. 

The keyboard must be in NUMLOCK mode when pressing the 
numeric keys indicated in these keyboard alternatives, and the 
alt key and all of the indicated numeric keys must be 
pressed to create the desired character. 
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Table of extended and international characters 
for TSC 

The table below illustrates the characters available and the 
corresponding keystrokes that create them in a Terminal 
Server Client window. 

 

To create this 
character: 

Type these 
keystrokes: 

{ Alt+1,2,3 

} Alt+1,2,5 

[ Alt+9,1 

] Alt+9,3 

~ Alt+1,2,6 

' Alt+9,6 

� Alt+0,1,2,8 

£ Alt+0,1,6,3 

 

 
Terminal Server Client is available in U.K. and U.S. English 
versions of the HP Jornada 700 Series only. 
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GlossaryGlossaryGlossaryGlossary    

ac adapter  A connector that provides external power (not 
battery power) to your HP Jornada. For information 
about installing and using the ac adapter, see the 
Setting up your HP Jornada section in chapter 2. 

ActiveSync  Software from Microsoft that manages data 
synchronization between your HP Jornada and desktop 
PC. You can specify the type of data you want to 
synchronize. 

backup file  A duplicate copy of your HP Jornada files and 
data that is stored on your desktop PC or on a PC Card. 
This file does not include your HP Jornada settings and 
information stored in ROM, such as factory-installed 
software. Use your backup file to restore your 
HP Jornada to its previous state if your device data is 
damaged or destroyed or if you have performed a factory 
default reset. 

cache  A special high-speed storage mechanism that saves 
temporary copies of Web pages and other file types as 
you view them. Your computer can quickly display Web 
pages you have recently visited, because Internet 
Explorer can open them from cache instead of having to 
load them again from the Web. Increasing the space 
designated for your cache folder increases how quickly 
recently visited files are displayed, but decreases the 
amount of space available for other files on your 
HP Jornada. You can choose to empty your cache upon 
exiting Internet Explorer. This saves space on your 
device. 

cookies  A packet of messages a Web server passes to your 
Web browser. When you enter a Web site that uses 



178 HP Jornada 700 Series Handheld PC 

 

cookies, you may be asked to fill out a form with 
information such as your name and interests. This 
information is passed to your Internet Explorer browser 
as a cookie (in the form of a text file called cookie.txt). 
The next time you visit that Web site, Internet Explorer 
will pass the cookie back to the Web server, and the 
server will use this information to present you, for 
instance, with custom Web pages filled with information 
of interest to you. For example, instead of being 
presented with a generic welcome page, you might 
receive a welcome page with your name on it. 

dial-up connection  A connection between your 
HP Jornada and another computer by modem. You can 
have a dial-up connection with an ISP, a network, or 
with a modem attached to a PC. 

direct connection  A connection between your 
HP Jornada and another computer by means of the 
serial sync cable, USB cable or IR port. 

docking cradle (optional on the HP Jornada 710) Place 
your HP Jornada in the docking cradle for instant 
connectivity with your PC partner. Once you have seated 
your HP Jornada into the docking cradle you can sync 
with your PC partner, transfer documents, send e-mail 
and charge your main battery. 

DNS (Domain Name System)  An Internet service that 
translates domain names into IP addresses. For 
example, the domain name www.jornada.com might 
translate as 198.125.247.4.  

factory default reset  A process that returns your HP 
Jornada to its original state by removing all power, 
thereby erasing all files and data you have saved. For 
more information, see the Resetting section in chapter 
8. (Also called “hard reset.”) 

hard icons The icons located along the right side of your 
touch screen are hard icons. Tap these icons to open the 
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HP settings, HP backup, HP dialup and Windows Media 
Player applications. 

hot keys  The keys in the top row of the Jornada keyboard, 
just below the display screen. Hot keys provider one-
touch access to the most frequently used programs on 
your HP Jornada 

Internet Service Provider (ISP) A company that 
provides access to the Internet. 

IP (Internet Protocol)  Specifies the format of packets, 
also called datagrams, and the addressing scheme of the 
Web. Much like a postal system, IP allows you to address 
a package and drop it into the system, but your package 
is not delivered instantly to your recipient. The packets 
are simply delivered to a server until the recipient 
downloads them by logging onto the ISP server. 

IrDA (Infrared Data Association)  An international 
standard for the hardware and software used in infrared 
communication links. 

Java  An object-oriented programming language used to 
create applications that run on client or server 
computers, and "applets" for use as part of a Web page. 

LAN (Local area network)  A group of computers, 
usually in close proximity (either in the same building or 
in buildings in close proximity), that are linked together 
to share files and exchange data. 

MIME (Multipurpose Internet Mail Extensions)  A 
standard that allows binary data (such as graphics or 
documents) to be transmitted over the Internet without 
first being translated into ASCII text. Many e-mail 
programs use MIME to allow files to be sent or received 
as attachments to e-mail messages. 

NIC (Network interface card)  A card that is installed in 
a computer so that it can be connected to a network. 
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Network interface cards can provide a dedicated, full-
time connection to a network. 

ODBC (Open DataBase Connectivity)  A standard 
database access method. The goal of ODBC is to make it 
possible to access any data from any application, 
regardless of which database management system is 
handling the data. 

partnership  An established relationship between your 
HP Jornada and your PC for the purpose of 
synchronizing and transferring data. Your HP Jornada 
can have partnerships with up to two desktop 
computers. 

PCT (Private Communication Technology)  A protocol 
that maintains the security and integrity of Internet 
communications by using encryption, authentication, 
and message-authentication codes. The protocol is 
application independent, and is used by Web browsers 
and e-mail clients to send data via the Internet. PCT is 
able to negotiate encryption keys as well as authenticate a 
server before data is exchanged by the higher level application.  

POP (Post Office Protocol)  The first protocol used to 
retrieve e-mail from a mail server. Most e-mail 
applications (sometimes called e-mail clients) use the 
POP protocol, although some may use the newer IMAP 
(Internet Message Access Protocol).  

PPP (Point-to-Point Protocol)  The default method your 
HP Jornada uses to communicate with the ISP network 
server. 

ROM (Read Only Memory)  Computer memory 
containing data that normally can only be read, not 
written to, containing the programming that allows your 
computer to start up each time you turn it on. Unlike 
random access memory (RAM), the data in ROM is not 
lost when power is turned off. 



Glossary | 181 

  

RAM (Random Access Memory)  Memory that holds 
data and programs while a device is powered on, often 
referred to as "volatile" memory because all information 
is erased when power is off. 

RAS (Remote Access Service) account   A network 
account that enables your HP Jornada to access your 
Windows NT network remotely. 

remote connection   A connection between your 
HP Jornada and a remote computer or server.  

reset  A process that either causes your HP Jornada to 
restart (soft reset) or causes all data stored in RAM to 
be erased (factory default reset). For more 
information, see the Resetting section in chapter 8. 

restore  A process that returns your device to the state it 
was in when last backed up. This involves copying your 
backup data to your HP Jornada. 

SLIP (Serial Line Internet Protocol)  An older and 
simpler protocol than PPP. Connecting to the Internet 
via SLIP is very similar to connecting via PPP. 

soft reset  The process of restarting your HP Jornada and 
reinitializing the MS Windows for H/PC 2000 operating 
system. Performing a soft reset will erase any unsaved 
data in open documents, but will preserve data that has 
been saved. (Also called “warm boot.”) 

stylus  A pen-like utensil designed for navigating on a 
touch screen.  

touch screen  A touch-sensitive screen that allows you to 
open files, launch programs, and select text by touching 
or tapping the screen with the stylus. 

USB (Universal serial bus)  A standardized connection 
method and cabling protocol for connecting peripherals 
and other devices to standalone computers.  
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IndexIndexIndexIndex    

HP Jornada 720 Web site 
hot key  , 115, 138 

.... 
.2bp files, 118 
.bmp files, 118 
.doc file, 105 
.pwd file, 105 
.rtf file, 105 
.ttf files, 117 
.txt file, 105 
.wav files, 118 

5555 
56K V.90 modem, 89 

9999 
9-pin serial port, 36 

AAAA 
AC adapter, 36, 37, 38, 177 

traveling with, 144 
Access numbers, 144 
Accessing 

computer not on network, 
51 

corporate networks, 51 
Accessories, 118 
ActiveSync, 153, 154, 171 

about, 33 
backing up and restoring 

on PC, 79 

Connection Settings 
dialog box, 51 

defined, 177 
installing, 34 
setting up, 32 
Setup Wizard 

about, 32 
Inbox extensions, 

adding, 32 
requirements, 34 
transferring messages, 

32 
Troubleshooter, 43 

ActiveSync CD-ROM, 33, 35 
ActiveSync options, 48, 49 
Add/Remove programs, 116 
Adding or removing 

programs, 116 
Alarms, setting, 118 
Alt + hot keys 

defined, 138 
Attachments 

MIME encoding, 106 
saving on storage cards, 

106 
Audio buttons 

locking, 145 
using, 28 

Auto Connect option, 52 
Auto suspend failure, 149 
Auto-suspend, setting, 129 
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BBBB 
Background tab, 118 
Backing up 

to a CompactFlash Card, 
80 

Backing up and restoring 
data, 78, 81, 91, 181 

Backup file, 177 
Bass and treble 

setting, 137 
Battery 

backup, 126 
backup, replacing, 126 
main, 125 

Battery drain, 
troubleshooting, 149 

Battery main, replacing, 
126 

Battery power 
auto-suspend, 129 
conserving, 129 
managing, 125 
status, 128 

Benefits, overview, 4 
Bitmap images (.bmp files), 

118 
bmp files, 118 
Breakage, 148 
Browsing 

on HP Jornada desktop, 
46 

the Web, 107 
Browsing the Web, 108 

CCCC 
Cables 

HP parallel printer, 77 
serial sync, 36 
sync, 36 
telephone, 36 
USB, 119 

Caching, 177 

Calculator, described, 9 
Calendar, 56 

overview, 6 
Communications control 

panel, 132 
CompactFlash Card 

installing, 120, 122 
overview, 119 
removing, 123 
when traveling, 144 

Configuring 
ActiveSync for infrared 

connection, 45 
HP Jornada for infrared 

connection, 45 
Conflict resolution, default 

settings, 49 
Connecting 

by serial port, 36 
by USB, 38 
HP Jornada to a PC, 31 
HP Jornada to alternate 

PC, 45 
Connecting to Internet, 

personal accounts 
modems, 86 
PPP (Point-to-Point 

Protocol) Account, 87 
Connecting to PC 

9-pin serial port, 36 
with docking cradle, 37, 

38 
without docking cradle, 

36 
Connection Status dialog 

box, 40, 44 
Connections 

dialup, 87, 89 
direct, 178 
network 

creating without HP 
dialup, 101 

partnership 
automatic, 43 
infrared, 44 
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Contacting HP, 164 
Contacts, 58 

overview, 6 
Control panel 

opening, 132 
types of, 132 

Cookies, 177 
Corporate networks 

remote access, 51 
Customer service, 163 
Customizing 

general options, 132 
HP hard icons, 134 
HP hot keys, 134 

DDDD 
Data 

synchronizing general, 47 
synchronizing selected, 48 

Data loss, 155 
Databases, creating, 76 
DC jack, 36, 37, 38 
Default conflict resolution, 

49 
Desktop Wallpaper, 118 
Desktop, HP Jornada 

browsing, 46 
files, working with, 46 
opening files, 46 

Device connection via 
network option, 52 

Dialing control panel, 132 
Dialing locations, setting, 

53 
Dialup connection, 87, 178 
Dialup Connection dialog 

box, 53 
Dialup connections 

multiple, 100 
Dimming, automatic, 

setting, 130 
Display 

dimming, setting, 130 
shutting off, 131 

Display Control Panel, 132 
Display difficulties, 159 
Display profile hot key, 138 
Display Profiles tab, 136 
DNS 

address, 90 
server address, 97 

DNS address, 178 
doc file, 105 
Docking cradle, 36 

defined, 178 
Domain 

network, 92 
Drivers 

installing, 119 
NICs, 98 

EEEE 
Electrical interference, 148 
E-mail 

connecting to service 
provider from Inbox, 
104 

corrupted file 
attachments, 155 

E-mail accounts, corporate 
no offsite access, 88 
offsite access, 87 
setting up, 103 

E-mail accounts, personal 
setting up, 86 

E-mail attachments, 105 
E-mail connections, options, 

85 
E-mail messages 

deleting, 106 
sending difficulties, 155 
synchronizing, 49 

E-mail Service 
setting up, 93 

Enable Address Issue dialog 
box, 103 

Ergonomics, 167 
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FFFF 
Fields, mapping, 67 
File attachments 

MIME encoding, 106 
saving on storage cards, 

106 
File Conversion Properties 

dialog box, 54 
File formats 

GSM, 69 
Microsoft Pocket Word, 72 
PCM, 69 
recording, 68 

File types 
.rtf file, 105 
.txt file, 105 
Pocket Word files (.pwd), 

105 
Word file (.doc), 105 

Files 
accessing on a network, 

99 
arranging on desktop, 46 
attachments, 105 
conversion options, 54 
corrupted attachments, 

155 
opening from desktop, 46 
transferring, 54 

fon files, 117 
Fonts, adding, 117 

TrueType (.ttf files), 117 
Windows (.fon files), 117 

GGGG 
Guest privileges, network, 

98 

HHHH 
Hard icons 

customizing, 134 
defined, 178 

Hard icons tab, 135 
Hot keys 

customizing, 134 
defined, 179 
display profiles, 138 
volume profiles, 138 

Hot keys tab, 135 
HP backup, 80, 81, 153 

overview, 8 
HP ChaiVM, 109 

cache, clearing, 111 
disabling, 110 
Internet Explorer, using 

with, 110 
overview, 8 

HP dialup 
Setup Wizard, 91 

HP dialup, overview, 8 
HP F1227A, 119 
HP F1252A, 119 
HP F1258A, 118 
HP F1274A, 119 
HP F1279B, 119 
HP F1281A, 125 
HP F1281A, 119 
HP F1295A, 119 
HP F1822A, 118 
HP F1840A, 119, 125 
HP F1841A, 119 
HP F1842A, 119 
HP hard icons 

customizing, 134 
restoring default 

assignment, 135 
HP hot keys 

customizing, 134 
overview, 9 
restoring default 

assignment, 135 
HP hot keys control panel, 

132 
HP info exchange, 65 

overview, 8 
HP Jornada 700 Series Web 

site, 138 
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HP Jornada backup 
application, 79, 80 

HP Jornada, infrared 
connection, setting up, 45 

HP parallel printer cable 
(F1274A), 77 

HP quick pad, 63 
overview, 8 
using, 64 

HP security, 140 
overview, 8 

HP security control panel, 
132, 140 

HP settings 
opening, 136 
overview, 8, 136 
profiles, 137 
profiles, changing, 138 
profiles, hot keys, 138 
profiles, setting, 137 

HP viewer, 60 
launching difficulties, 154 
overview, 8 

IIII 
Identification tab, 140 
IMAP4 host, 90 
Inbox, 59, 93, 171, 172 

connecting to ISP 
(Internet Service 
Provider) from, 104 

sending failure, 155 
settings, 105 
using, 102 

Information, sources, 2 
Infrared connection, 

establishing, 45 
Infrared port, 44, 77 
Infrared transfer 

difficulties, 158 
Infrared-equipped PCL 

printer, 77 
Inso® Quick View Plus, 114 
Installing 

applications, 114, 115 
Microsoft ActiveSync, 35 
Microsoft Pocket Outlook, 

32 
Intelligent Power 

Management, 130 
Interference, electrical, 148 
Internet connections 

corporate account with no 
offsite access, 88 

corporate account with 
offsite access, 87 

options, general, 85 
personal account, 86 

Internet Explorer, 107, 109 
browsing the Web, 107 
launching, 108 
options dialog box, 107 
setting up AutoDial, 108 

Internet Options control 
panel, 133 

Internet service provider 
(ISP), 89 

Intranet connections, 107, 
108 

IP (Internet Protocol) 
address, 90, 179 

IrDA port option, printing, 
78 

ISP (Internet Service 
Provider, 89 

ISP (Internet Service 
Provider), 92, 179 
connection, setting up, 90 

JJJJ 
Java 

applets, 109 
applications, 110 
defined, 179 
script, 109 
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KKKK 
Keyboard control panel, 133 

LLLL 
LAN (Local Area Network), 

35, 88, 179 
Locking up, troubleshooting, 

150 

MMMM 
Main battery, 125 

when traveling, 144 
Maintenance and cleaning, 

147 
Make New Connection 

dialog box, 52 
Memory 

allocations, adjusting, 123 
conserving, 124 
displaying information, 

139 
managing, 123 
refreshing, 123 

Memory tab, 123, 139 
Microsoft ActiveSync 

Help, 147 
overview, 32 
setting up for infrared 

connections, 45 
troubleshooter, 43 

Microsoft Ink Writer 
overview, 78 

Microsoft Internet Explorer, 
33, 109 

Microsoft Money 2000, 33 
Microsoft Outlook 2000, 33, 

35, 40, 153, 172, 173 
Microsoft Pocket Access 

creating a database in, 76 
creating a table in, 76 
overview, 76 

Microsoft Pocket Excel 

overview, 75 
Microsoft Pocket Office, 6 

overview, 72 
Microsoft Pocket Outlook, 6, 

55 
installing, 32 

Microsoft Pocket 
PowerPoint 
overview, 73 

Microsoft Pocket Word 
overview, 72 

Microsoft Voice Recorder, 68 
Migrating data from other 

devices, 171 
MIME 

defined, 179 
encoding, 106 

Mobile Channels, 35 
Mobile Device window, 47, 

116 
Mobile Favorites, 35 
Modem card and cable, 144 
Modem list options, 52 
Modems 

connection difficulties, 
158 

dialing difficulties, 157 
installing and 

configuring, 89 
Monitor, viewing 

difficulties, 159 
MS Internet Explorer for 

H/PC, 107 
MS Windows for H/PC 2000 

Add/Remove Programs, 
116 

address bar, 99 
bitmaps (.2bp files), 118 

MS Windows for H/PC 
2000-based devices 
infrared transferring 

difficulties, 158 
MusicMatch Jukebox, 114 
My Handheld PC folder, 120 
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NNNN 
Network 

accessing computer not on 
network, 51 

guest privileges, 98 
Network (LAN) connection, 

88 
Network Configuration 

dialog box, 98 
Network connections 

accessing corporate 
accounts, 51 

creating without HP 
Dialup, 101 

onsite logon, 99 
Network control panel, 133 
Network Domain, 93 
Network interface card 

(NIC), 88 
New Partnership Wizard, 

39 
NIC (Network interface 

card), 179 
configuring, 98 

No converter selected dialog 
box, 116 

Notes tab, 140 

OOOO 
ODBC 

defined, 180 
Office documents, printing, 

77 
OmniSolve from Landwear 

overview, 82 
Open Presentation dialog 

box, 74 
Owner control panel, 133 
Owner properties, altering, 

139 

PPPP 
Palm devices 

migrating data, 173 
Part numbers 

HP F1252A, 119 
HP F1258A, 118 
HP F1274A, 119 
HP F1279B, 119 
HP F1281A, 125 
HP F1281A, 119 
HP F1295A, 119 
HP F1822A, 118 
HP F1840A, 119, 125 
HP F1841A, 119 
HP F1842A, 119 
HPF1227A, 119 

Partnership 
establishing, 39 
New Partnership Wizard, 

39 
Partnership between PC 

and HP Jornada, 180 
automatic connections, 43 
future connections, 43 
overview, 38 
troubleshooting, 40 

Password Activation Delay, 
142 

Passwords 
limitations, 141 

PC card 
installing, 120, 121 
overview, 119 
removing, 121 

PC card adapters, 
recommended, 120 

PC card detection 
difficulties with, 152 

PC Card NIC 
drivers, 98 

PC Connection 
difficulties with, 153 

PC Link, 44 
PCM, 69 
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PCT (Private 
Communication 
Technology), 180 

Performance, fine-tuning, 
132 

PIM (personal information 
manager), 40, 153 

Pocket Access, overview, 6 
Pocket Excel, overview, 6 
Pocket Outlook, 55 

Calendar, 56 
Contacts, 58 
Inbox, 59 
Tasks, 58 

Pocket PowerPoint, 
overview, 6 

Pocket Word, overview, 6 
POP3, 180 
Ports 

9-pin serial, 36 
infrared, 44 

Power 
displaying information 

about, 139 
Intelligent Power 

Management, 130 
troubleshooting, 149 

Power control panel, 133 
description, 133 
opening, 128 
overview, 128 

Power on option, setting, 
130 

Power Saving tab, 129 
PPP (Point-to-Point 

protocol), 158 
PPP (Point-to-Point 

Protocol), 87, 180 
Primary password 

removing, 142 
setting, 141 

Primary password 
protection 
disabling, 141 

Printing 

IrDA port option, 78 
Microsoft Pocket Office 

documents, 77 
office documents, 77 
via infrared, 78 

Program memory, 110, 123, 
139, 150, 151, 156 

Programs 
available from HP Web 

site, 114 
installing, 114 
removing, 117 

Proxy server, 94 
pwd.file, 105 

QQQQ 
Quick pad, 63 

RRRR 
Radiation, 148 
Recording, 68 

formats, 68 
Recycle Bin, options, 124 
Regional settings control 

panel, 133 
Reinstating or removing 

applications, 116 
Reminder Password 

setting, 143 
Remote Access Services 

(RAS), 181 
Remote connections, 181 

dialing location set up, 53 
Remote locations 

synchronizing from, 50 
Remote Networking 

setting up, 101 
Remote Networking folder, 

52 
Remove Programs control 

panel, 133 
Resetting, 159 

defined, 181 
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factory default, 160, 161, 
178 

soft, 160, 181 
Resolve Conflicts dialog box, 

49 
Restore 

full, 82 
PIM databases, 81 
using ActiveSync, 79 
warning message, 153 

Restoring 
using ActiveSync, 81 

Restoring data, 78, 181 
Rich Ink technology, 78 
rtf file, 105 

SSSS 
Safety precautions, 148 
Screen, viewing difficulties, 

159 
Security, 139 
Security Log 

using, 143 
Send using MIME format 

check box, 106 
Serial connection, 40 
Serial Port 

making connections, 36 
Serial sync cable, 31, 36, 

118, 144 
Server-assigned address, 93 
Server-assigned IP address, 

92 
Service Provider 

connecting to, 95 
Setting Alarms, 118 
Settings profiles, 137 
SLIP (Serial Line Internet 

Protocol), 87, 158 
Smart Card 

installing, 120, 121 
removing, 122 

SMTP host, 90 

Socket LP-E/EIO control 
panel, 133 

Software drivers, installing, 
119 

Software Product License 
Agreement, 196 

Sound 
adding, 118 
adjusting, 131 

Storage memory, 68, 69, 
111, 116, 123 

Stylus control panel, 133 
described, 133 

Support, 163 
Suspend, 13, 26, 131 

auto, 128 
delay, 129 

SVGA 256-color, 34 
Synchronization, 32, 39 

Resolve Conflicts dialog 
box, 49 

resolving conflicts, 49 
with Active Sync, 32 

Synchronizing 
data, 47 
e-mail messages, 48, 49 
files, 48 
from a remote location, 50 
Microsoft Pocket Outlook 

data, 48 
remotely, 50 
selected data, 48 

System control panel, 133 

TTTT 
Tables, creating, 76 
TCP/IP, 92 
Telephone cable, 36 
Telephone lines 

access, 87 
connecting to modems, 95 

Temperature moderation, 
148 
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Terminal Server Client 
(TSC) 
keyboard use, 175 

Transferring data 
difficulties, 158 

Transferring files, 54 
Traveling with HP Jornada, 

144 
Troubleshooting 

display, 151 
HP backup, 153 
installing software, 156 
insufficient memory, 152 
locking up, 150 
printing, 156 
shutdown/suspend, 150 
stylus response, 157 

txt file, 105 

UUUU 
USB, 40, 41, 154 

defined, 181 
making a connection, 38 

Use Server-assigned IP 
Address check box, 53 

VVVV 
Viewer, 60 
Viewing 

difficulties, 159 
Voice Recorder, 68 
Volume & Sound control 

panel, 133 
Volume profile hot key, 138 
Volume Profiles tab, 136 

WWWW 
Waiting for mobile device to 

disconnect message, 51 
Warranty 

hardware, 193 
software, 196 

wav files, 118 
Wave sounds (.wav files), 

118 
Web Service, 94 
Web, browsing, 107 
Windows folder, 117 
WINS server address, 97 
World Clock 

control panel, 134 
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WarrantyWarrantyWarrantyWarranty    

Important: This is your hardware product warranty statement. 
Read it carefully.  

Warranty terms may be different in your country. If so, your 
Authorized HP Dealer or Hewlett-Packard Sales and Service 
office can give you details. 

One year limited hardware warrantyOne year limited hardware warrantyOne year limited hardware warrantyOne year limited hardware warranty    
Hewlett-Packard (HP) warrants this hardware product, against 
defects in material and workmanship for a period of one year 
from receipt by the original end-user purchaser. 

If HP receives notice of the above defined defects during the 
warranty period, HP will either, at its option, repair or replace 
products that prove to be defective. 

Should HP be unable to repair or replace the product within a 
reasonable amount of time, the customer's alternate exclusive 
remedy shall be a refund of the purchase price upon return of the 
product. 

Limitation of warrantyLimitation of warrantyLimitation of warrantyLimitation of warranty    
The above warranty shall not apply to defects resulting from: 
misuse; unauthorized modification; opening for any reason except 
to perform an official upgrade using an HP Upgrade Kit; 
operation or storage outside the environmental specifications for 
the product; the coin-cell backup battery, or damage caused by 
this battery; in-transit damage; improper maintenance; 
physical damage to the unit, such as a cracked or 
broken screen or defect resulting from use of non-HP 
software, accessories, media, supplies, consumables, or such 
items not designed for use with the product. 

HP makes no other express warranty, whether written or oral, 
with respect to this product. 
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Any implied warranty of merchantability or fitness for a 
particular purpose is limited to the one-year duration of this 
written warranty.  

Some states, provinces, or countries do not allow limitations on 
how long an implied warranty lasts, so the above limitation or 
exclusion may not apply to you. 

This warranty gives your specific legal rights, and you may also 
have other rights that vary from state to state, province to 
province, or country to country. 

Limitation of liability and remediesLimitation of liability and remediesLimitation of liability and remediesLimitation of liability and remedies    
The remedies provided above are the customer's sole and 
exclusive remedies. 

In no event shall HP be liable for any direct, indirect, special, 
incidental, or consequential damages (including lost profit), 
whether based on warranty, contract, tort, or any other legal 
theory.  

Some states, provinces, or countries do not allow the exclusion or 
limitation of incidental or consequential damages - including lost 
profit-, so the above limitation or exclusion may not apply to you. 

Consumer transactions in Australia, New Zealand and 
the United Kingdom  
The preceding disclaimers and limitations shall not apply to 
consumer transactions in Australia, New Zealand and the United 
Kingdom, and shall not affect the statutory rights of consumers.  

For consumers in Australia  
The above warranty terms and any other warranty statement 
enclosed with this product, except to the extent lawfully 
permitted, do not exclude, restrict, or modify and are in addition 
to the statutory rights implied by the Trade Practices Act 1974 or 
any corresponding State or territory legislation applicable to the 
sale of this product to you. If you have any queries about your 
rights, contact the Hewlett-Packard Customer Care Center at 61-
3- 88778000.  
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For consumers in New Zealand  
The above warranty terms or any other warranty statement 
enclosed with this product, except to the extent lawfully 
permitted, do not exclude, restrict or modify and are in addition 
to the statutory rights implied by the Consumer Guarantees Act 
1993 applicable to the sale of this product to you. If you have any 
queries about your rights contact the Hewlett-Packard End User 
Support line at 0800-733547. 
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HP software product license agreement HP software product license agreement HP software product license agreement HP software product license agreement 
and HP software product limited warrantyand HP software product limited warrantyand HP software product limited warrantyand HP software product limited warranty    
This HP product contains preinstalled software programs. Please 
read the HP Software Product License Agreement before 
proceeding.  

Important: Carefully read this License Agreement and the 
Limited Warranty statement before operating the equipment. 
The rights to the software are licensed, not sold. HP or its 
licensors continue to own all intellectual property rights to the 
software, and you will be granted certain rights to use the 
software upon your acceptance of this license. Rights in the 
software are offered only on the condition that you agree to all 
terms and conditions of the License Agreement. Operating the 
equipment indicates your acceptance of these terms and 
conditions. If you do not agree to the terms and conditions of the 
License Agreement, return the complete package for a full refund 
now. 

HP Software Product License Agreement 
The HP Software Product License Agreement shall govern the 
use of all software that is provided to you, the customer, as part 
of this HP product with the exception of Microsoft Software. 
Microsoft Products are licensed to you under the Microsoft End 
User License Agreement (EULA) contained in the Microsoft 
documentation. Any third party software supplier's warranty 
terms that may be found on-line, or in any documentation or 
other materials contained in the product packaging, shall govern 
the use of that third party software. 

The following License Terms govern the use of the software: 

Use 
You may only use the software on a single computer. You may not 
reverse, assemble, or decompile the software.  

Transaction in European Union member states: The prohibition 
against decompilation shall be subject to Directive 91/250/EEC. 
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Copies and adaptations 
You may make copies or adaptations of the software (a) for 
archival purposes, or (b) when copying or adaptation is an 
essential step in the use of the software with a computer so long 
as the copies and adaptations are used in no other manner.  

You have no other rights to copy unless you acquire an 
appropriate license to reproduce which is available from HP for 
some software.   

You agree that no warranty, free installation, or free training is 
provided by HP for any copies or adaptations made by you.  

All copies and adaptations of the software must bear the 
copyright notice(s) contained in or on the original.  

Ownership 
You agree that you do not have any title to or ownership of the 
software, other than ownership of the physical media. You 
acknowledge and agree that the software is copyrighted and 
protected under the copyright laws. You acknowledge and agree 
that the software or part thereof may have been developed by a 
third party software supplier named in the copyright notice(s) 
included with the software, who shall be authorized to hold you 
responsible for any copyright infringement or violation of this or 
their own License Agreement.  

Transfer of rights in software 
You may transfer rights to the software to a third party only as 
part of the transfer of all your rights and only if you obtain the 
prior agreement of the third party to be bound by the terms of 
this License Agreement. Upon such a transfer, you agree that 
your rights to the software are terminated and that you will 
either destroy all your copies and adaptations or deliver them to 
the third party. Transfer to a U.S. government department or 
agency or to a prime or lower tier contractor in connection with a 
U.S. government contract shall be made only upon prior written 
agreement to terms required by HP.  
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Sublicensing and distribution 
You may not lease, sublicense the software or distribute copies or 
adaptations of the software to the public in physical media, by 
telecommunication or at all without the prior written consent of 
HP.  

Termination 
HP may terminate this software license for failure to comply with 
any of these terms, provided HP has requested you to cure the 
failure and you have failed to do so within thirty (30) days of such 
notice.   

Updates and upgrades 
You agree that the software does not include updates and 
upgrades that may be available from HP under a separate 
support agreement. 

Export clause 
You agree not to export or re-export the software or any copy or 
adaptation in violation of the U.S. Export Administration 
regulations or other applicable regulations.  

U.S. government restricted rights  
The Software and Documentation have been developed entirely at 
private expense. They are delivered and licensed as “commercial 
computer software” as defined in DFARS 252.227-7013 (Oct 
1988), DFARS 252.211-7015 (May 1991) or DFARS 252.227- 7014 
(Jun 1995), as “commercial item” as defined in FAR 2.101 (a), or 
as “Restricted computer software” as defined in FAR 52.227-19 
(Jun 1987) (or any equivalent agency regulation or contract 
clause), whichever is applicable. You have only those rights 
provided for such Software and Documentation by the applicable 
FAR or DFARS clause or the HP standard software agreement for 
the product involved. 
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HP Software Product Limited Warranty 
Important: This HP Software Product Limited Warranty shall 
cover all software that is provided to you, the customer, as part of 
the HP product, including any operation system software. Any 
third party software supplier's warranty terms that may be found 
on-line, or in any documentation or other materials contained in 
the product packaging shall supersede the HP Software Product 
Limited Warranty with regard to that third party software. 

Ninety-Day Limited Software Warranty 
HP warrants for a period of NINETY (90) DAYS from the date of 
purchase that the software product will execute its programming 
instructions when all files are properly installed. HP does not 
warrant that the software will be uninterrupted or error free. In 
the event that this software product fails to execute its 
programming instructions during the warranty period, your 
remedy shall be replacement or refund only. Return the media to 
HP for replacement. Should HP be unable to replace the media 
within a reasonable amount of time, HP shall refund the 
purchase price upon return of the product and all copies. 

Removable media (if supplied) 
HP warrants the removable media, if supplied, upon which this 
product is recorded to be free from defects in material and 
workmanship under normal use for a period of NINETY (90) 
DAYS from the date of purchase. In the event the media proves to 
be defective during the warranty period, your remedy shall be 
replacement or refund only. Return the media to HP for 
replacement. Should HP be unable to replace the media within a 
reasonable amount of time, HP shall refund the purchase price 
upon return of the product and destruction of all other non-
removable media copies of the software product. 

Notice of warranty claims 
You must notify HP in writing of any warranty claim not later 
than thirty (30) days after the expiration of the warranty period. 
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Limitation of warranty 
HP makes no other express warranty, whether written or oral, 
with respect to this product. 

Any implied warranty of merchantability or fitness for a 
particular purpose is limited to the 90-day duration of this 
written warranty. Some states, provinces, or countries do not 
allow limitations on how long an implied warranty lasts, so the 
above limitation or exclusion may not apply to you. This warranty 
gives specific legal rights, and you may also have other rights 
which vary from state to state, province to province, or country to 
country. 

Limitation of liability and remedies 
THE REMEDIES PROVIDED ABOVE ARE YOUR SOLE AND 
EXCLUSIVE REMEDIES. IN NO EVENT SHALL HP BE 
LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES 
(INCLUDING LOST PROFIT), WHETHER BASED ON 
WARRANTY, CONTRACT, TORT, OR ANY OTHER LEGAL 
THEORY. Some states, provinces, or countries do not allow the 
exclusion or limitation of incidental or consequential damages - 
including lost profit-, so the above limitation or exclusion may not 
apply to you. 

In no case shall HP's liability exceed the purchase price for the 
software and/or product. The limitations set forth above will 
apply regardless of whether you accept the software. 

Consumer transactions in Australia and the United Kingdom: 
The disclaimers and limitations above shall not apply and shall 
not affect the statutory rights of a Consumer. 


